The Development, Interview Testing, and Generalization of a Theory Based Model of Conceptual Structures for Solving Routine Trigonometry Problems

by

Warren J. Burch

Dissertation submitted to the Graduate Faculty of the Virginia Polytechnic Institute and State University in partial fulfillment of the requirements for the degree of DOCTOR OF EDUCATION in Community College Instruction

APPROVED:

Gerald Brazier, Chairman

M. G. Cline

Lawrence Cross

Harold Mick

Robert Sullins

June, 1981

Blacksburg, Virginia
This dissertation is lovingly and thankfully dedicated to my parents, who have encouraged and supported me at every step in the educational process.

My grateful appreciation is extended to the many individuals who have been of assistance in researching and producing this dissertation. These include Dr. Gerald Brazier and Dr. Harold Mick, who have served as advisors; Dr. Robert Sullins, who assisted me in entering the program; and Dr. Lawrence Cross and Dr. M. G. Cline, who have served as committee members.

Special thanks are extended to my wife, who has spent many hours in typing (and editing) the paper and to my children, and , who have learned what it means to have a father who is a graduate student.
Table of Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>THEORETICAL BASIS AND RELATED RESEARCH</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Theoretical Basis</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Related Literature</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>METHODOLOGY AND MODEL DEVELOPMENT</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Methodology</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Development of the Preliminary Specific Model</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>The Preliminary Specific Model</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Interview and Analysis Procedures</td>
<td>94</td>
</tr>
<tr>
<td>4</td>
<td>INTERVIEW ANALYSES AND MODEL REFINEMENT</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>Interview Analyses of the First Four Subjects</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>The Refined Model</td>
<td>169</td>
</tr>
<tr>
<td></td>
<td>Interview Analyses of S5 and S6</td>
<td>178</td>
</tr>
<tr>
<td></td>
<td>Validity</td>
<td>216</td>
</tr>
<tr>
<td></td>
<td>Reliability</td>
<td>223</td>
</tr>
<tr>
<td>5</td>
<td>CONCLUSIONS AND APPLICATIONS</td>
<td>227</td>
</tr>
</tbody>
</table>
CHAPTER 1

INTRODUCTION

One major goal of mathematics educators has been to facilitate conceptual development in their students. Understanding concepts appears to have several advantages over rote learning. These include improved long term memory, increased ability to solve problems which have not been previously studied, improved ability to draw valid conclusions from the learned information, and an increased appreciation for the subject.

In the attempt to aid educators, researchers have attempted to develop teaching methods designed to facilitate conceptual development. To test these methods requires the ability to determine the conceptual development of subjects. As a result, a major goal of research in mathematics education has been to find a method of determining conceptual development. In pursuing this goal, it has been realized that the investigation of how a single concept is developed is not sufficient; relations among collections of concepts must also be examined. This has led to the development of the construct called "conceptual structure." One definition of conceptual structure can be obtained by a slight modification of Shavelson's (1974, p. 231) definition of structures as "an assemblage of identifiable concepts and the relationships between those concepts." Since the ability to
solve problems is of particular importance in mathematics, it is valuable to obtain representations of conceptual structures within which problem solving can be described. The problem investigated in this study is to produce a theory based model of conceptual structures which can be used to describe routine problem solving.

The use of structures to explain "thinking" appears to have begun in Gestalt Theory and the closely related meaning theory. The intent of Gestalt and meaning theorists was to use the idea of a "mental" structure to describe thinking. However, their ideas were vague and untestable (Mayer, 1977, p. 49; Anderson & Bower, 1974, pp. 56-57), and their applications to problem solving were different from this study in that they were involved with nonroutine problems.

Another approach to the problem has been taken by the semantic theorists (Meyer, 1970; Rips, Shoben, & Smith, 1973; Anderson & Brower, 1974; Rumelhart, Lindsay, & Norman, 1972; Collins & Quillian, 1967). These semantic models attempt to develop representations of cognitive structure, but they are limited to explanations of how bits of information, sentences, and events can be structured in the memory and then utilized to answer questions and determine truth or falsity of statements. There seems to have been no attempt by the semantic theorists to use their models to explain problem solving, nor does it seem possible to do so. Although semantic theory is more precise and testable than
Gestalt and meaning theory, its inability to be applied to problem solving prevents it from being adequate for this study.

An information processing theory which utilized the computer to examine problem solving behavior was developed by Newell and Simon (1971, 1972). Their ideas involve both structures and problem solving, but the structures are not conceptual in nature and the problems are nonroutine, so their work is inappropriate for this study. Another information processing approach was developed by Frijda (1972), who synthesized several theories into a model which involves conceptual structures. However, it does not fulfill the needs of this study since it is not applicable to problem solving.

One model which includes conceptual structures and may have potential to describe problem solving was developed by Shavelson (1974). However, it has not been used in this way in research (Shavelson, 1974; Geeslin & Shavelson, 1975a, 1975b; Shavelson & Stanton, 1975). In addition, it lacks some important features of the present model, which are discussed in chapter 2.

A theory which incorporates conceptual structures in a way which can describe problem solving has been developed by Skemp (1971, 1976, 1979). This is a general theory that treats human beings as goal seeking individuals and which uses schemas (conceptual structures) as a vehicle to
describe how goals are reached. In this study the goals are solutions to problems and routes through schemas are called problem solving paths. Thus Skemp's theory provides an acceptable basis for this study.

Even though Skemp's theory is an acceptable base for this study, some adaptation was found to be needed. This need arose from the observation that schemas are essentially static while problem solving is a dynamic activity. This difficulty has been surmounted by hypothesizing two levels of schemas: (a) an underlying conceptual structure called a "parent schema," and (b) a related structure called a "problem solving schema" which represents problem solving paths through the parent schema.

**Purposes**

1. To adapt that portion of Skemp's theory that deals with conceptual structures to make it operational.

2. To develop, from that adaptation, a specific model of a structure of trigonometric concepts which contains paths for solving routine problems in trigonometry.

3. To use an interview process, developed from the specific model, to determine hypothetical representations of the conceptual structures possessed by subjects and to determine if the specific model contains the paths utilized by those subjects in problem solving.

4. To generalize the processes of model formulation
and interviewing in such a way that they can be used and tested in areas other than trigonometry.

**Procedures**

The first step in the study was to decide on the content area for investigation. Trigonometry was chosen since it contains many complex interrelationships of concepts and is thus an ideal topic to be represented by conceptual structures. A preliminary model of trigonometric conceptual structures was developed from a study of methods of solving routine problems and an identification of the major concepts used in those problem solutions.

The preliminary model was refined after a series of four interviews with each of four subjects. The interviews were semistructured and were based on the problem solving methods used to determine the preliminary model. Using the refined model, two additional subjects were interviewed. The interviews with one subject were analyzed by a second evaluator as a check on reliability. Three forms of validity (face validity, cross-validity, and comparison with word association data) were investigated.

The intent of this research was not only to determine structures of trigonometric concepts, but also to develop a methodology which can be used to determine conceptual structures in other content areas. The development of the trigonometric model provides an example of this methodology.
CHAPTER 2

THEORETICAL BASIS AND RELATED LITERATURE

This chapter has a twofold intent: (a) to develop the theory base referred to in the first purpose statement, and (b) to report related models and methods of assessing conceptual structure and to relate them to the theory base. The theoretical basis referred to is developed in the first part of the chapter and the related models and methods in the second part.

The theory developed in this chapter is a theory of understanding based largely on the theories of Piaget, Skemp, and Mick and Brazier. A portion of that theory involves hypothesizing the idea of a schema as a structure of inter-relationships of concepts. Only this portion of the theory was tested in this study. Various models of the use of structures in memory and understanding as well as a variety of methods which have been used in attempts to measure conceptual structures in both content and memory are reported in the second part of the chapter. One of the methods reviewed is the use of interviews to determine cognitive structure, which is the data gathering method utilized in this study.

Theoretical Basis

In this section, the theory of the study is developed. The section is divided into four parts: (a) Conceptual
Structures; (b) Understanding; (c) Director Systems and Problem Solving; and (d) Representing Conceptual Structures.

**Conceptual Structures**

The overall theory which is being developed here is a theory of understanding. Conceptual structures form an important part of this theory and is the part which will be tested by the research. Thus, it is important to consider various conceptions of conceptual structures.

The work of Piaget forms the background for the conceptions of understanding to be considered. For Piaget (1971, p. 15) learning involves the formation of mental structures and the continual modification of those structures to receive new ideas. Piaget hypothesizes two kinds of mental structures which he calls schemas and schemes. Schemas are structures that represent reality literally while schemes are systems of operations. An operation is defined by listing its four characteristics: (a) It is an internalized action. (b) It is reversible. (c) It involves conservation, i.e., some aspect that remains unchanged. (d) It is part of a system of operations or structure. Each structure is a totality that is controlled by laws which apply to the entire system. These laws are actions or transformations.

The Piagetian concept of learning can now be described in more detail. Learning consists of the restructuring of existing schemas so that new ideas can be accepted. The restructuring is called "accommodation" and the acceptance is
called "assimilation." As assimilation occurs, the stimulus object is modified by the mind to enable it to fit into the existing structure. For example, when the concept "square" is assimilated, reality is modified so that an ideal, perfect square concept is accepted. According to Piaget (1970a), however, no assimilation can occur without accommodation. Thus learning is a very active process of assimilation and accommodation. This process, however, must be regulated to avoid random restructuring. This auto-regulation is called equilibration.

The need for equilibration is explained by Piaget when he says that although "accommodation and assimilation are present in all activity, their ratio may vary" (Piaget, 1970a, p. 708). In a circumstance when assimilation overpowers accommodation, a complete act of pretending occurs and objects become, in the mind, exactly what the mind wishes them to be. In the reverse situation, objects are reproduced in the mind as exact images which leads to figurative thought. Only when assimilation and accommodation are more or less in a state of equilibrium is true intelligence or cognitive behavior present. Again, it is the process of equilibration that regulates the process of assimilation and accommodation to reach equilibrium. Finally, Piaget defines knowing as follows: "To know is to assimilate reality into systems of transformations" (Piaget, 1970b, p. 29).

Skemp (1979, p. 190) defines a schema as follows.
A schema is a structure of connected concepts. The idea of a cognitive map is a useful introduction, a simple particular example of a schema at one level of abstraction only, having concepts with little or no interiority, and representing actuality as it has been experienced. A schema in its general form contains many levels of abstraction, concepts with interiority, and represents possible states (conceivable states) as well as actual states.

A schema can be represented by diagram as in Figure 1. Such a diagram is merely a model to aid in the discussion of schemas. Skemp alternately calls the vertices states (Skemp, 1979, p. 168) or concepts (Skemp, 1979, p. 190). "A state is a set of values of certain chosen observables" (Skemp, 1979, p. 47). Such a diagram can be thought of at three levels of abstraction: a road map, a cognitive map, or a generalized schema (Skemp, 1979, pp. 167-168). A vertex may represent a conceptual structure with a great amount of detail. Such a vertex is said to have much interiority (Skemp, 1979, p. 116). The ability to focus on either the interior of a vertex within a schema or on the entire schema itself is called a vari-focal ability (Skemp, 1979, p. 115).

Although this definition is a specification of Piaget's ideas, Skemp believes that assimilation and accommodation do not adequately describe changes in schemas. He agrees that the structuring of incoming sense-data can be called assimilation, but feels that the modification of conceptual structures by new experience takes two forms which he calls
FIGURE 1
SCHEMA
(SKEMP, 1979, p. 168; USED BY PERMISSION)
expansion and reconstruction (Skemp, 1979, p. 127). Thus he feels that accommodation is an inadequate term, and in his definition of schema avoids the Piagetian language entirely.

At this point a digression seems necessary to delineate and discuss types of structures. First is the philosophical question as to whether conceptual structures actually exist outside of the mind. Piaget's answer to this is that "it is nearly impossible to understand and justify the validity of our knowledge without presupposing the existence of relations. But this answer implies that the word existence has to be taken to have a multiplicity of meanings" (Piaget, 1971, p. 23). If we assume that these structures exist independently, then the objective of teaching in our perspective is to implant these conceptual structures in the mind of the learner. If we assume otherwise, then such structures exist in the mind of the teacher and the objective is the same. Thus it appears that, for the purpose of education, it does not matter which philosophical stance we take. Next, we compare these conceptual structures with Piaget's operational mental structures. As indicated above, Skemp does not appear to recognize any distinction between the two:

The general psychological term for a mental structure is a schema. The term includes not only the complex conceptual structures of mathematics, but relatively simple structures which coordinate sensory-motor activity. Here we will be concerned mainly with abstract conceptual schemas. (Skemp, 1971, p. 39)
On the other hand, Mick and Brazier see the two as distinct but similar in several respects. They are similar in acquisition and form since "both are internalized structures acquired by abstraction and self-regulated by equilibration, and both are mental constructs which serve as mental tools for further acquisition" (Mick & Brazier, 1979, p. 52). They also see similarities of content and structure.

Since this study concentrates on conceptual structures, it is necessary to discuss the definition of concept that is appropriate. Skemp (1971, pp. 19-36; 1979, p. 24) does not attempt to define the term "concept." Instead he approaches this idea by citing a number of examples. However, his examples involve the process of abstraction, the act of determining the common properties possessed by a collection of objects. Thus it appears his idea is consistent with Mick and Brazier's (1979) definition of a concept as the result of an abstraction. This is the point of view taken in this study.

Understanding

To develop fully the idea of conceptual structures it is necessary to show how they are used in a theory of understanding. Skemp (1971, p. 46) defines understanding as follows: "To understand something means to assimilate it into an appropriate schema." He later adds more precision to this definition by introducing the terms "actuality" and "reality." Actuality is the "environment in which our physical actions and activities take place" (Skemp, 1979, p. 21).
Reality refers to an individual's inner, mental world which would include representations of actuality. This leads Skemp to a definition of the process of realization. (Skemp, 1979, p. 21) "In the sense with which we are here using the word, realisation maps or images actuality within an appropriate conceptual structure" (Skemp, 1979, p. 33). The relationship between realizing and understanding is probably best described using one of his examples. His tape player developed to capacity to receive and amplify foreign radio stations. He realized the problem, i.e., recognized the nature of the problem, but neither he nor anyone else understood why it was happening. To understand the occurrence it would be necessary to understand concepts about tape players and radio reception. This likely did not occur because his existing schemas were not extensive enough. Thus realization is necessary but not sufficient for understanding. (Skemp, 1979, p. 146)

The resulting definition of understanding is twofold: "To understand a concept, group of concepts, or symbols is to connect it with an appropriate schema. To understand an experience is to realise it within an appropriate schema." (Skemp, 1979, p. 148) This seems to modify his earlier statement about the relationship between realization and understanding. Concepts can be understood, but for experiences, realization is understanding.

To aid in our attempt to examine understanding of
concepts, we shall discuss Skemp's taxonomy of understanding. Skemp (1976) credits Stieg Mellin-Olsen with pointing out to him that there are, in fact, two kinds of understanding mathematics, which he calls relational and instrumental. Instrumental understanding is what Skemp has "in the past described as 'rules without reason', without realizing that for many pupils and their teachers the possession of such a rule, and ability to use it, was what they meant by 'understanding'" (Skemp, 1976, p. 20). Thus instrumental understanding is the ability to use rules to obtain correct answers without knowing why the rule works. On the other hand, "learning relational mathematics consists of building up a conceptual structure (schema) from which its possessor can (in principle) produce an unlimited number of plans for getting from any starting point within his schema to any finishing point" (Skemp, 1976, p. 25).

There are several advantages of relational learning over instrumental learning. (a) An encounter with a problem for which an individual has no specific plan available may not prevent the solution of that problem. If that individual is a relational learner and if he possesses a schema which contains his present state (given information) and his goal state (the "answer") then he has the capacity to develop a plan for solving the problem. (b) The probability of talking nonsense is reduced. Skemp gives one example of this. The problem is to find the area of a field 20 cm by 15 yards.
One subject's answer was 300 square centimeters, an error which would likely have been avoided if relational understanding was present. (c) With many different types of problems, the task of the memory of an instrumental learner becomes monumental as he needs to remember large numbers of plans. A relational learner, however, develops plans as needed from existing schema. The process of building these schema is more difficult, but the resulting memory work is greatly diminished. In a situation in which both learner and teacher have relational learning goals, other advantages exist. (d) Explanations and discussions between learner and teacher encourage the learner to reflect on his mental process and consciously modify existing schemas. (e) "Continuing development of an existing schema seems to be capable of becoming a goal state in itself" (Skemp, 1979, p. 425). Thus learning becomes self-motivating. (f) It appears that if a teacher is able to give a student a bit of relational learning, that the student may learn to like it. (Skemp, 1979, p. 259-261)

**Director Systems and Problem Solving**

Skemp states that "many human acts and activities are goal-directed" (Skemp, 1979, p. 2) and bases his model of problem solving behavior on this idea. Goal seeking behavior involves the need to pass from a present state to a goal state. He proposes the idea of a goal seeking system (see Figure 2) to explain this process. This system has three
parts. The operand is "that which is changed from one state to another and kept there" (Skemp, 1979, p. 41). The operator actually "does the work of changing the state of the operand" (Skemp, 1979, p. 41). The part which "directs the way in which the energy of the operator system is applied to the required state and keep it there" is called the director system. An example of a goal directed system is the system which controls oven temperature. The oven temperature is the operand, the heating element is the operator, and the thermostat is the director system. (Skemp, 1979, p. 4)

The director system itself has four parts: (a) a sensor (thermometer) which determines "the relevant aspect of the present state of the operand" (Skemp, 1979, p. 42); (b) a part which is used to set the goal state (temperature control dial); (c) the comparator which monitors the "difference between the present state and the goal state" (Skemp, 1979, p. 42); and (d) a plan for moving the operand from the present state to the goal state. "Plan" is more precisely defined by referring to the idea of a schema. A path is a "sequence of states" in a schema and "a plan consists of a path from a present state to a goal state and a way of applying the energies available to the operators in such a way as to take the operand along this path." (Skemp, 1979, p. 168) Problem solving involves the formation of such a plan and the following of such a path. The comparator aids in this endeavor by constantly monitoring the
relationship between the present state and the goal state to
determine if progress is being made. It appears that the
frequently observed phenomenon of making false starts, re-
covering, and trying again is part of the plan forming pro-
cess in which the problem solver is attempting to find the
path which leads from the present state to the goal state.

In the definition of relational understanding, "start-
ing point" may be replaced by "present state" and "finish-
ing point" by "goal state." Instrumental understanding con-
sists of the ability to follow a known rule or plan from a
present state to a goal state without having the ability to
devise other plans. The ability to follow specific plans or
algorithms in a routine way is of value even to the rela-
tional learner since it offers improved efficiency. How-
ever, overpracticing of such algorithms can lead to the fad-
ing of the rest of the cognitive map, leaving the learner
with one fixed plan available. (Skemp, 1979, p. 173) Thus
overpracticing can lead to a loss of relational understand-
ing.

Representing Conceptual Structures

One way of viewing the purpose of this study is as a
test of a portion of this theory, specifically Skemp's idea
of a schema as a model of how concepts are structured and re-
membered and as a model to describe problem solving. In or-
der to develop models of specific conceptual structures it
was necessary to extend and modify Skemp's ideas of schema
FIGURE 2
GOAL SEEKING SYSTEM
(SKEMP, 1979, P. 49; USED BY PERMISSION)
and state. Skemp describes a schema as a "structure of connected concepts" (1979, p. 190) which contains paths for problem solving (1979, pp. 168-174). In attempting to develop specific trigonometric schemas two questions arose. (a) Do the vertices of schemas represent concepts or states? (b) What happens along the lines joining the vertices? The purpose of this section is to develop answers to these questions.

In attempting to answer these questions the taxonomy of concepts proposed by Mick and Brazier (1979) is useful, so it will be described here. They define a concept as the result of an abstraction and utilize Piaget's idea that there are two kinds of abstraction. Piaget (1971) believes that abstraction is the result of action. A child learns the concept of weight by lifting objects. However, even though action is involved, the concept that is abstracted is static, a property of objects. He calls this process a simple abstraction. The actions which lead to a simple abstraction constitute physical experience (Piaget, 1970a, p. 721). An abstraction which is the result of abstracting coordinated actions (operations) is called a reflective abstraction and the actions involved are called logico-mathematical experience (Piaget, 1971). It is this psychological classification of abstractions that led Mick and Brazier (1979) to their taxonomy of concepts. A figural concept is the result of a simple abstraction while an operational concept is the
result of a reflective abstraction. More precisely, a fig- urnal concept is the result of abstracting common physical properties possessed by members of a class and operational concepts are "abstractions of coordinated actions as applied to various figural concepts or other operational concepts" (Mick & Brazier, 1979, p. 50). The operational concept category contains relations, functions, and higher order operations. Relations are the result of abstracting connections between static states of figural concepts. "A relation is an operational concept because it requires that the class of coordinated actions relating ordered pair components be abstracted" (Mick & Brazier, 1979, p. 51). Functions are, of course, relations from a mathematical perspective but are psychologically distinct since they give unique assignments and specify direction, which relations in general do not. "Higher order operations can be described as relations or functions between other relations or functions" (Mick & Brazier, 1979, p. 51).

This taxonomy of figural and operational concepts appears to be consistent with Skemp's theory. Skemp (1971) even uses this classification implicitly in his book The Psychology of Learning Mathematics where chapter two involves figural concepts and chapter three uses operational concepts. In addition, Skemp (1971, pp. 37-38) uses a relation as either a set of ordered pairs of concepts or the action of pairing concepts and a function as the action of
assigning concepts to unique concepts. These ideas differ from Mick and Brazier's definitions in that Mick and Brazier restrict relations and functions to being actions on figural concepts while Skemp allows them to operate on any concept.

Since the idea of schema is designed as a structure of concepts, it seems that the vertices should represent concepts. However, problem solving procedures seem to require successive steps, each step involving some action which leads to a different state of knowledge about some concept; rather than to a concept itself. Thus, in problem solving, it seems that vertices should represent states of knowledge. These difficulties have been surmounted by defining two related kinds of schemas. A parent schema is a structure of connected concepts. A problem solving schema is a structure of possible states of knowledge about particular instances of concepts connected by specific actions (called connections). Thus a problem solving schema is closely related to a parent schema. The vertices of a problem solving schema are in one-to-one correspondence with the vertices of its parent schema. Each vertex of the problem solving schema contains states of knowledge of an instance of the concept at the corresponding vertex of the parent schema. The concepts at the vertices of the parent schema are joined by links. These links are described only by an examination of the connections between corresponding vertices in the problem solving schema. The concepts at the vertices of the
parent schema could be either figural or operational and could have high interiority. The connections in problem solving schemas are defined as actions and must involve uses of operational concepts. The previously given definitions of path and plan are accepted as applied to problem solving schemas.

Thus the first question has been answered by hypothesizing two levels of schemas, the parent schema at the conceptual level and the problem solving schema. This seems to be reasonable and consistent with Skemp's theory as an outgrowth of the interiority idea. The second question has two answers, one for each level of schema. In a problem solving schema, actions (connections) which are uses of operational concepts that change the state of knowledge about the problem occur along the lines. In a parent schema, a line joining two concepts simply indicates that there is at least one connection joining the corresponding vertices in the problem solving schema.

**Related Research**

The purpose of this section is to examine in more detail the studies mentioned in chapter one, and to compare each with the present model. This section has six parts: (a) Gestalt and Meaning Theory; (b) Semantic Memory Theory; (c) Information Processing Theories; (d) Determining Conceptual Structure; (e) Determining Content Structure; and
Comparisons of Content Structure and Conceptual Structure Possessed by Subjects.

**Gestalt and Meaning Theory**

Research and theory in the domain of cognitive structure seems to be a tradition that has its roots in what is called Gestalt theory. According to Gestalt theory thinking "involves the reorganization of the elements of the problem situation" which "results in structural understanding" (Mayer, 1977, p. 58). This definition is prevalent in Gestalt research, along with the concept of direction, which is the giving of hints to aid in reorganization. Both of these ideas are present in the work of Maier (1931), Duncker (1945), and Birch and Rabinowitz (1951). Gestalt psychologists describe two kinds of thinking; reproductive and productive. Reproductive thinking in problem solving is the reproduction of learned procedures, while productive thinking involves repatterning, changing, and restructuring past experiences and previously learned processes to meet the present needs (Birch & Rabinowitz, 1951; Wertheimer, 1959; Maier, 1945). Memorization is often associated with reproductive thinking, while understanding is associated with productive thinking.

One major problem with Gestalt theory is its vagueness and resulting untestability (Mayer, 1977, p. 49; Anderson & Bower, 1974, p. 56-57). It is not clear whether structural understanding means the possession of a schema, or whether
the reorganization of past experience, procedures, and elements of the problem solving situation involve reorganization of existing schema. Reproductive and productive thinking sound very much like instrumental and relational understanding. It appears that the ideas previously developed and yet to be developed in this study can be considered as attempts to make Gestalt psychology more precise and therefore testable.

A variation of Gestalt theory which needs discussing can be called "meaning theory" (Mayer, 1945, p. 91). Thinking, to a meaning theorist, involves relating a new problem situation to individual past experience and then reorganizing the new situation to fit the past experience. It was in this context that Bartlett (1932, p. 201) made an early effort to define schema: "schema refers to an active organization of past reactions which must always be supposed to be operating in any well-adapted organic response." In his development, relating a new situation to a past experience is searching for an appropriate schema to which the new situation should be connected. This search and connection is called assimilation. Mainstream Gestalt theory is concerned with internal relations among problem elements, while meaning theory is concerned with relationships between external problem situations and internal schemas (Mayer, 1977, p. 101). As pointed out by Mayer (1977, p. 92) meaning theorists distinguish two kinds of cognitive structure,
meaningful (Ausubel, 1968) called propositional by Greeno, 1973), which contains structures of general experience, and rote (Ausubel, 1968) (called algorithmic by Greeno, 1973), which contains mechanical rules. Reproductive thinking appears to utilize rote structures, while productive thinking appears to utilize meaningful structures.

**Semantic Memory Theory**

Semantic memory theory involves the study of ways in which information is stored in long term memory. This movement is in the Gestalt tradition since memory structures are hypothesized and tested. The work of the semantic theorists is divided into two different approaches: Some hypothesize structures based on the organization of words into sentences and others suggest structures of relationships between concepts. Two types of structural models have been formulated by semantic theorists, network models and set-theoretic models. Two set-theoretic models (Meyer, 1970; Rips, Shoben, & Smith, 1973) and three network models (Anderson & Brower, 1974; Rumelhart, Lindsay, & Norman, 1972; Collins & Quillian, 1967) will be examined as representatives of semantic theory models.

Meyer (1970) proposed a model of structure of semantic memory based on relations between sets (subset, over-lapping sets, etc.). According to this theory, subjects' response time for true-false decisions about statements of the form "All A's are B's" should be longer than response time about
statements of the form "Some A's are B's." In addition, an enlargement of class B was predicted to result in longer response times, but this did not always occur experimentally. Meyer's theory could not offer an explanation.

An explanation of this phenomenon was offered by Rips, Shoben, and Smith (1973). They modified the set-theoretic ideas by introducing the concept of semantic distance. The semantic distance between two concepts was determined by asking subjects to rate pairs of words according to how closely related they are to each other. From the results, a two-dimensional chart was developed. In this chart, closely related concepts were placed close together. Reaction time data was found to be consistent with distances between concepts on the chart.

A network model based largely on sentence structure has been proposed by Anderson and Bower (1942). Their linguistic approach involves the use of a computer program to develop a diagram of a tree-like graph structure of a sentence. The tree is formed by separating components of the sentence, such as context form from fact, location from time, subject from predicate, and relation from object. Their research, however, has not established that people use this type of structure (Mayer, 1977, p. 124). Anderson and Bower (1973, p. 56-57) claim that their model is associationist rather than Gestalt, which may be true in the
details of their model, but their use of structures in long term memory is clearly in the Gestalt tradition.

Rumelhart, Lindsay, and Norman (1973) have developed a network model which seems to contain some elements of both the sentence structure and conceptual structure approaches. They have defined a node as a "cluster of information in the memory" and a relation as an "association among sets of nodes" (Rumelhart, Lindsay, & Norman, 1972, pp. 51-52). Examples of relations are "is," "is a," "object," "path," "time," "quality," and "location." Relations are labelled and directed, but the direction can be reversed. This model provides a way of developing a graph from a sentence. Mayer (1977, p. 125) points out that little testing of this model has been done. Since that 1972 publication, Rumelhart, Lindsay, and Norman have modified their model and produced the "LNR active structural network" model (Norman, Gentner, & Stephens, 1976). As the description implies it is somewhat more action oriented, but is still a model of remembering sentences and bits of information.

A network model which involves information stored in a more conceptual fashion has been suggested by Collins and Quillian (1969). Some elements of a set-theoretic nature are present since the nodes are arranged in a hierarchical fashion with the levels defined by subset relationships. However, each node is not only a category name, but is also related to properties of that category. Collins and Quillian
tested some implications of their model using response time
data and found "substantial agreement."

These semantic models are important to the present
study because they are attempts to develop representations
of conceptual structure in the memory, just as this study
is. However, the semantic models represent attempts to un-
derstand how bits of information, sentences, and events can
be structured in the memory and then utilized to answer
questions and determine truth or falsity of statements.
This study attempts to develop a model of a structure of
interrelated concepts which can be used for problem solving.
There seems to be no attempt by the semantic theorists to
use their models to explain problem solving, nor does it
seem possible to do so.

Information Processing Theories

The problem solving element which was lacking in se-
monic theory is present in information processing theories.
The basic hypothesis of these theories is that subjects'
problem solving procedures can be approximated by computer
programs. The power of such an approach is that, if they
are correct, problem solving processes of humans may be ex-
amined by analyzing computer processes. The theory of
Newell and Simon is representative of information processing
and computer simulation. It is discussed in detail in their
book, Human Problem Solving (1972). A more concise formu-
lation (Simon & Newell, 1971) will be discussed here. The
overall theory is massive, involving short term and long term memory, processes and mechanisms for problem solving and predictions of problem solving behavior. Only those aspects of the theory which are applicable to this study will be discussed. Of particular importance are the concepts of task environment and problem space. The task environment is a general realm which includes all aspects of the problem. It has a structure from which the problem space derives its structure. The problem space is "the way a particular subject represents the task in order to work on it" (Simon & Newell, 1971, p. 151). The problem space is made up of nodes. A node is "a possible state of knowledge to which the problem solver may attain," while "a state of knowledge is simply what the problem solver knows about the problem at a particular moment of time" (Simon & Newell, 1971, p. 151). Problem solving is described as "an odyssey through the problem space, from one knowledge state to another, until his current knowledge state includes the problem solution - that is, until he knows the answer" (Simon & Newell, 1971, p. 151). To pass from one node to another (i.e., to gain new or different information about the problem), the problem solver performs some action, which is called an operator (Simon & Newell, 1971, p. 152). Thus the problem space is a structure of nodes connected by operators and problem solving involves using operators to pass from
one node to another until a node which contains the desired information is reached and the problem is solved.

Many similarities between these ideas and the model problem solving schemas proposed in this paper can be observed. The major difference is that the present model supposes an underlying conceptual structure (parent schema) which is not a part of Simon and Newell's model. This means that vertices are viewed as containing states of knowledge about particular instances of particular concepts, while nodes are states of knowledge about a particular problem with no reference to any concept. One consequence of this is that in the present model a particular set of known information about a problem may involve states of knowledge about instances of two different concepts meaning that this knowledge resides in two different vertices. This cannot occur in Simon and Newell's model. This implies that problem solving paths in the present model will, on occasion, involve two or more independent branches which come together in the final vertex on the path, the goal state. For example, one way to find \( \cos 115^\circ \) is to observe the quadrant which leads to the sign of the answer, and to use the table to find the cosine of the reference angle and then put the two together. Thus nodes and vertices both contain states of knowledge, but vertices are tied to concepts, while nodes are not, and this leads to differences in problem solving paths.
Some other similarities can be noted. Operators and connections are similar, both being actions used to move from one state of knowledge to another. Other similarities between the more general formulations of the two models exist. Simon and Newell (1971, p. 152) state that the problem solver "must make two kinds of choices: choice of a node from which to proceed, and choice of an operator to apply at that node." To aid in these choices, evaluations as to the likelihood of the usefulness of both nodes and operators must be made. These choices and evaluations are part of the plan forming aspects of this model. To assist with plan forming, Simon and Newell (1971, p. 152) discuss what is often called means-end analysis. This involves the constant comparison between the present state and the goal state. According to Skemp and this model, the mechanism which accomplishes this comparison is called the comparator. Thus the present model and the model of Simon and Newell both address problem solving and many similarities exist. However, the present model places problem solving in a conceptual context which Simon and Newell do not.

An attempt to combine a large quantity of computer simulation research into one overall model to simulate human long term memory has been made by Frijda (1972). He lists seven components of such a memory system. The first component, an information store, is of interest in this study.
An information store is a network of associations which should have three characteristics:

(a) A relational structure: the elements should be linked by means of specified relations; (b) A structure with hierarchical features: sets of elements should be capable of functioning as a whole as new elements, and thus of being linked as a whole to other elements; and (c) A structure of implicit information: the information should be stored in such a way that information implicit in it can be represented and used. (Frijda, 1972, pp. 3-4)

The present model possesses these three characteristics, the second being called "interiority." Frijda goes on to extrapolate his model from a number of studies similar to the semantic memory research previously discussed. Like those studies, his model includes conceptual structures and "appears capable of giving meaningful answers to factual questions" (Frijda, 1972, p. 1). In fact, answering such questions appears to be the way these structures can be "used" as described in characteristic (c). He comments that the mode of representation is also the standard way of representing data for problem solving in models which are similar to the Simon and Newell model previously discussed (Frijda, 1972, pp. 4-5), but fails to notice the difference between the problem solving model and the others he discusses. This difference, the lack of a conceptual context, appears to be critical, actually setting the Simon and Newell model apart from the others he discusses. Frijda's model is conceptually
based, but does not appear to be applicable to problem solving.

A third information processing model which is appropriate to this study has been formulated by Shavelson (1974). Of particular importance are several of his definitions. A structure is defined as "an assemblage of identifiable elements and the relationships between those elements" (Shavelson, 1974, p. 231). This definition is consistent with the present model, but is rather general. More can be said concerning Shavelson's definitions of content structure and cognitive structure. Content structure in instructional materials is "the web of facts (words, concepts) and their interrelations in a body of instructional material" (Shavelson, 1974, p. 231), while cognitive structure is "a hypothetical construct referring to the organization (relationships) of concepts in memory" (Shavelson, 1974, p. 232). In the early stages of the present research, concepts involved in right triangle trigonometry were identified, possible problem solving procedures were represented as paths containing those concepts, and a network was drawn utilizing the concepts as vertices. This network may be considered to be content structure. In the interview process, subjects' problem solving procedures were utilized to determine hypothetical representations of relations between concepts in their memories, i.e., cognitive structure. Viewed in this light, part of the present research is to
determine content structure of trigonometry and cognitive structures of trigonometry possessed by subjects, and compare the two. Thus far, we observe general agreement between aspects of the present model and Shavelson's.

On closer inspection, however, some differences are observed. To Shavelson, each node is a concept (1974, p. 236). This agrees with the present model in that each vertex of the parent schema represents a concept. However, in the attempt to utilize schemas in problem solving it was necessary to delineate a related problem solving schema. In the problem solving schema, a vertex is a state of knowledge of an instance of the concept at the corresponding vertex of the parent schema. In Shavelson's model, a relationship between two concepts is indicated by a line. A line could indicate any of the following relationships: superset, subset, attribute, part, similarity, proximity, antecedent-consequent, and operations. In the present model, a line in a problem solving schema represents a connection which is an action that enables the development of more knowledge about the problem. A line in a parent schema indicates only that there is at least one connection joining states of knowledge of the two concepts. A connection in the present model represents just one of the relationships indicated by a line in Shavelson's model, that is, an operation. It appears that this may be the only one needed in a discussion on problem solving and that the present model not only includes an
attempt to make the Skemp model more precise and testable, but is also a specification of a part of Shavelson's model.

Determining Conceptual Structure

Five methods have been used which purport to determine some aspect of cognitive structure. They are: achievement testing, word association, card sorting, graph building, and interviews.

**Achievement testing.** Achievement tests utilize problem solving and are valuable for determining certain specific relationships between concepts. They can be easily administered to large samples. However, this technique suffers from two disadvantages. First, it obtains only limited information about each subject, largely due to the difficulty in determining precisely the methods used by subjects in problem solving. Second, it is inflexible in that it is difficult to design tests in such a way that subjects are required to use more than one method to solve a problem. It appears that achievement tests cannot provide a very effective measure of cognitive structure. Further, it seems likely that subjects with fairly complete and accurate structures should do well on achievement tests, but that the converse is not likely, due the limited nature of achievement tests.

**Word association.** Of the various methods of measuring cognitive structure, the word association method may be the oldest and most used (Shavelson, 1972, 1974; Johnson, 1967,
1969; Geeslin & Shavelson, 1975a, 1975b; Shavelson & Stanton, 1975). All of the cited studies used the same technique for gathering word association data. Key concepts were identified. For each key concept a page with the key concept typed at the top and a number of blank lines below it were prepared. A page of specific instructions was prepared (see Shavelson, 1974, p. 239 for an example). Each subject listed on each page all words that were thought of as related to the key concept.

There are many ways of dealing with word association data. One study (Marshall & Cofer, 1963) catalogues and discusses ten different measures which have been developed to represent such data. Such measures range from simply counting the number of responses to sophisticated mathematical procedures. Most of the sophisticated procedures involve some ratio of the number of responses to a given key concept to a measure of the overlap between response lists for pairs of key concepts. Several of the reported studies (Shavelson, 1972; Shavelson & Stanton, 1975; Geeslin & Shavelson, 1975a, 1975b) utilized the Garskoff and Houston (1973) relatedness coefficient. This procedure (and some others) give similarity coefficients relating each pair of key concepts. These coefficients can be reduced to the median for comparison purposes or can be arranged in a similarity matrix. Several methods exist for examining the structure of these matrices; these include factor analysis, multidimensional
scaling and hierarchical cluster analysis (Shavelson, 1974). Multidimensional scaling was used by Shavelson (1972) to obtain clusters of key concepts. Geeslin and Shavelson (1975a, 1975b) used multidimensional scaling to locate key concepts on a Cartesian coordinate system representing Euclidean distances between key concepts. This was taken to be a representation of cognitive structure. Shavelson and Stanton (1975) used hierarchical clustering to obtain a pictorial representation of how subjects group the key concepts.

The word association procedures allow development of measures which give information concerning how subjects group concepts into clusters and allow computation of Euclidean distance measures from which concepts may be represented on a Cartesian coordinate system. Thus, some aspects of cognitive structure which do not involve problem solving are measured by such methods. In addition, the structural information obtained does not offer an explanation of problem solving. However, it may be possible to develop a configuration (probably three dimensional) which would preserve the Euclidean distances generated, and in which the concepts would be joined by connections in such a way that problem solving paths would be represented. Since the present model is concerned only with the relations (connections) between vertices and not with geometric relations between the vertices, such a configuration may be possible for it. It should be noted that, although the studies
discussed used group data, similarity matrices were developed for each subject, and thus the procedures could be used to gain information about an individual's cognitive structure.

**Card sorting.** The card sorting methodology is also based on the similarity of concepts (Shavelson, 1974; Shavelson & Stanton, 1974). The basic procedure is described by Miller (1969). Stimulus words naming the appropriate concepts are typed in the middle of index cards. Each member of a group of judges is asked to sort the cards into piles of similar ideas. The "number of judges putting a pair of items in the same cluster is taken as a measure of the proximity of the two items" (Miller, 1969, p. 169). A matrix of proximities of pairs of items can then be constructed and various procedures used to analyze the structure of the matrix. This procedure cannot be followed for each individual judge because of the measure of proximity used. A result is that structures of individuals cannot be obtained from this process.

**Graph building.** A graph building procedure for measuring cognitive structure is described by Fillenbaum and Rapoport (1971) and used by Rapoport, Rapoport, Livant and Boyd (1966) and by Shavelson (1974). In this procedure each subject is given a list of words and asked to construct a tree representing proximity of words, according to very precise instructions (Fillenbaum & Rapoport, 1971, pp. 15-16;
Rapoport, et. al., 1966; Shavelson, 1974). Shavelson (1974) describes a way of obtaining proximity measures of each pair of words, determining a proximity matrix. Then any of the previously discussed methods for determining the underlying structure of a matrix may be used. This procedure can be used to obtain information about the cognitive structure of a single subject. As was the case with the word association data, a configuration which preserves the distances generated and the problem solving paths of the present model may be possible.

The more general theory of linear graphs (Fillenbaum & Rapoport, 1971, pp. 14-20) is directly related to the present model. A linear graph contains nodes and links. A node is a vertex, while a link would be called a connection in a problem solving schema and a link in a parent schema. The nodes at the ends of a link are called end points of the link. A link which has only one end point is called a loop. Two links which have the same end point are parallel. A graph in which each pair of distinct nodes is connected by a link is called complete. A graph is connected if every node is connected to every other node by links and nodes. A link progression is a sequence of links in which one passes from the initial point of the first to the end point of the last by passing over the links in the order specified. If a progression closed and no links are repeated, it is called a cycle. If the links of a graph are directed, it is called
a directed graph. This terminology is clearly applicable to the present model. For example, a parent schema is an undirected graph, while a problem solving schema is a directed graph. Problem solving paths which do not involve parallel branches are link progressions. If analysis of the schemas developed in the study were to be carried further, both the terminology and the statistics discussed by Fillenbaum and Rapoport (1971) could prove to be appropriate and valuable.

An application of a modification of digraph procedure previously discussed was made by Branca (1980). His research involved the development of a one hour lecture and a seven page text on the subject of operational systems. This was taught to a group of high school teachers who then taught it to their classes. All subjects, curriculum developers, teachers, and students then followed an alternative procedure (Fillenbaum & Rapoport, 1971, pp. 16-17) which avoids the actual building of a graph by the subject. This involved examining a list of twelve key concepts of operational systems and indicating the two most closely related by the number 2, etc. This data was converted into proximity matrices which were in turn converted into digraphs by the HILCUS hierarchical clustering computer program (Johnson, S. C., 1967). Group digraphs representing conceptual structure were reported for curriculum developers, teachers, all students, two of the classes, above average students, and below average students, as well as individual
digraphs for two teachers. Thus, this procedure can be used for individuals.

However, the task of the subjects is very difficult, even if actual graph construction by students is avoided by Branca's method (Fillenbaum & Rapoport, 1971, p. 17). This difficulty stems from the necessity of making fine line decisions as to which pair of concepts is most closely related, which is the next most closely related pair, etc. It would seem that this may cause reliability problems, especially for individual subjects. Reliability is not discussed in the cited articles using this procedure.

The digraph procedure gives structural information determined by perceived proximity of concepts. It says nothing about how those are related nor does it give any measure of proximity. An interesting research problem would involve a comparison between results of Branca's digraph procedure and results from multidimensional scaling of word association data. Another limitation of Branca's procedure is that it ignores problem solving, which is especially important in a mathematical context.

Clinical interviews. Interview procedures to obtain information about individual subjects have a long history. Gestalt researchers have used interviews over the last five decades (Maier, 1931; Duncker, 1945; and Birch & Rabinowitz, 1951). Interviewing has been the main information gathering procedure for psychological research in the Soviet Union
since the Central Committee of the Soviet Communist Party prohibited the use of mental tests in 1936 (Kilpatrick & Wirzup, 1969, p. 1). Jean Piaget based his theories on information gained in interviews. Much controversy among researchers over the value of interview procedures has existed, largely due to the use of small samples and the resulting lack of generalizability of conclusions. In recent years, however, such procedures have gained increased respectability due to recognition of their value in certain types of research. In fact, Ginsburg (Note 1, p. 29) has said that "The attempt to measure underlying thought process demands the use of flexible measurement procedures." In addition, interview conclusions may actually be generalizable in a particular way.

Clinical researchers feel that they can generalize from a study of a single case to some other individual cases because they have seen a given phenomenon in one situation in sufficient detail and know its essential workings to be able to recognize it when they encounter it in another situation. (Easley, 1977, p. 2)

In an investigation of cognitive processes, the investigator is more interested in processes followed by subjects than in whether answers are right or wrong. Flexibility is needed to focus on specific areas in which information is needed. Interview procedures provide both flexibility and the opportunity to investigate cognitive processes. Ginsburg (Note 1, pp. 31-32) discusses a
specific interview method and lists five useful characteristics of that method: (a) It is related to academic work. (b) It examines processes children use to do mathematics. (c) It determines reasons for errors. (d) It shows strengths possessed by children. (e) It avoids many of the problems with normal testing procedures. Thus, interviewing can be the best method of obtaining information related to certain research goals.

Interviewing procedures have been used in two basically different ways. Newell and Simon (1972, pp. 163-164) and the Gestalt researchers (Maier, 1931; Duncker, 1945; and Birch & Rabinowitz, 1951) have used interview data to support existing theories. The Gestalt researchers used interview data to support their contention that thinking consists of reorganizing problem information and to investigate productive and reproductive thinking. Their procedure involves posing a problem and observing attempts at solution, while giving certain prescribed hints (directions). Newell and Simon use interview research in an attempt to gain support for their previously discussed model. Specifically, they look for answers to a number of questions based on their model. These questions include:

1. Can the subject be viewed as working in some problem space?
2. If so, can one identify his problem space at the degree of detail that we have been using in our analyses?
3. Can the subject's behavior be viewed as making use of the sorts of problem
solving organizations we have introduced--
e.g., search strategies, heuristics, and so on?
4. Can one actually describe an IPS that
behaves like the subject--and to what de-
gree of detail? (Newell & Simon, 1972,
pp. 163-164).

Ginsburg (Note 1) supports this view:

The cognitive approach to assessment de-
pends on a theory of children's knowledge
of mathematics. We cannot do accurate
assessment until we know what cognitive
processes to assess. (p. 5)

He goes on to hypothesize three cognitive systems of chil-
dren's knowledge of arithmetic and uses interview data to
support these systems.

On the other hand, Clement, Kantowski, and Krutetskii
seem to follow Easley's belief that interview procedures
should be used to generate hypotheses, not to validate pre-
conceived notions. In this usage, the interviews are ex-
ploratory in nature. Krutetskii (1969a, 1969b, 1969c) does
not state hypotheses, but does use interview data to arrive
at general conclusions. Kantowski (1977) used "thinking
aloud" interview data to study thought processes such as
"means-end" analysis and heuristics, and to develop hypo-
theses for future investigation. Clement (Note 2) has de-
veloped and used a vocabulary and a method of interview anal-
ysis called "cognitive microanalysis." This procedure shows
promise of allowing more exact and replicable analysis of
interviews. He states his agreement with Easley:
We wish to develop models of intuitive reasoning processes that are grounded in detailed observations of authentic behavior, rather than in a prior analysis of the subject area. The reason for this stems from a research perspective in which we reject the blank slate or 'copy' theory of learning. (Clement, Note 2, p. 2)

It seems unlikely, however, that interviews can be conducted or analyzed without some prior conception, however imprecise, to guide choice of problems, interview procedures, and interview analysis. This study adopts the previous point of view. A specific model is hypothesized from problem solving methods and interviews are developed within this context.

**Determining Content Structure**

Several of the previously discussed methods of determining aspects of cognitive structure can also be used to determine aspects of content structure. Miller's (1969) card sorting procedure gives information about a kind of composite conceptual structure of a group of subjects. This can be considered also as a representation of conceptual content structure. The graph building procedure as used by Shavelson (1974) can be used to obtain the same kind of result. Branca's (1980) research obtained similar group results which could be taken to represent content structure. However, in that study (1980, p. 39), Branca actually used Shavelson's (1974) digraph procedure to analyze curriculum content structure, and then utilized the HILCUS program to obtain a representation of content structure.
A method for obtaining a "semantic structural graph" of a paragraph has been presented by Frederiksen (1972). His process involves three steps: (a) Important concept-classes are identified from the paragraph. (b) Relations between those classes are identified from the paragraph. (c) A figure is drawn which contains the concept-classes as nodes and the relations as links. This process is similar in some general respects to the development of the present specific model of trigonometry, but differs in three important ways: (a) The concepts and relations are drawn from a single paragraph of textual material rather than from a complex body of knowledge. (b) Many of the concepts and relations are simply inferred from the paragraph, as opposed to their actual existence in a body of knowledge. (c) It does not allow for problem solving. A similar (from the point of view of this study) procedure which has the same limitations was given by Crothers (1972).

More closely aligned with the purposes of this study is a procedure for constructing a digraph of textual material from physics (Shavelson, 1971, 1972; Geeslin & Shavelson, 1975a, 1975b; Shavelson & Geeslin, 1975). In this method key concepts are identified from the material, each sentence and formula are diagrammed according to specific rules, and from each diagram a digraph is constructed, again according to specific rules. The digraphs developed are combined into a super-digraph which can be converted into a similarity
matrix and analyzed by any of a variety of methods. This procedure is more closely aligned with the objectives of this study than the others discussed. However, it is still a static representation designed more to describe a way in which formulas and sentences are remembered than to be an active representation to describe problem solving. It is derived from semantic rather than problem solving considerations. Thus it is not considered to be adequate to meet the purposes of this study.

Comparisons of Content Structure and Conceptual Structure Possessed by Subjects

The present research involves developing representations of cognitive structure of subjects by comparison with a criterion model of content structure. This type of overall procedure has been used by a number of previous studies, but with great variation in detail. None of those described (Branca, 1980; Frederiksen, 1972; Crothers, 1972; Shavelson, 1971, 1972; Geeslin & Shavelson, 1975a, 1975b) were adequate to fulfill the purposes of this study for reasons previously discussed.
Chapter 3 discusses the methodology and the procedures used for the development of the model. It has four main parts: Part I is a discussion of the methodology used, including procedures, subject selection, and the validity and reliability measures used. Part II describes the initial development of the specific model of a conceptual structure of trigonometry. The specific model is described in Part III. Interview and analysis procedures are discussed in Part IV, along with predictions for cross-validation.

PART I: METHODOLOGY

Methodology is discussed in four sections: (a) Model Development and Data Collection; (b) Subject Selection; (c) Validity Measures; and (d) The Reliability Measure.

Model Development and Data Collection

The processes of model development, data collection, and data analysis had five stages:

1. The initial specific model of interrelationships of concepts in trigonometry was developed. Development procedures are described in Part II of this chapter and the initial model is presented in Part III.

2. Initial interview procedures were developed. These procedures are described in Part IV of this chapter.

3. Four subjects were selected and interviewed and
their interviews analyzed. Selection procedures are discussed later in this chapter. Analyses of the interviews are reported in chapter 4.

4. Based on the analyses of the interviews with these four subjects, the model itself and the interview and analysis procedures were refined. Results of the refinement are reported in chapter 4.

5. Two more subjects were selected, interviewed, and the interviews analyzed according to the refined model and procedures. Selection procedures will be discussed later in this chapter. Analyses of these two subjects are also found in chapter 4.

Subject Selection

The first four subjects were chosen by their instructor from a Mathematics 1012 class at Virginia Polytechnic Institute and State University near the end of the winter quarter of the 1979-80 school year. Mathematics 1012 is the middle course of a three quarter sequence designed for freshmen. The course includes trigonometry and some linear algebra. The teacher was instructed to choose one "A" student, one "B" student, one "C" student, and one "D" student. The last two subjects were chosen from another Mathematics 1012 class with a different teacher near the end of the spring quarter of the 1979-80 school year. The teacher was instructed to choose one A student and one D student. The first teacher
selected three female and one male student, while the second teacher selected two female students.

**Validity Measures**

Validity measures were of three types: (a) face validity; (b) comparison with word association data; (c) cross-validity. These are discussed in detail in chapter 4. Face validity requires that the measurement be consistent with the model and fulfill the stated purposes of the study. For comparison purposes, word association data was obtained from all six subjects using Geeslin and Shavelson's (1975a, 1975b) method. Cross-validation involved two steps: (a) On the assumption that differences between A and D students exist, these differences were predicted from the theory. (b) Analyses of the interviews of the A and D students were compared to determine if the differences between them were similar to the predicted differences.

**The Reliability Measure**

To check reliability directly would require at least one of the subjects to be interviewed and analyzed a second time by a different knowledgeable interviewer and the analyses compared. However, since learning takes place during the first interview, the analyses could not be expected to be similar. Thus a modification of this procedure was decided upon. The tape recordings and written work from the interviews with a student from the second interview phase were
analyzed by a second knowledgeable person and the analyses by the two individuals compared. It was decided to use a subject from the second interview phase in this reliability check since it was the interview process utilizing the refined model and instructions which needed to be examined.

PART II: DEVELOPMENT OF THE PRELIMINARY SPECIFIC MODEL

Trigonometry was chosen as the subject area for this study because it contains many complex interrelationships between concepts and was thus considered to be an ideal vehicle. Since trigonometry is a very broad area, it was decided to limit the study to the use of construction, trigonometric tables, the calculator, and the analytic use of the definitions of the six trigonometric functions. Three different approaches (right triangle, coordinate system, and unit circle) were used with different schemas and interviews for each. The definitions used are given next.

1. Right triangle definition. Let θ be an acute angle in a right triangle. Let "hyp" be the length of the hypotenuse, "opp" be the length of the side opposite θ, and "adj" be the length of the side adjacent to θ. Then:

\[
\begin{align*}
\sin \theta &= \frac{opp}{hyp} \\
\cos \theta &= \frac{adj}{hyp} \\
\tan \theta &= \frac{opp}{adj} \\
\csc \theta &= \frac{hyp}{opp} \\
\sec \theta &= \frac{hyp}{adj} \\
\cot \theta &= \frac{adj}{opp}
\end{align*}
\]

2. Coordinate system definition. Let θ be an angle in
standard position on a Cartesian coordinate system. Let $(x,y)$ be the coordinates of a point on the terminal side of $\theta$ and let $r$ be the distance from that point to the origin. Then:

\[
\begin{align*}
\sin \theta &= \frac{y}{r} & \csc \theta &= \frac{r}{y} \\
\cos \theta &= \frac{x}{r} & \sec \theta &= \frac{r}{x} \\
\tan \theta &= \frac{y}{x} & \cot \theta &= \frac{x}{y}
\end{align*}
\]

3. Unit circle definition. Let $s$ be the length of an arc in standard position on a unit circle on a Cartesian coordinate system. Let $(x,y)$ be the coordinates of the endpoint of the arc. Then:

\[
\begin{align*}
\sin s &= y & \csc s &= \frac{1}{\sin s} \\
\cos s &= x & \sec s &= \frac{1}{\cos s} \\
\tan s &= \frac{\sin s}{\cos s} & \cot s &= \frac{\cos s}{\sin s}
\end{align*}
\]

Once the specific area was established and limitations set, it was necessary to develop preliminary structures in which problem solving could be described, and which related to underlying conceptual structure. That is, the theory developed in chapter 2 was combined with a knowledge of the interrelations of concepts in trigonometry to produce the preliminary model schemas. The starting point for this was an examination of various methods of solving problems in the limited subject area. After many attempts at delineating possible problem solving paths and combining those into structures, three decisions were made which greatly facilitated the development of the preliminary model: (a) It was
decided that all actions should be performed along the lines joining the vertices and that these actions would be called connections. (b) It was decided that two schemas would be constructed for each interpretation, a detailed problem solving schema and a parent schema representing underlying conceptual structure. (c) It was decided that the vertices of the problem solving schemas would contain states of knowledge of particular instances of underlying concepts. These principles have been discussed in chapter 2.

With these principles established, the model development process can be described in a reasonably orderly fashion: (a) Problems involving the definitions were chosen. (b) Methods of solving these problems were examined. (c) States of knowledge utilized in problem solutions were identified. (d) Concepts were identified for which the states of knowledge were about instances of those concepts. (d) Problem solving methods were converted into problem solving paths which involved performing actions (connections), each of which begins with a state of knowledge of an instance of one of the identified concepts and ends with a state of knowledge of an instance of another (possibly the same) concept. (f) A figure (parent schema) was drawn in which each vertex represented one of the identified concepts and in which two concepts were directly joined by a line (link) if and only if, in at least one of the problem solving paths, states of knowledge of instances of the two
concepts were directly joined by some action (connection).

(g) A second figure (problem solving schema) was drawn in which the vertices have the same geometric relationships to each other as the corresponding vertices in the parent schema have to each other, but in which two vertices may be joined by more than one line, each of which represents an action (connection) and is labeled. The process just described is somewhat oversimplified, especially the figure drawing steps. Many attempts were made before reasonable geometric representations were obtained.

PART III: THE PRELIMINARY SPECIFIC MODEL

The preliminary specific model, developed by the procedures outlined in Part II of this chapter, has four sections: (a) The right triangle interpretation is represented by the R-schema section. (b) The coordinate system interpretation is represented by the C-schema section. (c) The unit circle interpretation is represented by the U-schema section. (d) The T-schema (trigonometry schema) section represents a unification of the C-schema and the U-schema by examining some relationships between them. Every section except the T-schema section follows the same format: Each section begins with a figure representing the parent schema, with a discussion of the relevant aspects of the concepts at its vertices and continues with a figure representing the problem solving schema with a listing of the relevant states.
of knowledge present in each vertex and a listing and description of the connections indicated in the figure. Each section concludes with a table representing the problem solving paths associated with the schema and a list of problems which can be solved using the paths. In all problem solving schemas, a dashed line indicates a joining up of states of knowledge from two concepts before performing an action (connection) which leads to a state of knowledge about another concept. The problem numbers associated with each problem solving path refer to problems in the list which can be solved by that path. The T-schema section is similar, except that the parent T-schema and problem solving T-schema are described rather than drawn.

**Preliminary Model R-Schema**

The preliminary model R-schema is a representation of a conceptual structure of right triangle trigonometry which can be used to describe problem solving behavior. It is based on the psychological theory outlined in chapter 2 and on problem solving methods utilizing the right triangle definitions of the six trigonometric functions.

**The Concepts at the Vertices of the Preliminary Model Parent R-Schema**

- **AM** Angle Measure

  This is the general angle measure concept.
FIGURE 3
PRELIMINARY MODEL PARENT R-SCHEMA
RT Right Triangle

The following aspects of the right triangle concept are considered.

1. Right triangle itself.
2. Meanings of opposite side, adjacent side and hypotenuse.

L Length

Only the lengths of line segments are considered.

R Ratio

This is the general ratio concept. Of importance to this study it includes:

1. Labels of the six trigonometric ratios.
2. The reciprocal concept.
3. Knowledge that division by zero is undefined.
4. Equivalence of ratios.

Connections in the Preliminary Model Problem

Solving R-Schema

1. Table. AM→R, R→AM, R→R.

   This is the use of the table in any of three ways:
   a. Given θ find Trig θ. (AM→R)
   b. Given Trig θ find θ. (R→AM)
   c. Given Trig₁ θ find Trig₂ θ. (R→R)

2. Calculator (Calc). AM→R, R→AM.

   This is the use of a calculator in either of two ways:
   a. Given θ find Trig θ. (AM→R)
   b. Given Trig θ find θ. (R→AM)
3. Construct (Const). \( \text{AM-RT, L-RT, } \frac{\text{AM}}{\text{L}} \rightarrow \text{RT.} \)

This connection is the act of constructing, with some accuracy, a right triangle meeting certain conditions. Those conditions are:

a. Knowledge of \( \theta \). (AM-RT)

b. Knowledge of \( \theta \) and A. (L-RT)

c. Knowledge of \( \theta \) and H. (L-RT)

d. Knowledge of \( \theta \) and one of A, H. (\( \frac{\text{AM}}{\text{L}} \rightarrow \text{RT} \))

e. Knowledge of \( \theta \) and O. (\( \frac{\text{AM}}{\text{L}} \rightarrow \text{RT} \))

These constructions are to be done with protractor, ruler, and, possibly, compass. Note that a through e simply represent different states of knowledge of instances of AM and L, and right triangles meeting those conditions are states of knowledge of instances of RT. In path 5a, described later, conditions d or e which involve states of knowledge of instances of both AM and L may be utilized. Conditions c, d, and e are rather difficult to meet by construction. An inability to meet them is not considered important in this study.

4. Sketch. \( \text{L-RT, } \frac{\text{AM}}{\text{L}} \rightarrow \text{RT.} \)

This involves only the act of making a rough sketch of a right triangle and including known information about the triangle.
5. Measure (Meas). RT→AM, RT→L.
This involves either the careful measuring of an acute angle of a right triangle with a protractor or of a side of a right triangle with a ruler. This connection can be used only if the "construct" connection was used to produce the triangle.

6. Form ratio (F rat). L→R.
In this connection, a ratio may be formed in one of two ways:
   a. If two of O, A, H are known, the numeric ratio of those two may be formed.
   b. If, as in path 5a, one of O, A, H is known and it is necessary to find another one, the algebraic-numeric ratio of those two may be formed.

7. Uniform ratio (U rat). R→L.
This involves the examining of a ratio such as O/H = 1/3 and producing possible values of O and H such as: O = 1, H = 3 or O = 2, H = 6.

8. Theorem of Pythagoras (TP). RT→RT.
This theorem really is a generalized schema which includes AM, RT, L and much more. Since its only importance in this study is its use, it is not represented in any detail and is considered a connection.

9. Take reciprocal (Rec). R→R.
This connection is subsumed within the ratio (R) concept,
FIGURE 4
Preliminary Model Problem Solving R-Schema
but requires special representation because of its importance in trigonometry.

10. Solve. R→L.

This is the solving of an equation. It occurs only in paths 5a and 5b. The state in R must be a ratio equation such as \( \sin \theta = \frac{O}{H} \) with \( \sin \theta \) and one of \( O \), \( H \) known. The equation is solved for the other of \( O \), \( H \) and the answer is a state of L.

11. Observe (Obs). RT→L, RT→AM.

This is simply the observing of a state of knowledge of one concept and transferring it to a state of knowledge of another concept. For example, if the state of knowledge at RT is a right triangle with \( O = 1 \) and \( H = 2 \), this could be observed and transferred to L where the state would be that the length of one line segment is \( O = 1 \) and of another is \( H = 2 \).

**States of Knowledge of the Concepts of the Preliminary Model Problem Solving R-Schema**

**AM**  
Degree measures of acute angles.

**RT**  
A right triangle with knowledge of any, all, or none of:

1. Length of hypotenuse.
3. Lengths of the two legs.
4. Labels (0 & A) of the two legs (related to one of the acute angles).
Knowledge of the lengths \((0, A, H)\) of any or all of the opposite side, adjacent side, and hypotenuse.

Knowledge of any of the following may be pertinent here:

1. Any trig \(\theta\) (trig \(\theta\) refers to any of \(\sin \theta, \cos \theta, \tan \theta, \cot \theta, \sec \theta, \csc \theta\)).

2. Any of \(O\) and \(\sin \theta\), \(H\) and \(\sin \theta\), \(A\) and \(\cos \theta\), \(H\) and \(\cos \theta\), etc.
Table 1.
Problem Solving Paths Through the Preliminary Model Problem Solving R-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>1a</td>
<td>AM → Table → R</td>
<td>1</td>
</tr>
<tr>
<td>1b</td>
<td>AM → Calc → R</td>
<td>1</td>
</tr>
<tr>
<td>1c</td>
<td>AM → Const → RT → Meas → L → F rat → R</td>
<td>1</td>
</tr>
<tr>
<td>2a</td>
<td>R → Table → AM</td>
<td>2</td>
</tr>
<tr>
<td>2b</td>
<td>R → Calc → AM</td>
<td>2</td>
</tr>
<tr>
<td>2c</td>
<td>R → U rat → L → Const → RT → Meas → AM</td>
<td>2</td>
</tr>
<tr>
<td>3a</td>
<td>R → Table → AM → Table → R</td>
<td>3</td>
</tr>
<tr>
<td>3b</td>
<td>R → Table → R</td>
<td>3</td>
</tr>
<tr>
<td>3c</td>
<td>R → Rec → R</td>
<td>4</td>
</tr>
<tr>
<td>3d</td>
<td>R → U rat → L → Const → RT → Meas → L → F rat → R</td>
<td>3</td>
</tr>
</tbody>
</table>
Table 1 (continued).

Problem Solving Paths Through the Preliminary Model Problem Solving R-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3e</td>
<td>R→U rat→L→Sketch→RT→TP→RT→Obs→L</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>F rat→R</td>
<td></td>
</tr>
<tr>
<td>4a</td>
<td>L→Const→RT→Meas→AM</td>
<td>5</td>
</tr>
<tr>
<td>4b</td>
<td>L→Sketch→RT→Obs→L→F rat→R→Table→AM</td>
<td>5</td>
</tr>
<tr>
<td>4c</td>
<td>L→Sketch→RT→Obs→L→F rat→R→Calc→AM</td>
<td>5</td>
</tr>
<tr>
<td>5a</td>
<td>L→Sketch→RT→Obs→AM→Table→R→Solve→L</td>
<td>6</td>
</tr>
<tr>
<td>5b</td>
<td>L→Sketch→RT→Obs→AM→Calc→R→Solve→L</td>
<td>6</td>
</tr>
<tr>
<td>5c</td>
<td>L→Const→RT→Meas→L</td>
<td>6</td>
</tr>
</tbody>
</table>
Problems with Associated Paths in R-Schema

1. Find \( \sin 50^\circ \). Paths: 1a, b, and c.

2. Given \( \tan \theta = .3 = 3/10 \), find \( \theta \). Paths: 2a, b, and c.

3. Given \( \tan \theta = 3/1 = 1.5 \), find \( \cos \theta \). Paths: 3a, b, d, e.

4. Given \( \sec \theta = 3/2 \), find \( \cos \theta \). Path: 3c.

\[ \text{Ask for reciprocals of } \sin \theta \text{ and } \cot \theta. \]

5. A ten foot ladder leans against a vertical wall. Its base is four feet from the wall. What angle does the ladder make with the ground?

If S has difficulty sketching the figure, I should assist him/her and then allow S to complete the problem, if s/he can. As indicated in the construct connection, this is a difficult instance to construct. Do not spend time to see if S can work out how to do it, but determine if s/he is aware that it can be done.

Paths: 4a, b, c.

6. To determine the height of a vertical bell tower, a marker is placed on the ground (assumed level) 100 feet from the base of the tower. The angle of elevation of the top of the tower is measured to be \( 40^\circ \). How tall is the tower? I may again need to assist S with the original sketch.

Paths: 5a, b, c.
Preliminary Model C-Schema

The preliminary Model C-schema is a representation of a conceptual structure of coordinate system trigonometry which can be used to describe problem solving behavior. It is based on the psychological theory outlined in chapter 2 and on problem solving methods utilizing the coordinate system definitions of the six trigonometric functions. It is considered that the coordinate system interpretation of trigonometry deals essentially with angles and thus no arc lengths are mentioned in C-schema. Although radian measure of angles can be used, in coordinate system trigonometry, only degree measure is considered in C-schema, leaving radian measure for U-schema and T-schema.

The Concepts at the Vertices of the Preliminary Model Parent C-Schema

AM Angle Measure
A Angle

This is the general angle concept except for angle measure which, in the study of trigonometry, appears important enough to be considered individually. This includes the meanings of:

1. Initial side.
2. Terminal side.
FIGURE 5
PRELIMINARY MODEL PARENT C-SHEMA
Point
This means a point on a coordinate system with meanings of $x$, $y$, $r$, and the distance formula $x^2 + y^2 = r^2$.

Ratio
This is the general ratio concept. It includes:
1. Labels of the six trigonometric ratios.
2. The reciprocal concept.
3. Knowledge that division by 0 is undefined.

Quadrant
This is the general concept of quadrant on a Cartesian coordinate system.

Absolute Value
This is the general absolute value concept. To go from one state of AV to another it may be necessary to use $x^2 + y^2 = r^2$.

Sign
This is the concept of positive and negative signs and the rules of operations with signs.

Reference Angle
This is the reference angle concept.

States of Knowledge of the Concepts of the Preliminary Model Problem Solving C-Schema

Angle Measure
This includes knowledge of the degree measure of any angle $\theta$. 
FIGURE 6
PRELIMINARY MODEL PROBLEM SOLVING C-SCHEMA
A Angle
This includes knowledge of any of the following:
1. Angle in standard position and its measure.
2. Location of the terminal side of an angle in standard position.
3. Angle in standard position and the measure of its reference angle.

P Point
This includes knowledge of a point on the terminal side of an angle in standard position with knowledge of any, all, or none of $x$, $y$, $r$.

R Ratio
This includes knowledge of any or all of the trigonometric ratios with associated labels or knowledge that a particular trigonometric ratio is undefined.

Q Quadrant
This includes knowledge of the quadrant in which a point or the terminal side of an angle in standard position lies.

AV Absolute Value
This includes knowledge of any or all of the following: $|x|$, $|y|$, $r$, $|\text{trig } \theta|$.

RA Reference Angle
This includes knowledge of the measure of the reference angle for an angle in standard position.
Sign

This includes knowledge of sign of any or all of the following: \( x, y, r, \text{trig } \theta \).

Connections in the Preliminary Model Problem
Solving C-Schema

1. Construct (Const). AM→A, P→A.
   a. Knowing the measure of \( \theta \), construct the angle \( \theta \) in standard position on a Cartesian coordinate system. (AM→A)
   b. Knowing a point on the terminal side of \( \theta \), construct \( \theta \) in standard position on a Cartesian coordinate system. (P→A)

2. Choose point (Ch pt). A→P.
   Having constructed \( \theta \) in standard position, choose any point on the terminal side of \( \theta \).

   a. Having located a point on the terminal side of \( \theta \), determine the needed values of \( x, y \) and/or \( r \) by measurement or use of graph paper. (P→P)
   b. Having an angle constructed in standard position, measure the angle. (Arc→AL)

4. Form ratio (F rat). P→R, AV→AV.
   a. Knowing the needed value or value or values of two of \( x, y, r \), form the desired ratio (trig \( \theta \)). (P→R)
   b. Knowing the absolute value of the needed value or values, form the desired ratio (|trig \( \theta | \)). (AV→AV)
5. Uniform ratio (U rat). R→P, AV→AV.
   a. Knowing trig θ, uniform the ratio. Examples: If sin θ = -2/3 then y = -2 and r = 3 or y = -4 and r = 6, etc. If tan θ = -2/3, then two possibilities must be considered and used: y = -2, x = 3 and y = 2 and x = -3. (R→P)
   b. Knowing |trig θ|, uniform the ratio getting two of the following: |x|, |y|, r. (AV→AV)

   a. Knowing the measure of θ, sketch θ in standard position. (AM→A)
   b. Knowing a point on the terminal side of θ, sketch θ in standard position. (P→A)
   c. Knowing the reference angle for θ and the quadrant in which the terminal side is located, sketch θ in standard position. (RA A)

   This is simply the act of observing a piece of known information and transferring it to another vertex.

8. R-Schema. RA→AV, AV→RA.
   This is the use of R-schema to relate the reference angle for θ and |trig θ|.

9. QSTF. Q→S, S→Q.
   This is the relationship between quadrant and signs of the trigonometric functions, i.e., knowing that sine is
positive in QI and QII and negative in QIII and QIV, etc.

10. QSXY. Q→S, S→Q.
This is the geometric relationship between quadrant and sign of x, y.

11. Affix sign (A sign). \( \frac{A}{S} \rightarrow R, \frac{A}{S} \rightarrow P \).
   a. Knowing the sign of \( \text{trig } \theta \) and \( |\text{trig } \theta| \), determine \( \text{trig } \theta \). \( \frac{A}{S} \rightarrow R \)
   b. Knowing sign of x and/or y and \( |x| \) and/or \( |y| \), determine x and/or y. \( \frac{A}{S} \rightarrow P \)

12. Form ratio of signs (F rat sign). S→S.
Knowing the signs of the appropriate two of x, y, r, determine the sign of the needed ratio (\( \text{trig } \theta \)).

13. Uniform ratio of signs (U rat sign). S→S.
Knowing the sign of the ratio (\( \text{trig } \theta \)) determine the signs of the appropriate two of x, y, r. There may be two such answers which may need to be continued through to obtain two answers (values of \( \theta \)).

   a. Knowing the measure of \( \theta \), use the calculator to find \( \theta \). (AM→R)
   b. Knowing \( \text{trig } \theta \), use the calculator to find \( \theta \). (R→AM)

15. Arithmetic and Geometry (AG). A→AM, A→RA.
a. From a sketch of $\theta$ in standard position which includes knowledge of the reference angle, find the measure of $\theta$. (A-AM)

b. From a sketch of $\theta$ in standard position and a knowledge of the measure of $\theta$, find the reference angle. (A-RA)

16. $x^2 + y^2 = r^2$ (TP). P-P, P-AV, AV-AV.

a. Knowing two of $x$, $y$, $r$, use $x^2 + y^2 = r^2$ to determine the two possible values of the unknown. This will lead to two answers. (P-P)

b. Knowing two of $x$, $y$, $r$, use the equation $x^2 + y^2 = r^2$ to determine the unknown, either $|x|$, $|y|$, or $r$. (P-AV)

c. Knowing two of $|x|$, $|y|$, $r$ use $x^2 + y^2 = r^2$ to determine the unknown of $|x|$, $|y|$, $r$. (AV-AV)

17. Take reciprocal (Rec). R-R.

This involves taking the reciprocal of the ratio trig$_1$ $\theta$ to get the ratio trig$_2$ $\theta$. 
### Table 2.

**Problem Solving Paths Through the Preliminary Model Problem Solving C-Schema**

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>1a</td>
<td>AM → Const → A → Ch pt → P → Meas → P → F rat → R</td>
<td>1</td>
</tr>
<tr>
<td>1b</td>
<td>AM → Sketch → A → AG → RA → R-Schema → AV → A Sign → R</td>
<td>1</td>
</tr>
<tr>
<td>1c</td>
<td>AM → Sketch → A → Obs → Q → QSTF → S → F rat sign → S → A sign → R</td>
<td>1</td>
</tr>
<tr>
<td>1d</td>
<td>AM → Calc → R</td>
<td>1</td>
</tr>
<tr>
<td>1e</td>
<td>AM → Sketch → A → Ch pt → P → Obs → P → F rat → R</td>
<td>2</td>
</tr>
<tr>
<td>2a</td>
<td>R → U rat → P → Const → A → Meas → AM</td>
<td>3</td>
</tr>
<tr>
<td>2b</td>
<td>R → Obs → AV → R-Schema → RA → Sketch → A → AG → AM</td>
<td>3</td>
</tr>
<tr>
<td>2c</td>
<td>R → Obs → S → QSTF → Q → Observation → RA → Sketch → A → AG → AM</td>
<td>3</td>
</tr>
<tr>
<td>2d</td>
<td>R → Calc → AM</td>
<td>3</td>
</tr>
<tr>
<td>2e</td>
<td>R → U rat → P → Sketch → A → AG → AM</td>
<td>4</td>
</tr>
</tbody>
</table>
### Table 2 (continued).

Problem Solving Paths Through the Preliminary Model Problem Solving C-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3a</td>
<td>P → F rat → R</td>
<td>8</td>
</tr>
<tr>
<td>3b</td>
<td>P → TP → P → F rat → R</td>
<td>9</td>
</tr>
<tr>
<td>3c</td>
<td>P → TP → AV → A sign → P → F rat → R</td>
<td>5</td>
</tr>
<tr>
<td>3d</td>
<td>P → TP → AV → F rat → AV → A sign → R</td>
<td>5</td>
</tr>
<tr>
<td>3e</td>
<td>P → TP → AV → A sign → P → F rat → R</td>
<td>6</td>
</tr>
<tr>
<td>3f</td>
<td>P → TP → P → F rat → R</td>
<td>7</td>
</tr>
<tr>
<td>4a</td>
<td>R → rec → R</td>
<td>10</td>
</tr>
</tbody>
</table>
Table 2 (continued).

Problem Solving Paths Through the Preliminary Model Problem Solving C-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>4b</td>
<td>R → U rat → P → TP → P → F rat → R</td>
<td>11</td>
</tr>
<tr>
<td>4c</td>
<td>R → Obs → AV → U rat → AV → TP → AV → F rat → AV → A sign → R</td>
<td>12</td>
</tr>
<tr>
<td>4d</td>
<td>R → Obs → AV → U rat → AV → TP → AV → A sign → P → F rat → R</td>
<td>12</td>
</tr>
<tr>
<td>4e</td>
<td>R → Obs → AV → U rat → AV → TP → AV → F rat → AV → A sign → R</td>
<td>13</td>
</tr>
</tbody>
</table>
Problems with Associated Paths in C-Schema

1. Find \( \cos 127^\circ \). Paths: 1a, 1b, 1c, 1d.
2. Find (a) \( \tan 180^\circ \), (b) \( \cos 270^\circ \). Path 1e.
3. Given: \( \cot \theta = 1.6 = -16/10 \), find \( \theta \). Paths: 2a, 2b, 2c, 2d.
4. Given: \( \sin \theta = -1 \), find \( \theta \). Path: 2e.
5. Given: \( x = -1, r = 3 \) for a point on the terminal side of \( \theta \), an angle in Q3, find \( \sin \theta \). Paths: 3c, 3d.
6. Given: \( y = 3, r = 7 \), and \( x < 0 \). Find \( \sec \theta \).
   Path: 3e.
7. Given: \( x = -2, r = 5 \). Find \( \cot \theta \). Path: 3f.
8. Given: \((2, -3)\) is on the terminal side of \( \theta \), find \( \cot \theta \). Path: 3a.
9. Given: \((2, -3)\) is on the terminal side of \( \theta \), find \( \sec \theta \). Path: 3b.
10. Given: \( \sin \theta = -2/3 \), find \( \csc \theta \). Path: 4a.
11. Given: \( \cot \theta = -2/3 \), find \( \sin \theta \). Path: 4b.
12. Given: \( \cot \theta = -2/3 \), \( \theta \) in QIV. Find \( \sin \theta \). Paths: 4c, 4d.
13. Given: \( \sec \theta = 4 \), \( \sin \theta < 0 \). Find \( \tan \theta \). Path: 4e.

Preliminary Model U-Schema

The preliminary Model U-schema is a representation of a conceptual structure of unit circle trigonometry which can be used to describe problem solving behavior. It is based on the psychological theory outlined in chapter 2 and on
problem solving methods utilizing the unit circle definitions of the six trigonometric functions. It is considered that the unit circle interpretation deals with arcs on a unit circle and with arc lengths (real numbers), so angles and degree measure are not included. Since, in the unit circle interpretation, the sine and cosine functions are coordinates of points rather than ratios, knowledge of \(\sin s\) and \(\cos s\) are considered to be in the P vertex with all other trigonometric labels in the R vertex. This leads to some ambiguity in the paths. If the known or desired trig is \(\sin s\) or \(\cos s\), the P vertex must be used in the problem solving path while if it is any other trig \(s\), the R vertex must be used. Thus, any given path may have to be adjusted slightly with different known or desired trig \(s\). This is especially true in path 4e which is a representative of a class of paths involving different given and desired trig \(s\). The one representative given is considered to be sufficient.

The Concepts at the Vertices of the Preliminary Model Parent U-Schema

AL Arc Length
Arc Arc

This is the general arc concept. It includes:

1. Arc on a unit circle.
2. Arc in standard position on a unit circle on Cartesian coordinate system.
FIGURE 7
PRELIMINARY MODEL PARENT U-SCHEMA
P  Point
This is the same concept as in C-schema. In U-schema, however, the labels $x = \cos s$ and $y = \sin s$ for a particular point will be important.

R  Ratio
This is the same concept as in C-schema. In U-schema, however, the trigonometric ratios are ratios of $\sin s$ and $\cos s$ instead of ratios of $x, y,$ and $r$. Also, the only trigonometric ratios here are $\csc s$, $\sec s$, $\cot s$, and $\tan s$ which are defined as follows:
$csc s = 1/\sin s$, $sec s = 1/\cos s$, $cot s = \cos s/\sin s$, and $\tan s = \sin s/\cos s$.

AV  Absolute Value
This is the general absolute value concept. It is the same concept that is in C-schema.

S  Sign
This is the general sign concept. It is the same concept that is in C-schema.

Q  Quadrant
This is the general quadrant concept. It is the same concept that is in C-schema.

RArc  Reference Arc
This is the usual reference arc concept.
FIGURE 8
PRELIMINARY MODEL PROBLEM SOLVING U-SCHEMA
States of Knowledge of the Concepts of the Preliminary Model Problem Solving U-Schema

**AL Arc Length**
This includes knowledge of the lengths of any arc on a unit circle (restricted to $0 \leq s < 2\pi$).

**Arc Arc**
This includes knowledge of any of the following:
  a. Arc in standard position on a unit circle and its measure.
  b. Arc in standard position on a unit circle and the measure of its reference arc.

**P Point**
This includes knowledge of the end point of an arc of length $s$ in standard position on a unit circle with knowledge of either, both, or none of $x$ and $y$. It also includes knowledge that $y = \sin s$ and $x = \cos s$.

**R Ratio**
This includes any or all of $\csc s = 1/\sin s$, $\tan s = \sin s/\cos s$, $\cot s = \cos s/\sin s$ or knowledge that one of these ratios is undefined.

**Q Quadrant**
This includes knowledge of the quadrant in which a point lies.

**AV Absolute Value**
This includes knowledge of any or all of the following: $|x|$, $|y|$, $1$, $|\text{trig } \theta|$. 
S Sign

This includes knowledge of the sign of any or all of the following: \(x, y, 1, \text{trig } \theta\).

RArc Reference Arc

This includes knowledge of the length of the reference arc for an arc in standard position.

Connections in the Preliminary Model Problem

Solving U-Schema

1. Construct (Const). \(\text{AL-Arc, P-Arc}\).
   
a. Knowing a real number \(s\), construct an arc of length \(s\) in standard position on a unit circle. This will be somewhat inaccurate since no way is available to accurately measure arc length. (AL-Arc)

2. Measure (Meas). \(\text{ArcP, Arc-AL}\).
   
a. Having an arc constructed in standard position, determine \(x\) and/or \(y\) for the end point by measurement or by use of graph paper. (Arc-P)
   
b. Having an arc constructed in standard position, determine the arc length by estimation (since there is no accurate method of measurement). (Arc-AL)

3. Form ratio (Frat). \(\text{P-R, AV-AV}\).
   
a. Knowing the needed value or values of \(\sin s\) or \(\cos s\), form the desired ratio (trig s). (P-R)
   
b. Knowing the absolute value of the needed value or values, form the desired ratio (|\text{trig s}|). (AV-AV)
4. Uniform ratio (U rat). R→P.
   
a. Knowing trig s (other than sin s or cos s), uniform the ratio. This is more difficult than in C-schema because of the necessity to fulfill the condition \(x^2 + y^2 = 1\) or \(\sin^2 s + \cos^2 s = 1\). In some instances, this may lead to two possibilities which may need to be carried through. (R P)

5. Sketch. AL→Arc, P→Arc, \(\text{RArc}_Q\rightarrow\text{Arc}\).
   
a. Knowing the measure of the arc, sketch it in standard position. (AL→Arc)
   
b. Knowing the end point of the arc in standard position, sketch it. (P→Arc)
   
c. Knowing the measure of the reference arc and the quadrant, sketch the arc in standard position. (\(\text{RArc}_Q\rightarrow\text{Arc}\))

   
This is simply an act of observing a piece of known information and transferring it to another concept.

7. Table. RArc→AV, AV→RArc.
   
a. Knowing the length of the reference arc for s, use the table to find \(|\text{trig } s|\). (RArc→AV)
   
b. Knowing \(|\text{trig } s|\), use the table to find the length of the reference arc. (AV→RArc)
8. QSTF. Q→S, S→Q.
   This is the relationship between quadrant and signs of
   the trigonometric functions.

9. QSXY, Q→S, S→Q.
   This is the relationship between quadrant and signs of
   x and y.

10. Affix sign (A sign). \( \frac{AV}{S} \rightarrow R, \frac{AV}{S} \rightarrow P \).
    
    a. Knowing \(|\text{trig } S|\) (other than \(\sin S\) or \(\cos S\))
    and the sign of \(\text{trig } S\), determine \(\text{trig } S\). \(\frac{AV}{S} \rightarrow R\)

    b. Knowing \(|x|\) and/or \(|y|\) and its (their) respective sign(s), affix the sign(s) to determine \(x\) and/or
    \(y\); or, equivalently, knowing \(|\sin S|\) and/or \(|\cos S|\) and
    its (their) sign(s), affix the sign(s) to determine
    \(\sin S\) or \(\cos S\). \(\frac{AV}{S} \rightarrow P\)

11. Form ratio of signs (F rat sign). S→S.
    Knowing the signs of the appropriate two of \(x, y, 1\)
    (\(\cos S, \sin S, 1\)), determine the sign of \(\text{trig } S\). Ac-
    tually, if \(\text{trig } S\) is \(\sin S\) or \(\cos S\) it will not be nec-
    essary to form a ratio.

12. Unform ratio of signs (U rat sign). S→S.
    Knowing the sign of \(\text{trig } S\), determine the signs of the
    appropriate two of \(x, y, 1\) (\(\cos S, \sin S, 1\)). There
    may be two such answers which may need to be carried
    through to obtain two answers.

13. Calculator (Calc). AL→(Por R), (P or R)→AL.
a. Knowing $s$, the length of an arc in standard position, use the calculator to find trig $s$. 
\(AL \rightarrow F \) or \(F \rightarrow R\).  
b. Knowing trig $s$, use the calculator to find $s$. 
\(F \) or \(R \rightarrow AL\)

   a. From a sketch of an arc in standard position which includes a knowledge of the reference arc, find the length of the arc. (Arc-AL) 
   b. From a sketch of an arc in standard position with knowledge of the length of the arc, determine the length of the reference arc. (Arc-RArc) 

15. $x^2 + y^2 = 1 \ (\cos^2 s + \sin^2 s = 1)$ (TP). P-P, P-AV.  
   a. Knowing one of $x, y$ (\(\cos s, \sin s\)), use the equation $x^2 + y^2 = 1 \ (\cos^2 s + \sin^2 s = 1)$ to find the other. This will lead to two answers. (P-P) 
   b. Do the same to find $|x|$ or $|y|$ ($|\cos s|$ or $|\sin s|$). (P-AV) 

16. Take reciprocal (Rec). R-R, P-R, R-P. 
   a. Take the reciprocal of either tan $s$ to get cot $s$ or cot $s$ to get tan $s$. (R-R) 
   b. Take the reciprocal of either sin $s$ to get csc $s$ or cos $s$ to get sec $s$. This connection is not indicated separately on the problem solving U-schema, but is considered as subsumed in form ratio (P-R) 
   c. Take the reciprocal of either csc $s$ to get
sin s or sec s to get cos s. This connection is considered as subsumed in the uniform ratio connection.

(R-P)

Problems with Associated Paths in U-Schema

1. Find (a) \( \sin 4 \); (b) \( \tan 4 \). Paths: 1a, 1b, 1c, 1d.

2. Find sec \( 3\pi/2 \). Path: 1e.

3. a. Given: \( \tan s = -2 \). Find s.
   
   b. Given: \( \cos s = -2 \). Find s. Paths: 2a, 2b, 2c, 2d.

4. Given: \( \cos s = 0 \). Find s. Path: 2e.

5. Given: \((x, y)\) is the end point of an arc of length s in standard position and \( x = -.2 \). Find sec s.
   'Path: 3a.

6. Given: \( y = -.7 \). Find sin s and then tan s. Path: 3b.

7. Given: \( y = -.7 \) and \((x, y)\) is in QIV. Find tan s.
   Paths: 3c, 3d.

8. Given: \( y = -.7 \) and \( x > 0 \). Find tan s. Path: 3e.


10. a. Given: \( \cot s = -3/5 \). Find sin s.
    
    b. Given: \( \sec s = 3/2 \). Find tan s. Path: 4b.

11. Given: \( \cos s = 1/3 \) and the end point of s is in QIV. Find cot s. Paths: 4c, 4d.

12. Given: \( \sin s = -3/4 \) and \( \cos s > 0 \). Find tan s.
    Path: 4e.
Table 3.
Problem Solving Paths Through the Preliminary Model Problem Solving U-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>1a</td>
<td>AL → Const → Arc → Meas → P → F rat → R</td>
<td>1</td>
</tr>
<tr>
<td>1b</td>
<td>AL → Sketch → Arc → AG → R Arc → Table → AV → A sign → R or P</td>
<td>1</td>
</tr>
<tr>
<td>1c</td>
<td>AL → Sketch → Arc → AG → R Arc → Table → AV → A sign → R or P</td>
<td>1</td>
</tr>
<tr>
<td>1d</td>
<td>AL → Calc → R or P</td>
<td>1</td>
</tr>
<tr>
<td>1e</td>
<td>AL → Sketch → Arc → Obs → P → F rat → R</td>
<td>2</td>
</tr>
<tr>
<td>2a</td>
<td>R → U rat → P → Const → Arc → Meas → AL</td>
<td>3</td>
</tr>
<tr>
<td>2b</td>
<td>P or R → Obs → AV → Table → R Arc → Sketch → Arc → AG → AL</td>
<td>3</td>
</tr>
</tbody>
</table>
Table 3 (continued).

Problem Solving Paths Through the Preliminary Model Problem Solving U-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>2c</td>
<td>(P or R) Obs → AV → Table → RArc → Sketch → Arc → AG → AL</td>
<td>3</td>
</tr>
<tr>
<td>2d</td>
<td>(P or R) Obs → S → U rat sign → S → QSXY → Q → AL</td>
<td>(one answer only) 3</td>
</tr>
<tr>
<td>2e</td>
<td>R → U rat → P → Sketch → Arc → AG → AL</td>
<td>4</td>
</tr>
<tr>
<td>3a</td>
<td>P → F rat → R</td>
<td>5</td>
</tr>
<tr>
<td>3b</td>
<td>P → TP → P → F rat → R</td>
<td>6</td>
</tr>
<tr>
<td>3c</td>
<td>P → TP → AV → A sign → P → F rat → R</td>
<td>7</td>
</tr>
<tr>
<td>3d</td>
<td>Q → QSXY → S → U rat sign → S → AV → F rat → AV → A sign → R</td>
<td></td>
</tr>
</tbody>
</table>
Table 3 (continued).

Problem Solving Paths Through the Preliminary Model Problem Solving U-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3e</td>
<td><img src="image1" alt="Diagram" /></td>
<td>8</td>
</tr>
<tr>
<td>4a</td>
<td>(P or R) → Rec (R or P)</td>
<td>9</td>
</tr>
<tr>
<td>4b</td>
<td><img src="image2" alt="Diagram" /></td>
<td>10</td>
</tr>
<tr>
<td>4c</td>
<td><img src="image3" alt="Diagram" /></td>
<td>11</td>
</tr>
<tr>
<td>4d</td>
<td><img src="image4" alt="Diagram" /></td>
<td>11</td>
</tr>
<tr>
<td>4e</td>
<td><img src="image5" alt="Diagram" /></td>
<td>12</td>
</tr>
</tbody>
</table>
Preliminary Model T-Schema

The T-schema (trigonometric schema) is the schema which is the union of the C-schema and the U-schema. As such, the vertices have already been defined. In fact, the vertices labeled P, AV, R, S, and Q are in both C-schema and U-schema. All that remains to be investigated are the connections and links between (a) AM and AL, (b) A and Arc, and (c) RA and RArc. The connection between AM and AL is the equation $\pi/180 = s/\theta$. The connection between A and Arc is the geometric principle that a particular angle in A can be considered as the central angle for the arc in Arc. The connection between RA and RArc is the same.

Problems with Associated Paths in T-Schema

1. Given a table with only degree measure; find $\cos .8$. 
   Path: 1.

2. Given a table with only degree measure; find $\sin 35^\circ$. 
   Path: 2.

3. Given an angle constructed in standard position; construct an arc whose length is the same as the radian measure of the angle. Paths: 3a, 3b.

Table 4.

Problem Solving Paths Through the Preliminary Model Problem Solving T-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Problem</th>
<th>Solution Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>$\frac{\pi}{180} = \frac{s}{\theta}$</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>$\frac{\pi}{180} = \frac{s}{\theta}$</td>
</tr>
<tr>
<td>3a</td>
<td>3</td>
<td>$A \rightarrow \text{Const} \rightarrow \text{Arc}$</td>
</tr>
<tr>
<td>3b</td>
<td>3</td>
<td>$\text{RA} \rightarrow \text{Const} \rightarrow \text{RArc}$</td>
</tr>
<tr>
<td>4a</td>
<td>4</td>
<td>$\text{Arc} \rightarrow \text{Const} \rightarrow A$</td>
</tr>
<tr>
<td>4b</td>
<td>4</td>
<td>$\text{RArc} \rightarrow \text{Const} \rightarrow \text{RA}$</td>
</tr>
</tbody>
</table>
PART IV: INTERVIEW AND ANALYSIS PROCEDURES

This part discusses the interviews which were given, including the specific instructions for each interview, the possible modes in which a subject can operate within each interview, and instructions for analysis of the interviews. Although some interview instructions were developed prior to the beginning of the interviews, they were modified and expanded during and after analysis of the interviews held with subjects one (S1) and two (S2). Both the instructions for analysis of the interviews and the modes of operating during the interviews were also developed during and after analysis of the interviews with S1 and S2. The modes of operation and interview instruction 6 were developed since it became clear that subjects may prefer to use a different interpretation than the one intended in a given interview and both the modes and instruction 6 were designed to deal with this problem. The interview and analysis instructions are reported here, out of chronological order, to aid the reader in understanding the interview analyses. It should be noted that the interviews with S1 and S2 were reanalyzed according to the given analysis instructions and modes of operation and these reanalyses are reported in chapter 4. Subjects three (S3), four (S4), five (S5), and six (S6) were analyzed according to the given analysis instructions and modes of operation. In addition, S5 and S6 were interviewed according to the given instructions. Part IV has four sections:
(a) Interview Development and Schedule; (b) Interview Instructions; (c) Modes of Operation; and (d) Analysis Instructions.

**Interview Development and Schedule**

Based on the problems and problem solving paths previously reported, four interviews were developed to determine each S's schemas (R-schema, C-schema, U-schema, T-schema). The development took the form of the interview instructions reported in this part of chapter 3. The interviews were named "R-interview," "C-interview," "U-interview," and "T-interview." It was intended to interview each subject in four one-hour sessions. The R-interview and T-interview were expected to last less than one hour and the C-interview and U-interview to last more than one hour, overlapping on two sessions. This expectation was upheld, but exigencies of time schedules prevented having four one-hour sessions with each subject. Various schedules were followed depending on the convenience of each subject. Actual time spent in interviews per subject varied from two and one-half hours to four hours.

**Interview Instructions**

**General Instructions**

1. Give instructions on limits of the interview to be held as indicated in instructions for each interview.

2. Pose problem.
3. Observe response. Ask S to describe his method so each step may be clearly delineated.

4. Remove tool used. (Table, reciprocal, calculator, protractor, "QTSF" connection, Theorem of Pythagoras, etc.)

5. Repeat 2 through 4 until S either follows each appropriate path as indicated in Model paths or demonstrates an inability to do so. Be sure to determine exactly which step S is unable to complete. With careful judgement interviewer (I) may be able in some instances to determine that S can utilize a particular path without using the time to actually do it. For example, in the R-interview, if S has successfully used the calculator previously and has just utilized path 3b, I may question S as to what S would do without the table.

6. The principle of direction should be carefully used in two ways: (a) to encourage S to operate in the desired interpretation and in the most appropriate mode; and (b) to correct S's errors if such errors would prevent determination of whether S can use other connections which could not be reached if the error were not corrected. The complexity of the interviews does not allow a complete and precise listing of all hints to be given. Instead, it is necessary to leave this to I's judgement. Some examples of type (a) are:

   i. Do you know another definition of sine?
   ii. What is r? (in the U-interview)
iii. What does $x$ represent? (coordinate of a point or side of a triangle?)

It may be necessary to tell $S$ the definition of sine in a particular interpretation and see if $S$ can list the definitions of the other five trigonometric functions and if other connections may be utilized.

7. In some instances, $S$ may follow a non-Model path which causes a connection never to be reached or used. When this occurs, I should set up conditions, within the context of the problem, which allow determination of $S$'s ability to use that connection.

8. If no sketch is drawn where a sketch is appropriate, I should ask $S$: "Do you have a picture in your mind?" If so, I should ask $S$ to draw the picture.

Instructions for R-Interview

The objective of the R-interview is to determine a representation of the structure of the right triangle interpretation that is present in $S$'s mind. Therefore, $S$ should be instructed at the beginning of the R-interview that the interview is restricted to right triangle trigonometry.

Instructions for C-Interview

The objective of the C-interview is to determine a representation of the structure of the coordinate system interpretation that is present in $S$'s mind. Therefore, $S$ should
be instructed at the beginning of C-interview to avoid use of the unit circle, radian measure, and arc length.

It may not be necessary to examine each listed path with each S. For example, if S successfully follows paths 1b, 1c, 2b, and 2c, it will be assumed that S is capable of using the QSXY and QSTF connections and thus it will only be necessary to determine if S can utilize one of 3c and 3d. This assumption and others are written with logical symbols as follows:

$$1b \lor 1c \land 2b \land 2c \rightarrow 3d$$
$$1b \lor 1c \land 2b \land 2c \land 3d \rightarrow 3c$$
$$3c \lor 3d \rightarrow 3e$$
$$1a \lor 3b \lor 3c \lor 3d \lor 3e \lor 3f \rightarrow 3a$$
$$3f \rightarrow 3b$$
$$1b \lor 1c \land 3a \land 4c \rightarrow 4d$$
$$1b \lor 1c \land 3a \land 4d \rightarrow 4c$$

Use of the table, calculator, and protractor will be allowed on problems 1 and 3 only, with the exception that the calculator can be used to do arithmetic at any time.

Instructions for U-Interview

The objective of the U-interview is to determine a representation of the structure of the unit circle interpretation that is present in S's mind. Therefore, S should be instructed at the beginning of the U-interview to avoid use of angles, triangles, and degree measure.
As in the C-schema, some assumptions must be made in the interest of time. Because of the complications of having some labels of the trigonometric functions in \( P \) and some in \( R \), it is necessary to consider various modifications of the basic paths. It is not considered to be necessary to list all of the modifications. The assumption will be made that a subject who can utilize a basic path or any of its modifications can utilize all modifications. However, the problems in the interview will cover the various possibilities of starting at \( P \) and/or \( R \) and ending at \( P \) and/or \( R \).

Other assumptions are indicated by symbolic logic notation:

\[
\begin{align*}
1a & \lor 3b \lor 3c \lor 3e \lor 4b \lor 4c \lor 4d \rightarrow 3a \\
1b \land 1c \land 12b \land 12c \land 13c & \rightarrow 3d \\
1b \land 1c \land 12b \land 12c \land 13d & \rightarrow 3c \\
3c \lor 3d & \rightarrow 3e \\
4a & \text{ from C-schema} \rightarrow 4a \\
1b \land 1c \land 12b \land 12c \land 14c & \rightarrow 4d \\
1b \land 1c \land 12b \land 12c \land 14d & \rightarrow 4c
\end{align*}
\]

Use of the table, calculator, and construction methods will be permitted on problems 1 and 3 only, with the exception that the calculator may be used to do arithmetic at any time.

Instructions for T-Interview

The purpose of the T-interview is to determine if \( S \)
can utilize the connections described earlier in the T-schema. The geometric connection between RA and RArc will not be investigated since it is the same as that between A and Arc. The use of a calculator for anything other than arithmetic is prohibited in this interview.

**Modes of Operation**

**R-Interview Modes**

1. S stated and used the right triangle definitions ($\sin \theta = \text{opp}/\text{hyp}$, etc.) even if S drew coordinate systems and even if S preferred to use the coordinate system definitions. In the last instance S's R-schema would be considered weaker than S's C-schema.

2. S used a, b, and r consistently and could not be forced into using opp, adj, but consistently did not draw coordinate systems. In this situation it is felt that S really worked in R-schema but lacked the labels opp, adj, hyp, and the definitions $\sin \theta = \text{opp}/\text{hyp}$, etc., and thus the vertices RT and R in R-schema would be considered to be weak.

3. S consistently drew coordinate systems and could state the right triangle definitions but used a, b, and r even when encouraged to use opp, adj, and hyp. In this situation, S may have possessed some or all of R-schema as determined by the R-interview, but it is considered weaker than S's C-schema, and R and RT must be considered to be weak.
4. S consistently drew coordinate systems and could not state or use the right triangle definitions even when required to do so. In this situation some of R-schema may have been present. The vertices AM, RT, and L and the connections between them may be determined by the R-interview as present, although the absence of the labels opp, adj, and hyp will make RT at best weak. In this situation the R vertex is considered absent from S's R-schema and therefore all connections to the R vertex are absent.

C-Interview Modes

1. S used a, b as coordinates of a point on the terminal side of $\theta$ and r as the distance of that point from the origin. Two circumstances are considered evidence of this condition: (a) In drawings, S used (a,b) as a point on the terminal side of the angle. (b) S correctly worked with quadrantal angles without using triangles, but this is of less importance since it could easily have been remembered rather than used in the coordinate system interpretation.

2. S used a, b, r, both positive and negative values, but used them as sides of a triangle instead of coordinates of a point and a distance from the origin. Two circumstances are considered evidence of this condition: (a) In drawings, S consistently used a, b, r as labels for sides of triangles instead of using (a,b) as a point even after encouragement to use (a,b) as a point. (b) S insisted on
trying to draw and use triangles when asked about quadrant angles, or perhaps the lack of a triangle forces S into a remembered unit circle approach with no ability to use a point other than (0,1), (1,0), (1,-1) or (-1,0). In this situation, a complete Model C-schema may be present, but P must be considered as weak.

3. S used a, b, r, but only as sides of triangles and did not use negative values of a and b, even if S may have memorized that \( \cos \theta < 0 \) for \( \theta \) in QII, etc. This condition is the same as condition 4 except for the labels used, therefore the same comments apply.

4. S persisted in using opp, adj, and hyp even when encouraged to use a, b, r and could not state the coordinate system definition or stated it but persisted in not using it. In this situation, S could conceivably have possessed (in C-schema) the vertices AM, A, RA, and Q and the connections between them. Whether S possessed any of these should be determined by analysis of C-interview. S could not have possessed the vertices P, AV, R, or S or any connections involving them. Clearly, S's R-schema is stronger than S's C-schema under this condition.

5. S persisted in using \( r = 1 \) and \( \sin \theta = y \), etc., and was unable to use some other value of \( r \) and \( \sin \theta = y/r \), etc. An S operating in this mode appears to be using a schema composed of part of C-schema and part of U-schema. Certainly AM, A, and RA from C-schema could be present, but
the P and R that are being used are clearly part of U-schema and not part of C-schema. The remaining vertices, AV, S, and Q could be in either, but it seems more reasonable to represent them in U-schema and investigate their presence in U-interview. Therefore only vertices AM, A, and RA are considered to be present in S's C-schema. A complete U-schema and connections between AM, A, and RA and S's U-schema could be present. This must be determined by U-interview and T-interview analysis.

U-Interview Modes

1. S used, perhaps with encouragement, arc, arc length, end point of the arc, and the labels \( \sin s = y \) and \( \cos s = x \). In this situation all vertices and connections of U-schema could be both present and strong. This must be determined by U-interview analysis.

2. S used, perhaps with encouragement, arc on a unit circle, arc length and the end point of the arc, but used the ratio \( \sin s = y/1 \) instead of \( \sin s = y \), etc. In this situation all vertices and most connections of U-schema could be present. This must be determined by U-interview analysis. However, the label \( \sin s \) would be present in R instead of P causing both R and P to be considered weak and also causing some modifications of paths and connections. R is considered weak, not because it contains too little knowledge, but because it contains knowledge it should not contain.
3. S used points on the unit circle and unit circle definitions but did not, even after encouragement, use arc and arc length, persisting instead with angles and angle measure (degree or radian). In this situation the vertices AL, Arc and RArc are absent from S's U-schema. The vertex P could be considered present in S's U-schema since the labels \( \sin \theta = y \) and \( \cos \theta = x \) are present. However, P would be considered weak since S appears to have viewed it as a particular point on the terminal side of the angle rather than as the end point of an arc. The other vertices R, Q, S, and AV may have been present and strong. This must be determined by analysis of U-interview. However, there is an alternate view of this situation. Since the only vertices (AL, Arc, RArc) not present in C-schema were noticeably absent here, it might be considered that S has just assimilated the unit circle definitions into C-schema as a special case (always choosing \( r = 1 \)) to P and a revision of knowledge in R (\( \tan \theta = \sin \theta / \cos \theta \), etc.). From this viewpoint, S possessed no U-schema at all. It appears, from the following example, that this is the more accurate viewpoint. When asked to find \( \sin .3 \), an S behaving in this way would consider .3 as the radian measure of an angle and proceed. It seems more consistent to consider that S would proceed through a modified C-schema than to consider that S would jump to a weak U-schema and proceed. Thus, an S meeting
this condition is believed not to have possessed a U-schema at all and instead to have worked in a modified C-schema.

4. \( S \) used angles and angle measure (degree or radian) and the coordinate system definitions or the right triangle definitions (even if \( r = 1 \) and unit circles are drawn) even after encouragement to use arcs and the unit circle. In this situation the vertices \( AL, Arc \) and \( RArc \) are clearly absent. \( P \) and \( R \) are also considered absent from U-schema since none of the states of knowledge which these vertices need to be in U-schema were demonstrated. The other vertices, \( AV, Q \), and \( S \), may be present in C-schema, but in this situation \( S \) is considered to possess no U-schema at all. U-interview analysis may indicate that \( S \) can use radian measure in C-schema.

**Analysis Instructions**

First, it is necessary to be very clear on several definitions. The terms "vertex" and "connection" have been defined in the description of the Model by a discussion of each one. In the various schemas at the problem solving level, each connection may be used in various situations (joining various vertices). A "link" is an association between two concepts in the Model or in S's cognitive structure and is represented by a line segment joining two vertices in the parent schema. Exactly what constitutes such an association is determined by examining the connections between the
vertices in the corresponding schema at the problem solving level.

Vertices and links possessed by S may be strong, weak, or absent, and a connection in a given situation may be present or absent. The first consideration in determining the strength of a vertex is the mode of operation used by S during the interview. The discussion of each mode contains some instructions which establish the maximum possible strength for some vertices in the schema possessed by S. A vertex is considered to be strong in a particular schema if proper utilizations of all of the appropriate states of knowledge of that vertex were demonstrated by S, weak if S could not properly utilize at least one state of knowledge, and absent if no state of knowledge could be utilized by S during the interview. For example, in S's C-schema, the R vertex would be considered to be weak if S used \( \sec \theta = \frac{a}{r} \) and this appeared to be a real misconception rather than an inadvertent error. The strength of each vertex is to be indicated on the representation of S's schema by a solid dot for a strong vertex and an open circle for a weak vertex.

A connection is considered present in a given situation if it was utilized by S in that situation, whether it was used properly or improperly. Such a connection is to be indicated on the representation of S's schema at the problem solving level by a line segment or curve joining the two vertices. In some situations, states of knowledge from two
vertices must be utilized in making a connection to a third vertex. An example is the "Affix sign" connection in C-schema in the $AV_\rightarrow R$ situation. Here, the absolute value of $\text{trig } \theta$ is present in $AV$ and the sign of $\text{trig } \theta$ is present in $S$. The "Affix sign" connection joins these two, affixes the sign, and the result is a state of knowledge in $R$. If this connection is determined to be present in $S$'s C-schema, it would be represented by dashed lines drawn from that point to $R$ (see Figure 6 for an illustration).

A connection in a particular situation is considered absent from $S$'s schema if $S$ did not utilize it at all during the interview. When this occurs, the interview should be examined carefully to determine if $S$ evidenced an inability to use that connection in that situation, or if the opportunity to use the connection in that situation did not arise. The latter eventuality can occur if $S$ uses paths (perhaps not in the original model) which do not require the connection in that situation, or if $S$ makes an error which prevents the opportunity from arising. The incidence of this occurrence will be greatly reduced by careful adherence to interview instructions 6 and 7. Any connection considered to be absent in a particular situation for whatever reason will not be represented in that situation in $S$'s schema.

A link is considered to be strong if all connections appropriate to that link in the situations appropriate to
that link were properly utilized. It is considered weak if S properly utilized some but not all such connections and absent if S did not properly use any such connections. Some qualifications must be made to the definitions. The difficulty described earlier concerning avoidance of a connection in a particular situation presents a problem here. If the only connection missing for a link to be strong is one which was avoided in that situation, the link is considered to be strong. A link which has only one connection associated with it in the Model is a special case. If, during analysis of that connection, no weaknesses were observed in the use of the connection in the situation appropriate to that link, the link is considered to be strong. If such weaknesses were observed, the link is considered to be weak. If use of that connection in that situation was avoided during the interview, then the link must be considered to be absent.

Careful adherence to interview instruction 7 would avoid this situation. On representations of S's schemas at the conceptual level, strong links are indicated by solid lines, weak ones by dashed lines, and absent links are not represented.

Analysis to determine which mode of operation S utilized during an interview can be complicated if S uses more than one mode in one interview. The occurrence of this situation can be minimized or avoided by skillful interviewing utilizing interview instruction 6. When it does occur, the
interview should be analyzed to determine the mode in which S can operate which is the most appropriate for that interview. S's ability to operate in this mode determines an upper limit on S's capabilities. Then all problems attempted in that mode may be analyzed to determine the presence, absence, and strengths of the various possible vertices, connections, and links. However, careful analysis of problems attempted in other modes may gain information about S's schemas. This analysis must involve only paths and connections in which actions taken are the same in the mode used as in the more appropriate mode. If S required much encouragement to stay in the interpretation desired, the preferred schema would be considered to be stronger, but this would not affect determination of strengths and weaknesses within the schema being investigated. For an example of this situation, see the analysis of the U-interview with subject 2.

From the actual methods followed in analyzing the interviews with subjects 1 and 2, the following procedure for interview analysis was developed. The taped record should be analyzed one problem at a time. For each problem, the following items should be tabulated: Model path followed; non-Model paths followed; Model paths which were not followed; vertices utilized; and connections in various situations which were (a) utilized properly, (b) not utilized properly due to an evidenced inability, and (c) not utilized due to
avoidance. Non-Model paths and connections in various situations should be explicitly determined and noted. As this is being accomplished, the mode(s) of operation should be determined.

After analysis of the individual problems, each non-Model path used by S should be carefully determined and recorded. A determination of strengths of vertices should be made and a list compiled. Each connection should be examined to determine in which situations it was used and not used and to determine any exhibited weaknesses. This information should be listed.

The actual report should begin by stating the mode of operation used by S during the interview. Evidence should be cited to support the conclusion that S operated in that mode. The proper conclusions about possible vertices should be stated. After consideration of mode of operation comes a discussion of the presence or absence of vertices in S's schema and of the strengths of those which are present. The conclusions should be supported by evidence. The next section, if needed, should be a discussion of any non-Model paths followed. In some instances it will be necessary to report each path explicitly; in others, general discussion may be sufficient. A discussion of all connections involved in the interview follows. For each connection the report should include whether the connection is present or absent
in each situation and a discussion of any difficulties or errors in S's use of the connection.

This information could be summarized in figural representations of S's parent and problem solving schemas, constructed according to the rules described earlier. However, if the figures are similar enough to the Model schemas, they may be described by listing the differences.

Cross-Validation Predictions

The cross-validation procedures involves (a) predicting differences between A and D students from the Model, and (b) examining interview analyses of A and D students to determine if the predictions can be upheld. Since the Model has been developed, the predictions can be made.

The major predicted difference is that each schema possessed by an A student is more complete and more accurate than the corresponding schema possessed by the D student. One way this could happen is that the A student possesses a schema that the D student does not possess. For schemas that they both possess, any or all of the following differences could be present:

1. The A student's parent schema should contain more vertices than the D student's, and more of them should be strong.

2. The A student's parent schema should contain more
links than the D student's, and more of them should be strong.

3. The A student's problem solving schema should contain more correct and fewer incorrect connections than the D student's.
CHAPTER 4

INTERVIEW ANALYSES AND MODEL REFINEMENT

As indicated in chapter 3, the analyses of the interviews of the first four subjects were used to refine the Model. This chapter describes this process. It has five parts: (a) Interview Analyses of the First Four Subjects; (b) The Refined Model; (c) Analyses of S5 and S6; (d) Validity; and (e) Reliability.

PART I: INTERVIEW ANALYSES OF THE FIRST FOUR SUBJECTS

Procedures for analyzing the interviews are reported in chapter 3. The analyses reported here follow those guidelines. It should be noted that the teacher selected S3 as the A student, S2 as the B student, S4 as the C student, and S1 as the D student. The subjects' final grades agreed with this prediction, except that S2 earned a C instead of the expected B. This information was not made known to the researcher until after the subjects were interviewed and the interviews were analyzed.

It should be noted here that the trigonometry course these subjects were taking emphasized coordinate system trigonometry much more strongly than either the right triangle or unit circle interpretations.
Subject 1: Interview Analyses

R-Interview Analysis

The major conclusion about Subject 1 is that S operated in Mode 4 and, at the time of the interview, had no real conception of right triangle trigonometry. S's definition of the sine function was \( \sin \theta = \frac{b}{r} \) and S could not even be forced into using opp/adj. S stated that right triangle trigonometry had been discussed in class only two days before and indicated an inability to use right triangle trigonometry. In addition, every figure that was drawn, with one exception, included a coordinate system. In two or three instances, S mentioned, but never really used the unit circle. It is clear from the R-interview that, although S had been instructed to use right triangle trigonometry, S did not and could not. S's thinking involved use of the coordinate system interpretation almost exclusively. For this reason, Figure 9 is very limited. Many of the paths followed by S in R-interview actually involve utilizing some connection to C-schema and working within C-schema. These connections will be discussed more fully later.

S clearly possesses three (AM, RT, L) of the vertices of R-schema with one qualification. S does not have the state of knowledge of RT which involves knowledge of the labels "opposite" and "adjacent." Therefore, the RT vertex is considered to be weak and the AM and L vertices to be strong. In consideration of the R vertex, although S can
label the trigonometric ratios, these ratios are known and utilized in the coordinate system interpretation and not in the right triangle interpretation. For this reason, the R vertex is not included in Figure 9.

Of the connections in R-schema, S was able to utilize only "sketch" and "observe." S used other connections, which will be discussed later, but these were actually within the C-schema. S's use of the two connections with R-schema only occurred while attempting to solve problems 5 and 6, the applied problems. These were the only two instances in the interview when S attempted to use right triangle trigonometry. In working problem 5, S utilized the "sketch" connection in the L-RT situation properly but then added a coordinate system, jumped to P in C-schema, and finished the problem in C-schema. S did not succeed in solving problem 6, but failed at the end of the problem because of choosing the wrong function earlier. In the attempt, S utilized sketch in the L_{AM-RT} situation and observe in the RT-AM and RT-L situations. In a false start at solving problem 3, S drew a right triangle with a 60° angle on a coordinate system. From this it is inferred that S can utilize the sketch connection in the AM-RT situation. The sketch connection is considered present in the three appropriate situations. The observe connection is considered to be present in the two appropriate situations.

As indicated earlier, some paths followed by S appear
FIGURE 9
SUBJECT 1: PROBLEM SOLVING R-SHEMA
FIGURE 10
SUBJECT 1: PARENT R-SCHEMA
to be in C-schema instead of R-schema. Path 4b of C-schema was utilized to solve problem 3 except that only one answer was found. The paths AM \rightarrow Table \rightarrow R and AM \rightarrow Calc \rightarrow R and their reversals are viewed as being in S's C-schema since the coordinate system definitions of the trigonometric functions were used throughout the interview. One connection which joins R-schema to C-schema was used by S to change right triangle problems to coordinate system problems. This connection is the act of sketching a coordinate system on a right triangle. (RT \rightarrow Sketch \rightarrow P) S utilized the first of these connections in the following path to solve problem 4.

\[ \text{L} \rightarrow \text{Sketch} \rightarrow \text{RT} \rightarrow \text{Sketch} \rightarrow \text{P} \rightarrow \text{F rat} \rightarrow \text{R} \rightarrow \text{Table} \rightarrow \text{AM} \]

R-schema \hspace{2cm} C-schema

In summary, the sketch and observe connections are considered to be present in S's R-schema while all other connections are absent. Other conclusions are summarized in Figures 9 and 10.

Subject 1: C-Interview Analysis

Subject 1 appeared to operate in Mode 2 throughout the C-interview, considering a, b, and r as sides of a triangle. This was evidenced by four behaviors: (a) S used the coordinate system definitions of the trigonometric functions, using both positive and negative values of a and b (and once even wondered if r could be negative). (b) Although
coordinate systems were drawn, a, b, and r were always (with one exception) indicated as sides of a triangle rather than as a point (a,b). (c) When asked to find tan 180°, S went immediately to the point (-1,0) and, when questioned, showed an inability to use any other point, indicating that this was a memory response only. (d) When asked to find θ if sin θ = -1, S drew a triangle in the second quadrant, indicated a, b, and r as sides of the triangle and was unable to complete the problem. Since S operated in Mode 2, all connections in the Model C-schema could be present and all vertices could be strong except that the P vertex must be considered to be weak.

S properly utilized all relevant states of knowledge of the AM, A, Q, AV, S, and RA vertices, so these are considered to be present and strong in S's C-schema. In utilizing the R vertex, S had no difficulty with either the reciprocal concept or division by zero, but did make errors in remembering which label is attached to which trigonometric ratio. In one instance (problem 1), S used cos θ = b/r and later corrected it after some questioning by I. In another instance (problem 13), S incorrectly used sec θ = r/b. Thus the R vertex must be considered to be weak.

Some discussion of paths followed by S is necessary here. No construction path was utilized. All calculator paths were used correctly. Only one path involving "QSTF" was utilized and it improperly. Difficulty in using some
paths involving "remembering" to determine the sign of the answer separately or to find answers in two quadrants was evident. In finding \( \cos 127^\circ \) by table, the bottom part of path 1c (finding the sign) was ignored until the answer was found to be negative using the calculator, and then S followed the bottom part correctly. In following path 2c (if \( \cot \theta = -1.6, \) find \( \theta \)), S remembered to find the sign, but did it incorrectly due to an improper use of QSTF (\( \cot \theta \) is negative so \( \theta \) must be). Just why S and many other students have this difficulty cannot be determined from the interview, but two suggestions can be offered. It may be that, as a result of previous training, S feels that when a number is obtained the problem is solved. Or, it may be that the weakness in the point concept described earlier (considering \( a, b, \) and \( r \) as sides of a triangle) may lead to an ignoring of signs since lengths are positive.

Three non-Model paths were utilized by S. The first was an incorrect method which S used to find \( \theta \) if \( \cot \theta = -1.6 \) (problem 3).

The second involved the addition of a sketch to path 3c. These new paths involve some new connections which will be discussed.

The "construct" and "measure" connections were not
utilized by S at all, evidencing no construction ability. It may well be that S could measure line segments and possible angles but the failure to do so indicates that the measure connection was not present in S's C-schema. Similarly, the construct connection is absent.

The "choose point" connection could be available only in construction or quadrantal angle paths. S did no construction and was capable of using only one point (-1,0) on the terminal side of 180°, indicating, at best, a very weak understanding of the choose point connection, but that it is present in the A-P situation.

The "form ratio" connection was utilized in P-R situations but not in AV-AV situations. This appears to be due to the fact that it could be utilized in AV-AV situations only in conjunction with the "QSTF" connection which, as described later, is absent from S's C-schema. Because of this information the form ratio connection is considered to be absent from S's C-schema in the AV-AV situation and present in the P-R situation. However, the reverse "unform ratio" connection was used properly in both R-P and AV-AV situations and is considered to be present in both situations.

S properly utilized the sketch connection in the AM-A situation and, as indicated in the new paths discussed earlier, in the Q-A and Q-P situations. Because of S's error (cot θ < 0 → θ < 0) in problem 3 and use of the unit
circle interpretation in problem 4, the interview provides no opportunity to observe whether the sketch connection can be used in either the \( R_A^Q \rightarrow A \) or P\( -A \) situations. Therefore, the sketch connection is considered to be present in the AM\( -A \), Q\( -A \), and Q\( -P \) situations, and absent in the Q\( -A \) and P\( -A \) situations. It was added to the Model in the Q\( -A \) and A\( -P \) situations.

The observe connection was correctly used by S in all appropriate situations (A\( -Q \), P\( -P \), R\( -AV \), R\( -S \)) and is considered to be present in S's C-schema in these situations.

Since S used the table in every instance in which R-schema could be used, the table connection is considered to be in S's C-schema instead of the R-schema connection. This is also consistent with the R-interview analysis. S repeatedly utilized the table connection properly in the RA\( -AV \) situation but had some difficulty in the AV\( -RA \) situation. This difficulty involved confusion over whether to use the column with the label on top or the column with the label on the bottom and may have been due to S's expressed unfamiliarity with the specific table used. Although this weakness was evident, S did utilize the connection properly in that situation and the table connection is considered to be present in S's C-schema in both situations.

Concerning the "QSTF" and "QSXY" connections, it is obvious that the QSXY connection was far stronger in R's C-schema since it was chosen in every instance over the
QSTF connection. In fact, S considered the QSTF connection only when asked by I to tell whether a particular trigonometric function was positive or negative in a particular quadrant and why. S answered these questions readily using the QSXY connection, but since S never used the QSTF connection, it is considered to be absent from S's C-schema. On the other hand, the QSXY connection was used correctly in all appropriate situations (Q→S, S→Q) and is considered present in S's C-schema in those situations.

The affix sign connection was used correctly by S in the two expected situations \( R_A \to R, A_V \to P \) and in one new one, \( R_A \to A_M \). This new one arose from the incorrect solution of problem 3 due to use of the "\( \cot \theta < 0 \to \theta < 0 \)" connection. This connection is considered to be present in S's C-schema in all three situations. The new situation was added to the Model.

The "form ratio of signs" (S→S) and "uniform ratio of signs" (S→S) were appropriately used and are considered to be present in S's C-schema in the S→S situation. The uniform ratio of signs connection was not used in problem 4 (path 2c) due to an error (\( \cot \theta < 0 \to \theta < 0 \)) which prevented its use, but it was used properly in S's attempt to work problem 13.

The "calculator" connection is considered to be present in S's C-schema since it was used correctly in both situations (\( A_M \rightarrow R, R \rightarrow A_M \)).
The "AG" connection was properly used in the A-RA situation, but S's error (cot θ < 0 → θ < 0) in problem 3 prevented the opportunity for S to utilize the AG connection in the A-AM situation. This connection is considered present in the A-RA situation and absent in the A-AM situation.

S showed a number of difficulties in using the "x² + y² = r²" connection. S showed an ability to use it to find r but also an inability to use it to find either x or y correctly. In addition, when attempting to find x or y, S on some occasions ignored totally the possibility of a negative answer. Thus the x² + y² = r² connection is considered as present in S's C-schema in the P-P, P-AV, and AV-AV situations. Since this connection is the only connection joining P and AV and it was not used properly in the P-AV situation, the link joining P and AV must be considered weak.

The "take reciprocal" connection (R-R) was utilized properly and is considered present in S's C-schema.

One totally new, but incorrect, connection was used by S. This was S's conclusion, in problem 3, that θ must be negative since cot θ is negative. This connection is named cot θ < 0 → θ < 0 and is considered present in S's C-schema. It may be indicative of a more general statement: "trig θ < 0 → θ < 0," but this is not certain. The presence of this erroneous idea may be in part due to the absence of the QSTF connection.
FIGURE II
SUBJECT I: PROBLEM SOLVING C-SHEMA
S1's parent C-schema is the preliminary Model parent C-schema with circles at the P and R vertices (indicating that they are weak) and dashed lines joining AM to A, A to P, P to AV, and Q to S (indicating that they are weak links). S1's problem solving C-schema is represented by Figure 11.

Subject 1: U-Interview Analysis

The major conclusion from the U-interview is that S operated in Mode 4 and possessed no U-schema at all. At one point S indicated no understanding of arc or arc lengths. After extensive questioning, hints, and even explanations by I, it was clear that S had no conception of arc on a unit circle. At another point, with a unit circle drawn, I asked S to indicate an arc. S drew a chord in reply. The idea of unit circle, if not totally absent, was so weak as to be virtually unusable. S was aware of the points (1,0), (0,1), (-1,0), and (0,-1) as being on the circle, but did not, in any instance, utilize or indicate knowledge that \( r = 1 \). In fact, during a discussion involving the unit circle, S indicated that \( r = -.7 \). During the C-interview, S successfully solved a quadrantal angle problem, but was incapable of doing so in the U-interview.

In addition to an almost total lack of comprehension of arc, arc length and unit circle, S was unable to give the definitions of the trigonometric functions in the unit circle interpretation but used coordinate system
definitions only. When pressed for another definition, S could only give a right triangle definition (which indicates that some learning must have taken place since the R-interview). Also, it is clear that S thought exclusively in terms of triangles as S also did during the C-interview. Supporting this conclusion is the fact that S was unable to find sec $\frac{3\pi}{2}$ due to not being able to "visualize the triangle" when in fact no triangles are necessary, needed, or even helpful.

Since knowledge about both the end point of an arc on a unit circle and the definitions $\sin s = y$ and $\cos s = x$ are essential for $P$ in the U-schema, this vertex along with Arc, AL (arc length) and RArc (reference arc) are considered to be absent from S's U-schema. In addition, since the definitions $\tan s = \sin s / \cos s$, etc., could not be remembered or utilized by S, the R (Ratio) vertex is also considered to be absent. Without these vertices, the U-schema is essentially nonexistent and thus no representative figure can be drawn.

Subject 1: T-Interview Analysis

The T-interview was designed to investigate connections between U-schema and C-schema. Since S possessed no U-schema, no such connections are possible, yet some information about S's knowledge of trigonometry was gained, and some new insights about the Model C-schema were gained.

When a table which contained only radian measure of
angles (arc length) was given to S and S was asked to find cos .8, S succeeded with a minimum of assistance. But, since S has no knowledge of arc length (AL), it is clear that the \( \pi/180 = s/\theta \) connection was not used to join AL and AM. Instead, S considered .8 to be the degree measure of an angle rather than an arc length. This indicates that, for S, radian measure is part of the AM vertex in C-schema and the connection \( \pi/180 = s/\theta \) was utilized in the situation AM-AM. S also properly utilized this connection in reverse order. Thus it appears that radian measure is part of AM in S's C-schema and that the connection AM-\( \pi/180 = s/\theta \rightarrow \)AM is part of S's C-schema. However, since it cannot be known whether S possessed this ability at the time of the C-interview, this connection will not be included on S's C-schema.

As expected, S was unable to utilize paths 3 and 4.

Subject 2: Interview Analyses

Subject 2: R-Interview Analysis

Subject 2 appeared to be using Mode 3 for the R-interview. S consistently drew coordinate systems and used, a, b, and r exclusively. That S actually could state the right triangle definitions is more difficult to determine due to a weakness of the interview. When encouraged to use definitions other than the coordinate system definitions, S occasionally mentioned \( \tan \theta = \sin \theta/\cos \theta \), but only once mentioned or used opp, adj, and hyp. In this instance, S
wrote "\( \cos \theta = \text{adj/hyp} \)" and properly identified the adjacent side and hypotenuse of the right triangle. At this point I should have inquired further to determine if S knew the rest of the right triangle definitions. Instruction 6 was added to the interview instructions partly in an attempt to avoid this situation. In the absence of more concrete information, it is inferred that S was at least aware of the right triangle definitions and that R and RT are present in S's R-schema, but they are considered to be weak, because of the preference for the a, b, and r definitions.

During R-interview, S showed an ability to utilize all appropriate states of knowledge of the vertices AM and L and thus these are considered present and strong. The RT vertex is considered weak because of the tendency to use a, b, and r instead of opp, adj, and hyp. The R vertex is considered weak for four reasons: (a) S consistently used \( \sin \theta = \frac{b}{r} \), etc., instead of \( \sin \theta = \frac{\text{opp}}{\text{hyp}} \), etc. (b) S was unable to solve either applied problem by trigonometric methods and failed to utilize the second state of knowledge of R (opp and \( \sin \theta \), etc.). (c) S mentioned and tried to use \( \tan \theta = r \) (although S also used \( \tan \theta = \frac{b}{a} \) correctly). (d) S also used \( \tan \theta = \frac{\sin \theta}{\cos \theta} \) as a definition.

Concerning the table connection, it was used by S in all appropriate situations (AM→R, R→AM, R→R). However, there is a weakness in the R→AM situation in that when asked to find \( \theta \) if \( \tan \theta = .3 \), S attempted to use .3 as the
radian measure of an angle and correction was required by I. S's use of the table connection in the R-R situation is not evident from the tape, but was observed and recorded by I during the interview. This connection was not utilized in either applied problem, but this appears to be due to weaknesses in the form ratio and uniform ratio connections which prevented S from having the opportunity to use the table. The table connection is thus considered to be present in S's R-schema.

S was unable to use the calculator for trigonometric purposes and the calculator connection is considered to be absent from S's R-schema.

The construct, sketch, measure, take reciprocal, and observe connections were properly utilized by S in all appropriate situations and are considered present in each.

Interview analysis revealed that S utilized both the form ratio and uniform ratio connections, but found weaknesses in the form ratio connection. As indicated earlier, this connection involves the ability to form a strictly numeric ratio and also the ability to form an algebraic-numeric ratio. S showed the ability to form a numeric ratio in several instances, but failed totally to do so in an applied problem. In another applied problem, which presented the only opportunity to form an algebraic-numeric ratio, S was unable to do it. Thus both connections are considered to be present in S's R-schema.
The Theorem of Pythagoras was utilized by S in the one appropriate situation, but S originally failed to take the square root, which indicated a slight weakness. The "Theorem of Pythagoras" connection is considered present in S's R-schema.

The "solve" connection was not used by S during the interview due to the failure of S to use the form ratio connection. This connection is considered to be absent from S's R-schema. It appears that I should have made the form ratio connection for S in order to determine if S could utilize the solve connection. Instruction 6 should help to avoid this situation also.

S2's problem solving R-schema is identical to the preliminary Model R-schema except that the calculator connection (AM→R, R→AM) and the solve connection (R→L) are missing. S2's parent R-schema is like the preliminary Model R-schema except that the vertices RT and R are open circles (since they are weak), and the lines joining AM to R and R to L are dashed (since they represent weak links).

Subject 2: C-Interview Analysis

During the C-interview, S operated in Mode 2. Much evidence for this can be cited. Early in the interview, I made a great effort to encourage S to use (a,b) or (x,y) as coordinates of a point. This was finally achieved on problem 1, but S immediately abandoned the idea and used, a, b, r as sides of a triangle for most of the remainder of the
interview. S did use both positive and negative values of a and b and even r. On the first quadrantal angle problem (find tan 180°), S used a unit circle method with the point (-1, 0), seemingly forced into this remembered method by the absence of a triangle. That this is a remembered procedure is evident from a consideration of S's method on the second quadrantal angle problem (find θ if sin θ = -1). On this problem, S used (0,-1) and stated that he remembered to use that point. He could state that sin θ = b/r = -1 = -1/1 but then unformed the ratio incorrectly, getting b = 1 and r = -1, and could not use this procedure to obtain the point (0,-1). Since S operated in Mode 3, the P vertex is considered to be weak.

The vertices AM, A, RA, AV, Q, and S were all properly utilized by S and are considered to be present and strong in S's C-schema. As previously discussed, the P vertex is considered weak due to the observed tendency to consider a, b, and r to be sides of a triangle. S also exhibited a weakness in the R vertex in that, although S used sin θ = b/r and cos θ = a/r, S defined the remaining four trigonometric functions in terms of sin θ and cos θ (tan θ = sin θ/cos θ instead of tan θ = b/a, etc.). It may appear that S is here using U-schema, but this is not considered to be the case since arcs and unit circles were not utilized in C-interview. S could use tan θ = b/a, etc., but S had to derive them from sin θ = b/r, cos θ = a/r, and
\[
\tan \theta = \frac{\sin \theta}{\cos \theta}, \text{ etc. That this tendency is a weakness is evident since S deduced from } \cot \theta = \frac{-16}{10} \text{ that } \sin \theta = 10 \text{ and } \cos \theta = -16, \text{ which is impossible.}
\]

This subject utilized eight new paths which were not included in the original model. Two of these involved unnecessary complications of path 2a. Sketches were added to paths 3c, 3d, 3e, 3f, 4d, and 4e. These sketches are considered significant and will be added to the model. Due to frequent use of the definitions \( \tan \theta = \frac{\sin \theta}{\cos \theta}, \text{ etc.} \), S found it necessary to add extra segments to various paths. As an example, to find \( \tan \theta \), S found it necessary to form three ratios (\( \sin \theta = \frac{b}{r}, \cos \theta = \frac{a}{r}, \tan \theta = \frac{\sin \theta}{\cos \theta} \)) instead of one (\( \tan \theta = \frac{b}{a} \)). Since these additional segments stem from weaknesses in S's R vertex, they will not be added to the model. It does seem valuable to add one of S's new paths to the model as a replacement of path 4d. (Refer to Part II of this chapter, the Refined Model, for the new path 4d.)

S properly utilized the construct connection on the AM-A link, but avoided using it on the P-A link by developing new paths which used the construct connection in a new way: \( \stackrel{AV}{Q} \rightarrow A \). The construct connection is considered to be present in the AM-A and \( \stackrel{AV}{Q} \rightarrow A \) situations and absent in the P-A situation.

The choose point (A-P) connection was used only in the quadrant angle problem, which as indicated earlier, is
likely a remembered response. S's inability to utilize the connection properly led to failure to find cos 127° by construction. This connection is considered present in S's schema in the A-P situation.

S failed to utilize the measure connection in the P-P situation due to the inability to use the choose point connection. It was properly used in the A-AM situation and, in a new path, the A-RA situation. From this, and the fact that S properly measured lengths in a construction, the measure connection is considered present in S's C-schema in the A-AM and A-RA situations and absent in the P-P situation.

S failed to utilize the measure connection in the P-P situation due to the inability to use the choose point connection. It was properly used in the A-AM situation and, in a new path, the A-RA situation. From this, and the fact that S properly measured lengths in a construction, the measure connection is considered present in S's C-schema in the A-AM and A-RA situations and absent in the P-P situation.

The form ratio connection was properly used in all instances except one in which the inability to use the choose point connection prevented its use. Thus it is considered to be present in S's C-schema in the AV-AV and P-R situations.

Use of the uniform ratio connection in the R-P
situation was avoided in some instances by alternate paths but was properly and efficiently used in that situation in other instances. It was used properly in the AV-AV situation. S also used the connection in an inappropriate situation (R-R), concluding that, since cot θ = cos θ/sin θ = -2/3, that sin θ must be 3. However, this error was due to a previously discussed weakness in the R vertex rather than to a weakness in the uniform ratio connection. Thus this connection is considered to be present in S's C-schema in the R-P, AV-AV, and R-R situations.

The sketch connection was properly used by S in the AM-A and RA → A situations. It was not used in the P-A situation due to the use of new paths. In addition, it was used in a new situation (Q-P) in six of the new paths. Therefore, the sketch connection is considered to be present in S's C-schema in the AM-A, RA → A and Q-P situations, and it was added to the Model C-schema in the Q-P situation.

S properly utilized the observe connection in all four of the Model situations (P-P, A→Q, R→AV, R→S). In addition, S utilized it in the P→Q situation in the two new paths and in the A→AM situation in one new path. Thus the observe connection is considered to be present in S's C-schema in all six situations. Since the new path in which this connection was used in the A→AM situation was considered simply to be a complication of the existing path 2a, and was not incorporated into the Model, the observe connection was not
included in the Model C-schema in the A→AM situation. Since the new sketch paths were incorporated into the Model paths, the observe connection was added to the Model C-schema in the P→Q situation.

The "R-schema" connection was used correctly in both the RA→AV and AV→RA situations, so it is considered present in S's C-schema in both situations. The table was used in both directions and the calculator in one (RA→AV) which is interesting since S indicated, in the R-interview, an inability to use the calculator to do trigonometry.

S properly utilized the QSTF connection in several instances in the Q→S situation, but when queried as to why \( \cos \theta \) is negative in the second quadrant, the reply was, "The teacher told me." In using this connection in the direction S→Q, S repeatedly failed to realize that answers in two quadrants were needed. The QSTF connection is considered to be present in S's C-schema in the Q→S and S→Q situations.

Similarly, the QSXY connection was properly used in the Q→S direction, but single answers were repeatedly given when two answers were required. This connection is considered to be present in S's C-schema in both situations.

The affix sign connection was correctly utilized in the appropriate situations \( \overset{\text{AV}}{S} \to R, \overset{\text{AV}}{S} \to P \) and is considered to be present in S's C-schema in both situations.

Neither the form ratio of signs nor uniform ratio of signs connections were utilized in the C-interview. S
avoided the first by avoiding the use of the QSXY connection (path 2d) while solving problem 3. The second was avoided by using a new path. Since the connections were not evidenced during C-interview, they are considered absent from S's C-schema.

The calculator connection could be used in only one direction, AM-R, and is considered to be present in S's C-schema in that situation, but absent in the R-AM situation.

S correctly used the AG connection in the expected situations, A-AM and A-RA, but also in the RA-A situation. Since this new use was in a new path which was not added to the Model, the AG connection was not added to the Model in the RA-A situation. Of course, it is considered to be present in S's C-schema in the A-AM, A-RA, and R-A situations.

The $x^2 + y^2 = r^2$ connection was properly used in the P-AV situation, but in the P-P situation, S, on occasion, found and used only the positive solution. This connection was not used in the AV-AV situation since S did not follow path 4c at all and used the seventh new path in place of path 4d. The $x^2 + y^2 = r^2$ connection is considered to be present in S's C-schema in the P-AV and P-P situations, but absent in the AV-AV situation.

S properly utilized the "take reciprocal" connection
FIGURE 12
SUBJECT 2: PROBLEM SOLVING C-Schema
(R-R) in all instances and it is considered to be present in S's C-schema in that situation.

S's parent C-schema is identical to the preliminary Model C-schema except that the vertices P and R are open circles (since they are weak) and the lines joining A to P and AM to R are dashed (since they represent weak links). The other results from this interview are summarized in Figure 12.

Subject 2: U-Interview Analysis

Upon examination of the tape record and the scratch paper used by S in the U-interview, it became clear that S had learned much trigonometry during the interview. S began by operating in Mode 4. After some discussion of arc length and encouragement to use arc, S progressed into Mode 2. After solving several problems in Mode 2, S began operating in Mode 1. When asked to find \( \sin 4 \) (problem 1), S appropriately subtracted \( 4 - 3.14 = .86 \), looked up \( \sin .86 \) on the table and later remembered to consider the sign. During questioning it became apparent (and S agreed) that S was thinking of radian measure of angles and used \( \sin \theta = b/r \). After being pressed to point out an arc of length 4 on the sketch, S drew another arc which had radius less than one. After discussion S realized his error and could then point out the correct arc.

The next problem (2) was to find \( \sec \frac{3\pi}{2} \). S drew a coordinate system without a unit circle and used "\( x = \cos, \)"
but it appeared to be a remembered procedure similar to S's procedure on a similar problem during the C-interview. S appeared to be trying to use Mode 2 on problem 3, but used a circle of radius 5 without realizing that it was not a unit circle. Mode 2 was clearly in evidence on problems 4, 6, 7, and 8 and Mode 1 on problems 5, 10b, and 11. Problem 9 involved only taking a reciprocal and could have been done in any mode. The relative weakness of S's U-schema was evident in S's reversion to C-schema in problems 10a and 12. The use of C-schema in 10a is not surprising since problem 10a requires utilization of the uniform ratio connection in the difficult situation described earlier (x/y = -3/5 and x² + y² = 1). S's reverting to C-schema in problem 12 is more difficult to understand since S used Mode 1 very efficiently on problem 11. Although much variation of mode was evident it is clear that S was capable of operating in Mode 1, at least by the end of the interview. Therefore S could possess a complete U-schema, though the vacillation of mode indicates that S's C-schema was the stronger of the two. The remainder of the U-interview analysis determined S's U-schema.

All necessary aspects of the vertices Arc, Q, AV, S, and RArc were properly utilized by S during the U-interview, so they are considered to be present and strong in S's U-schema. In discussing the P and R vertices, it is necessary to examine S's definitions of sin s and cos s. S at times
used the definitions \( \sin s = b/r \) and \( \cos s = a/r \), which were in \( R \) and indicate weaknesses in both \( R \) and \( P \). However, \( S \) also at times used the more appropriate (for the \( U \)-interpretation) definitions \( \sin s = b \) and \( \cos a = a \) which were in \( P \). It appears that \( S \) actually possesses the latter ability and that the other definitions simply come to the fore on occasion because they are stronger. Therefore, both \( P \) and \( R \) are considered present and strong in \( S \)'s \( U \)-schema. In \( S \)'s efforts on problem 1, it became clear that confusion was present concerning the arc length concept. It is likely that this vertex (AL) was strengthened during the interview, but there is no evidence to support this view. Therefore, the AL vertex is considered present but weak in \( S \)'s \( U \)-schema.

Before beginning a discussion of the various paths and connections of \( S \)'s \( U \)-schema and their strengths, a few comments concerning conclusions from paths followed while \( S \) was operating in Modes 2 and 4 are necessary. Since it has been established that \( S \) did operate in Mode 1 and that all \( U \)-schema vertices except AL are strong, it is considered that some conclusions about paths and connections in \( S \)'s \( U \)-schema can be made from methods of solution utilized in Modes 2 and 4. This must be done carefully and must involve only paths and connections in which actions taken are the same in Mode 1 as in the mode actually utilized. For example, although problem 1 was solved in Mode 4, all
actions involved in paths 1b, 1c, and 1d are the same in either Mode 1 or Mode 4. Therefore connections utilized in those paths may be considered as being in S's U-schema. This would not be the case in path 1a, as the actions are different when performed in different modes. In some cases, although complete paths cannot be considered as being in S's U-schema, some individual connections may be. Careful analysis is necessary following the guidelines stated above to make such conclusions.

Non-Model paths followed by S fall in two categories: (a) Paths followed in Mode 3. These paths were considered to be inappropriate in U-schema and were not added to the Model. Such paths basically involve weaknesses in P and R in using \( \sin s = y/r = y/1 \), and \( \cos s = x/r = x/1 \) (in R) instead of \( \sin s = y \) and \( \cos s = x \) (in P). Since, as described earlier, this weakness was due to the strength of the C-schema definitions rather than a weakness of the U-schema definitions, P and R are considered strong, and inappropriate connections used in such paths will not be represented in S's U-schema. (b) The addition of a sketch to several Model paths. These connections are considered to be in S's U-schema. Also, sketch connections were added to a number of Model paths where they were deemed appropriate. (Refer to Part II of this chapter, The Refined Model, for these paths)

Little information can be drawn from the quadrantal angle problems since S used so much memorized information
that it is impossible to be accurate in analysis. Perhaps more skillful interviewing would have gleaned more information.

S demonstrated an inability to use either the construct connection or the calculator connection in any U-schema situation. The measure connection was not used due to S's inability to use the construct connection. The form ratio of signs and uniform ratio of signs connections were not utilized by S due to the use of alternate paths. Therefore these connections are considered to be absent from S's U-schema.

The form ratio (P→R, AV→AV), table (AV→RArc, RArc→AV), affix sign (\(\frac{AV}{S} \rightarrow P, \frac{AV}{S} \rightarrow R\)), and AG (Arc→AL, Arc→RArc) connections were all properly used and are considered to be present in these situations in S's U-schema.

S exhibited a weakness in the uniform ratio connection with an inability to properly uniform the ratio \(\cot s = -3/5\) on the unit circle. This is a difficult procedure since it involves solving a simultaneous system of equations \((x/y = -3/5\) and \(x^2 + y^2 = 1\)). However, S did properly uniform the ratio sec \(s = 3/2 = 1/\cos s\) to get \(\cos s = 2/3\). Therefore the uniform ratio connection is considered to be present in S's U-schema in the R→P situation.

The sketch connection was properly used in all Model situations (AL→Arc, P→Arc, RArc→Arc) and in two additional situations (P→P, Q→P). It is considered to be present in
S's U-schema in all five situations and was added to the Model U-schema in the last two.

S properly utilized the observe connection in four situations (Arc-Q, R-S, P-S, R-AV), and it is considered present in S's U-schema in these situations. Since S demonstrated an ability to observe the absolute value of a trigonometric function in the R-AV situation, it is clear that the same ability is present in the P-AV situation. Therefore, the observe connection is considered present in this situation also. S did not demonstrate this connection in the Arc-P situation since it could be used only in the quadrantal angle path which was described earlier. Therefore, the observe connection is considered to be absent from S's U-schema in this situation.

The QSXY connection was used properly in the Q-S situation but was not used in the S-Q situation due to the use of alternate paths. It is considered to be present in the Q-S situation but absent in the S-Q situation.

S properly used the QSTF connection in the Q-S situation but sometimes found only one answer in the S-Q situation. This connection is considered to be present in both situations.

Similarly the \( x^2 + y^2 = 1 \) connection was properly utilized in the P-AV situation, but S sometimes found only one answer in the P-P situation. It is considered to be present in S's U-schema in both situations.
The take reciprocal connection was properly utilized in all three situations (R→R, P→R, R→P) and is considered to be present. It is considered present in S's U-schema in the R→R situation, but is subsumed in the form ratio and uniform ratio connections in the P→R and R→P situations.

S2's problem solving U-schema is identical to the preliminary Model problem solving U-schema except that the construct (AL→Arc, Arc→P), measure (Arc→AL, Arc→P), observe (Arc→P), and calculator (AL→P, P→AL, AL→R, R→AL) connections are missing. S2's parent U-schema is identical to the preliminary Model parent U-schema except that the vertex AL is an open circle (since it is weak), the lines joining AL to Arc and Arc to P are dashed (since they represent weak links), and the lines joining AL to P and AL to R are missing.

Subject 2: T-Interview Analysis

S accurately followed all paths through T-schema. However, it seems that S considered the "0.8" in \cos .8 to be the radian measure of an angle rather than an arc length, since the term "radian" was mentioned by S. However, since S clearly understands (paths 3 and 4) the relationship between arc length and radian measure of angles, it appears that S considers the two to be synonymous. Thus, S could have considered "0.8" to be a state of knowledge of either AM or AL. It is concluded that the connection \( \pi/180 = s/\theta \)
is within S's C-schema (AM-AM, AM-AL). It is not indicated on S's C-schema because of the elapsed time between inter-
views.

Subject 3: Interview Analyses

Subject 3: R-Interview Analysis

It is obvious from analysis of the R-interview that S3 operated in Mode 1 and has a firm grasp of right triangle trigonometry. S correctly used the definition
\[ \sin \theta = \text{opp}/\text{hyp}, \]
and although S said once that
\[ \tan \theta = \sin \theta/\cos \theta, \]
S also used the opposite and adjacent sides on several occasions. No coordinate systems were drawn. S indicated an inability to use the calculator for trigonometry and thus could not use any calculator paths. Every appropriate state of knowledge of every vertex was utilized properly and every vertex is considered to be strong. With the exception of the calculator connection, S properly used every connection in every appropriate sit-
uation. The calculator connection is absent from S's R-schema at the problem solving level. All other connec-
tions are considered to be present in each appropriate sit-
uation in S's problem solving R-schema. S's problem solving R-schema is identical to the preliminary Model problem solving R-schema (Figure 4) except that the calculator con-
nection is missing. S's parent R-schema is identical to the preliminary Model parent R-schema (Figure 3) except that
the link joining AM and R is weak due to the absence of the calculator connection. However, this is considered to be only a slight weakness in an otherwise strong schema.

Subject 3: C-Interview Analysis

Subject 3 evidenced an ability to operate in Mode 2 during the C-interview. Both positive and negative values of a and b were utilized by S, but S appeared to view them as sides of triangles rather than as coordinates of a point. Two evidences of this viewpoint were observed. (a) S repeatedly used a, b, r as sides of triangles on figures. (b) When asked to find cot θ if x = -2 and r = 5, S proceeded to work in the third quadrant but was unable to explain why it should be in the third quadrant, stating an inability to understand how "-2 marks the terminal side." It appears from this comment that S considers "-2" to be a length of side of a triangle rather than a coordinate of a point. Thus, the P vertex is considered to be weak, but present in S's C-schema.

Of the vertices, AM, AV, S, and Q were properly used in all situations and are considered to be strong. Also considered to be strong is the R vertex, but this requires some discussion. Throughout the interview S showed a preference for inappropriate definitions such as sec θ = 1/cos θ and tan θ = sin θ/cos θ, yet there were several instances in which the proper definitions were used. Had interview instruction 6 existed and been followed, S would likely have
used the proper definitions more frequently. The A vertex is considered to be weak since S did not know the meaning of the term "standard position." The RA vertex is considered weak since S used the y-axis to be one side of the reference angle in problem 1.

S followed several non-Model paths during C-interview. The first type involved the addition of sketches to paths 3c, 3d, 3f, and 4d. The next type involved a modification of path 4e (problem 13). Instead of using QTSF to find the sign of tan \( \theta \), S considered the signs of sin \( \theta \) and sec \( \theta \) (which were given), used the uniform ratio of signs connection to find the signs of x and y, affixed those signs and formed the ratio to find tan \( \theta \). The new path follows:

All of these paths were considered viable and were added to the Model. In some instances S utilized new paths which used the form ratio connection in an inappropriate situation (R→R). This was due to the use of inappropriate definitions (tan \( \theta = \sin \theta / \cos \theta \), etc.). These paths were not added to the Model but the form ratio connection (R→R) was included in S's problem solving C-schema.

The construct connection was used incorrectly by S in
the AM-A situation in that the 127° angle was constructed, but not in standard position on a rectangular coordinate system. This prevented S from reaching the remainder of path 1a in the attempt to solve problem 1. This connection was not used at all in the P-A situation, perhaps due to the weakness of P. The construct connection is considered to be present in the AM-A situation and absent in the P-A situation.

S did not use the choose point connection (A-P) in problem 1. This may have been due to the fact that the construct connection was improperly used, but the weakness in P suggests an inability to use the choose point connection effectively. This connection was used in the quadrantal angle problem (2) (path 1e), but only for the unit circle choice (-1,0). This connection is considered to be present (A-P).

The measure connection was not used at all due to previously discussed problems with construction and is considered absent from S's C-schema.

S did not use the form ratio connection in problem 1 due to the construction difficulties, but did utilize it correctly and consistently in later P-R and AV-AV situations. It was also used on a couple of occasions in a non-Model way (R-R) due to use of inappropriate definitions (sec \( \theta = 1/\cos \theta \), etc.) which made the forming of an additional ratio necessary. This connection is considered to
be present in all three situations. It was not added to the Model in the R→R situation.

The uniform ratio connection was not utilized in problem 3 due to the construction difficulties, nor was it used in problem 4 (quadrantal angle) because memory was too much involved in S's solution. It was, however, utilized in all other appropriate instances in both the R→P and AV→AV situations. It is considered to be present in both situations.

The sketch connection was used properly in two non-Model situations (A→Q, Q→P) in the non-Model sketch paths discussed earlier, and was added to the Model C-schema in both situations. It was not utilized properly in the AM→A situation in that the angle was not placed in standard position on a coordinate system. Its use in the P→A situation was the only observable action in the quadrantal angle problem (number 4) due to excessive use of memory. This connection could be used in the \( ^{RA}_{Q} \rightarrow A \) situation only in paths 2b and 2c (problem 3) and was not used there since S did not progress that far in the solution of problem 3. The sketch connection is considered to be present in S's C-schema in the A→Q, Q→P, and P→A situations, and absent in the AM→A and \( ^{RA}_{Q} \rightarrow A \) situations.

Although the observe connection in the P→P situation was used only for the unit circle (and probably by memory), it was used there and in two other appropriate Model situations (R→AV, R→S). It was also utilized in two non-Model
paths in the A-Q and P-Q situations. However, in attempting to find \( \cos 127^\circ \) (problem 1) S failed to observe the quadrant (use the observe connection in the A-Q situation) and therefore did not follow the bottom part of either path 1b or 1c. A similar problem may have occurred in the R-S situation in S's attempt to solve problem 3 (paths 2b and 2c). Thus the observe connection is considered to be present in S's C-schema in all five situations. It was added to the Model C-schema in the Q-P situation.

S properly utilized the R-schema (table) connection in the RA-AV situation in problem 1, but did not use it in the AV-RA situation. The failure to use it in this situation was one of the reasons that S could not solve problem 1. Therefore the R-schema connection is considered to be present in the RA-AV situation and absent in the AV-RA situation.

Use of the QSTF connection in the Q-S situation was avoided in problem 1 due to previously failing to observe the quadrant, but was properly utilized in that situation in a later problem. This connection was properly used in the S-Q situation in both the attempt to solve problem 3 and the non-Model path used in the solution of problem 13. It is considered to be present in both situations.

The QSXY connection was used in exactly the same instances as the QSTF connection and is also considered to be present in the Q-S and S-Q situations.
S avoided using the affix sign connection in the \( \text{AV}_{S} \rightarrow R \) situation in problem 1 due to previously failing to observe the quadrant, but used it both in that situation and in the \( \text{AV}_{S} \rightarrow P \) situation repeatedly and correctly in later problems. This connection is considered to be present in both situations.

There was only one likely opportunity to use the form ratio of signs connection \( (S \rightarrow S) \) and that was in problem 1. It was not used there due to the previous failure to observe the quadrant and therefore must be considered absent from S's C-schema.

S similarly avoided use of the uniform ratio of signs connection \( (S \rightarrow S) \) in the attempt to solve problem 3, but did utilize it properly in that situation in the non-Model path followed in solving problem 13. It is considered to be present in S's C-schema.

The calculator was not used to do trigonometry at any time in the interview and is considered to be absent from S's C-schema.

S did not use the AG connection in the A-AM situation in problem 3 due to S's inability to utilize the beginning of either path 2b or 2c, but did use it in that situation in problem 4. It was utilized incorrectly in the A-RA situation due to the weakness of RA. The AG connection is considered to be present in both situations.

The \( x^2 + y^2 = r^2 \) connection was properly utilized in
all instances of all appropriate situations (P→P, P→AV, AV→AV) and is considered present in all three situations.

Similarly, the take reciprocal connection was properly utilized in the one appropriate situation (R→R) and is considered to be present in that situation.

Subject 3's problem solving C-schema is the preliminary Model problem solving C-schema with some deletions and additions. The measure (A→AM), construct (P→A), sketch (AM→A, RA→Q, A), and calculator (AM→R, R→AM) connections must be deleted. A new line joining P and Q must be added to represent the connections sketch (Q→P) and observe (P→Q). The parent C-schema for S3 is the preliminary Model parent C-schema with circles for the vertices A, P, and RA (indicating their weakness), with dashed lines joining AM to A, A to P, A to Q, and S to R (indicating that they are weak links), with the link joining AM to R missing, and the new link joining P and Q added.

Subject 3: U-Interview Analysis

Throughout the U-interview S operated in a slightly modified Mode 4. Early in the interview S evidenced an inability to comprehend or use arc length. When asked to find sin 4, S said, "I don't know how to do that." Extensive questioning and suggestions by I were unfruitful. S did try to use the table but failed since 4 was not on the table. S could not even use the table to find sin 100°. Similarly, S could not even attempt to solve problem 3. S was capable
of solving most of the rest of the problems, but seemed to use angles exclusively. This is evidenced by the presence of angles in every figure drawn and even the absence of a unit circle in some. After some encouragement S would use unit circles, but this just forced S into using $r = 1$. In one such instance, S had used $r = 3$ and then divided each side of the triangle by three to get $r = 1$. This was done instead of observing that \( \cos s = 1/3 \) means that $x = 1/3$.

There was some vacillation in the definitions used by S in the interview. In some instances S would use 
\[
\tan s = \sin s / \cos s, \quad \text{or} \quad \sec s = 1 / \cos s;
\]
in others, 
\[
\tan s = y / x \quad \text{or} \quad \sec s = r / x.
\]  
In no situation, however, did S use $\sin s = y$ or $\cos s = x$; instead, S always used $\sin s = y / r = y / 1$ and $\cos s = x / r = x / 1$. Thus S operated in Mode 4 with the modification that occasionally the definitions $\tan s = \sin s / \cos s$ or $\sec s = 1 / \cos s$ were used. Since S operated in Mode 4, S is considered to possess no U-schema. In fact, S operated in the U-interview in a fashion identical to the method of operation in S's C-interview which has already been analyzed.

**Subject 3: T-Interview Analysis**

S succeeded in solving problems 1 and 3 with much leading questioning by I, and then the solutions to problems 2 and 4 followed with little difficulty. Although S evidenced no understanding of the arc length concept or the arc concept during U-interview, some evidence of a weak
understanding was present during T-interview. When asked to find \( \cos .8 \), S first found \( \theta \) such that \( \cos \theta = .8 \). This error was corrected by I and S finally realized that ".8 is an arc length in radians" and that the table has only degree measure. Then S said, "I don't know, what to do" and then, "It's that conversion stuff." S tried to use the conversion formula but required much guidance. In particular, S didn't understand whether to use \( \pi = 3.14 \) or \( \pi = 180^\circ \), evidencing again a confusion of arc length with radian measure of angles. With more guidance in the use of the formula, S finally succeeded in following path 1. After the learning involved in problem 1, S solved problem 2 efficiently, following path 2. From this, it appears the S has formed a weak conception of the AL vertex and that the \( \pi/180 = s/\theta \) connection was followed in both situations (AL→AM, AM→L).

Although S immediately followed both path 3 and path 4, it appears that the Arc vertex must be considered to be weak since S originally believed that an arc of radius 2 had the same length as a corresponding arc of radius 1. The construct connection must be considered to be present in the A-Arc and Arc-A situations, but since RAarc was demonstrated during U-interview to be absent, and no evidence to the contrary has been developed, the construct connection cannot be considered to be present in the RA-RArc and RAarc-RA situations.
Subject 4: Interview Analyses

Subject 4: R-Interview Analysis

For the first two-thirds of the R-interview, S used a, b, and r rather than opp, adj, and hyp and even indicated an inability to remember the definitions appropriate to right triangles. Then, suddenly, in problem 5, S stated and used \( \cos \theta = \frac{\text{adj}}{\text{hyp}} \) and in problem 6 used \( \tan \theta = \frac{\text{opp}}{\text{adj}} \). In addition, S did not draw a single coordinate system and did draw angles with orientations other than in standard position. Thus it appears that S was not thinking in terms of coordinate systems. From this evidence, it is concluded S can operate in Mode 1 and that all vertices and connections could be present and strong.

The vertices AM and L were properly used in all instances during the R-interview. As discussed previously, S indicated weaknesses in the RT and R vertices early in the interview, but evidenced greater strength by the end of the interview. In fact, the states of knowledge of RT and R which seemed to be absent were actually found to be present. Thus all vertices are considered to be strong and present in S's R-schema.

One non-Model path was utilized by S in the solution of problem 3. S used construction to find \( \theta \) and the table to find \( \cos \theta \). No non-Model connections were used on this path. It is not considered significant to the Model and will not be added.
The sketch, Theorem of Pythagoras, uniform ratio, take reciprocal, solve, and observe connections were utilized effectively in all appropriate situations and are considered to be present in all Model situations.

S evidenced a slight difficulty in the use of the table connection in the AM-R situation in the first instance of its use, but then utilized it effectively in the next two instances. In addition, this connection was used correctly in the R-AM and R-R situations in all appropriate instances. The table connection is considered to be present in all three situations.

The calculator connection was used properly in the AM-R situation but could not be utilized in the R-AM situation. It is considered to be present in the AM-R situation, and absent in the R-AM situation.

S evidenced some weakness in the construct connection in the AM-RT situation due to inexperience in using the protractor. This connection was properly utilized in all instances in the L-RT situation, but S could not use it in the AM_L→RT situation. The construct connection is considered to be present in the AM-RT and L-RT situations and absent in the AM_L→RT situation.

S's inexperience in using the protractor was evident in the first instance of the use of the measure connection in the RT-AM situation, but it was properly utilized in three later instances in that situation. This connection was
properly used in the RT→L situation in one instance although its use in two other instances was avoided, once by use of the non-Model path and again by S's failure to construct in the AM→RT situation. The measure connection is considered to be present in S's R-schema in both situations. The form ratio connection is available only in the L→R situation. Its use was avoided once by use of the non-Model path, but it was used appropriately in all other instances. It is considered to be present in the L→R situation.

S4's problem solving R-schema is the preliminary Model problem solving R-schema with the sketch (AM→RT), calculator (R→AM), and construct (AM→RT) connections missing. S4's parent R-schema is the preliminary Model parent R-schema with a dashed line joining AM to RT indicating that it is a weak link.

Subject 4: C-Interview Analysis

S seemed to operate in Mode 2 throughout C-interview. S did use a, b, and r with both positive and negative values of a and b. However, with only one exception (other than quadrantal angles), S used a, b, and r as sides of triangles. The one exception was in problem 5 in which the statement of the problem referred specifically to a point on the terminal side of the angle. Further evidence for this came in S's attempt to find \( \cos 127^\circ \) by construction. S constructed a 127° angle and then indicated an inability to proceed since "There isn't a right triangle." Even so,
S's need to use triangles was not so great as to cause difficulty with quadrant angles. S performed appropriately on problems 2 and 4, using the coordinates of a point on the proper axis. Thus, S operated in Mode 2 and showed some weakness in the P vertex.

The AM, R, Q, AV, S, and RA vertices were properly used in all instances and are considered present and strong in S's C-schema. Although S did not know the meanings of the terms "initial side," "terminal side," and "standard position," S did appropriately use those ideas in most instances. S did require much instruction in problem 5 to sketch a third quadrant angle in standard position due to not knowing the meaning of "standard position." Thus the A vertex must be considered to be present, but weak.

S used one incorrect non-Model path and several correct non-Model paths which require sketches. The sketch paths were incorporated into the Model. The incorrect path was used in the solution of problem 5.(Model paths 3c and 3d) which requires two answers. S found only one solution due to a sketch which included only one quadrant:

\[ Q \xrightarrow{\text{Sketch}} P \xrightarrow{x^2+y^2=r^2} P \xrightarrow{\text{F rat}} R \]

S attempted to solve problem 1 by construction but did not succeed due to failure to construct the angle in standard position on a coordinate system, which was an incorrect usage of the construct connection in the AM-A situation.
In S's attempt to utilize the construct connection in the P-A situation, a and b were used as sides of a triangle instead of coordinates of a point, causing so much confusion that the construction could not even be completed. Thus this connection is considered to be present in the AM-A situation and absent in the P-A situation. More evidence for the conclusion that P is weak can be seen here also.

The choose point connection (A→P) was not used in problem 1 due to previously described weaknesses in both the P vertex and the construct connection (AM-A). It was used in the quadrantal angle problem 2. In finding tan 180°, S used (-1,0) but indicated that any point on the negative x axis could be used since, "We are going to get 0 no matter what x is used." This connection is considered to be present in S's C-schema in the A-P situation.

The form ratio connection was not used in problem 1 in the P-R situation due to the previously discussed construction difficulties, but was used correctly in that situation seven times during C-interview. Uses of the connection in the AV-AV situation could occur only following use of the QSTF connection, which, as will be seen, is absent from S's C-schema. Thus it was not used in the AV-AV situation. However, since the action of forming the ratio is the same in either situation and it was performed so effectively in the P-R situation, its absence in the AV-AV situation is not considered to be a weakness in the connection itself.
The form ratio connection is considered to be present in the P-R situation and absent in the AV-AV situation.

The uniform ratio connection was used correctly in all instances of the two appropriate situations (R-P, AV-AV) and is considered to be present in both situations.

Due the previously described difficulties with construction, the measure connection was not used at all during C-interview and must be considered to be absent from S's C-schema.

S properly and effectively used the sketch connection in all three Model situations (AM-A, P-A, Q-A). It was also used in problem 5 in the non-Model situation Q-P. This involved locating a point on the terminal side of angle in standard position, knowing the quadrant and the values of x and r. S required some assistance in doing this, but this was due to not knowing the meaning of "standard position," a weakness in the A vertex. In addition, S used the sketch connection in problem 7 in the non-Model situation P-P. Here it was necessary to locate two such points, one in the second quadrant and one in the third. Some difficulty occurred here which was likely due to the weakness in P in which x and r were considered to be sides of a triangle. The sketch connection is considered to be present in all five situations. It was added to the Model in the Q-P and P-P situations.

The observe connection was properly and effectively
used in all appropriate instances in the A→Q, R→AV, and R→S situations. Its use in the P→P situation in finding \( \cos 270° \) (problem 2) was avoided. S properly used the point (0,-1) on the negative y-axis, but instead of observing that \( r = 1 \), S used the \( x^2 + y^2 = r^2 \) connection to solve for \( r \). This does not appear to be a weakness in the observe connection; instead it appears to be a reflection of the relatively greater preference toward the use of the \( x^2 + y^2 = r^2 \) connection. The observe connection is considered to be present in the A→Q, R→AV, and R→S situations and absent in the P→P situation.

In each instance in which the R-schema connection could be used, S used the table properly. This connection is considered to be present in S's C-schema in the two appropriate situations (RA→AV, AV→RA).

The QSTF connection was not only not used during C-interview, but S stated that the only way S could decide that \( \cos \theta < 0 \) for \( \theta \) in the second quadrant was to note that \( x < 0 \) and \( r > 0 \) in the second quadrant and \( \cos \theta = x/r \). The QSTF connection is considered to be absent from S's C-schema.

S avoided the QSXY connection in the Q→S situation in problem 5 by using the non-Model path previously discussed, but did use it effectively in that situation and in the S→Q situation on other occasions. It is considered to be present in both situations.

Similarly, the affix sign connection in the S→P
situation was avoided in problem 5 by the non-Model path. It was not used in problem 12 (path 4c) due to the absence of the QSTF connection. This problem was effectively solved using path 4d. However, the connection was used in both situations ($AV_S \rightarrow P, AV_S \rightarrow R$) on other occasions and it is considered to be present in both situations.

Both the form ratio of signs and uniform ratio of signs connections were appropriately utilized. They are both considered to be present in the one appropriate situation ($S \rightarrow S$).

S properly used the calculator in the AM-R situation but could not use it in the R-AM situation. The calculator connection is considered to be present in the AM-R situation and absent in the R-AM situation.

The AG connection was correctly used in all instances and is considered to be present in the A-AM and A-RA situations.

The $x^2 + y^2 = r^2$ connection was correctly used in the two appropriate instances in the AV-AV situations. In the solution of problem 5, S ignored the possibility of a negative value of $y$ in the solution of $x^2 + y^2 = r^2$, and as a result solved the problem incorrectly. This was a weakness in the use of the $x^2 + y^2 = r^2$ connection in which S found $|b|$ which should have been in the AV vertex, but instead S considered it to be $b$ and in the P vertex. In the solution of problem 7, the previously discussed incorrect sketch led
S to use y to be positive, when in actuality both positive and negative values should have been used. This occurred in using this connection in the P-P situation, but it appears to be a result of an earlier error and not a weakness in the $x^2 + y^2 = r^2$ connection. In another instance in the P-P situation, this connection was properly used to find the value of r. It was also used correctly on another occasion in the P-AV situation. The $x^2 + y^2 = r^2$ connection is present in the situations P-P, P-AV, AV-AV.

S properly used the take reciprocal connection in the R-R situation and it is considered to be present in that situation.

S4's problem solving C-schema is the preliminary Model problem solving C-schema with the measure (A-AM), construct (P-A), form ratio (AV-AV), calculator (R-AM), and QSTF (Q-S, S-Q) connections missing. S4's parent C-schema is the preliminary Model parent C-schema with circles at the A and P vertices (indicating that they are weak), dashed lines joining AM to A, A to P, Q to S, and AM to R (indicating weak links), and a solid line joining P to Q added.

Subject 4: U-Interview Analysis

Throughout the U-interview S used the labels sin s = y, cos s = x, tan s = sin s/cos s, etc., but had some early difficulty with the arc and arc length concepts. By problem 3, however, S was using and discussing the concepts efficiently. This continued throughout the interview. Thus
S operated in Mode 1, at least after some learning had taken place, and all vertices and connections could be strong.

As indicated earlier, S showed some early difficulty with the AL and Arc concepts, yet as the interview progressed, S effectively utilized those vertices and they are considered to be strong. No difficulty of any kind was evidenced during the interview with the AV, R, S, Q, and RArc vertices and they are considered to be strong. For the P vertex, the correct labels \( \sin s = y \) and \( \cos s = x \) were appropriately used. In problem 1, S did not notice that the \( y \) coordinate of the point involved was negative. In problem 3, knowing that \( x = -3 \), S ignored the possibility that \( y \) could be positive. In problem 6, S had great difficulty locating the end point of an arc. For these reasons, the P vertex must be considered to be weak.

Three non-Model paths were utilized by S during U-interview. Two of these involved the addition of sketches to paths 3b and 3e. Sketches will be added to Model paths where appropriate. The third non-Model path used by S was a simplification of path 4e in the solution of problem 12. Instead of using QSTF twice, S simply observed the sign of \( x \) as given and affixed it to the absolute value of \( x \) which had already been found and formed the required ratio:

\[
P \xrightarrow{x^2+y^2=r^2} AV \xrightarrow{A \text{ sign}} S \xrightarrow{F \text{ rat}} R
\]

S required much guidance in using the construct
connection in the AL-Arc situation but used it effectively in the later P-Arc situation. The improvement may have been due to the previously discussed learning, but no evidence exists of improvement in the AL-Arc situation. The construct connection is considered to be present in both situations.

A similar situation exists for the measure connection. It was used with much guidance in the Arc-P situation but effectively in the later Arc-AL situation. It is considered to be present in both situations.

The form ratio connection was effectively used in seven instances in the P-R situation, but not used in the AV-AV situation due the use of an alternate path. It is considered to be present in the P-R situation and absent in the AV-AV situation.

S could not utilize the uniform ratio connection in the R-P situation when the tangent function was involved. This is not surprising since it required the solving of the system of equations \( \frac{x}{y} = -\frac{3}{5} \) and \( x^2 + y^2 = 1 \). S did utilize this connection properly in the R-P situation when the secant function was involved. The uniform ratio connection is considered to be present in the R-P situation.

The sketch connection was properly utilized in all three Model situations (AL-Arc, P-Arc, \( R_{\text{Arc}} \rightarrow \text{Arc} \)). S had some difficulty in problem 1 in the AL-Arc situation, apparently due to the previously described early weaknesses
in the AL and Arc vertices, but S later used this connection effectively. S also used the sketch connection in two non-Model situations (P→P, Q→P). Some difficulty was observed in both situations, but this seemed to be a result of the previously described weakness in the P vertex. Therefore, the sketch connection is considered to be present in all five situations. It will be added to the Model in the last two situations.

S properly used the observe connection in four situations (Arc→Q, Arc→P, R→AV, R→S). The two Model situations in which it was not used were P→AV and P→S. In these situations and in the Model situations R→AV and R→S, the observe connection involves observing the sign or absolute value of a known trig s. If the known trig s is sin s or cos s, the connection is in the P→AV or P→S situation; if the known trig s is any other trig s, the connection is in the R→AV or R→S situation. Since the actions involved are the same, it is assumed that the observe connection is present in the P→AV and P→S situations also. Thus this connection is considered to be present in all six situations.

The table connection is considered to be present in the two appropriate situations (RArc→AV, AV→RArc) since it was appropriately used in both situations.

The QSTF and QSXY connections must be discussed together. In all instances of the Q→S situation, S used the QSXY connection, while the QSTF connection was preferred and
used in all instances in S→Q situations. No explanation of S's preference can be offered. The QSTF connection is considered to be present in the S→Q situation and absent in the Q→S situation. The QSXY connection is considered to be present in the Q→S situation and absent in the S→Q situation. Careful attention to interview instructions 6 and 7 may avoid this occurrence.

S's use of the QSTF and QSXY connections in the way previously described caused S to avoid use of both the form ratio of signs and uniform ratio of signs connections and both are considered to be absent from S's U-schema.

The affix sign connection was properly used in all instances in both appropriate situations \((\frac{A_k}{S} \rightarrow R, \frac{A_v}{S} \rightarrow P)\) and is considered to be present in both situations.

S properly used the calculator connection in the AL→P situation, and it is assumed that S could have used it in the AL→R situation, for reasons similar to those described in the discussion of the QSTF and QSXY connections. S was unable to utilize the calculator connection in either the P→AL or R→AL situations. This connection is considered to be present in the AL→P and AL→R situations and absent in the P→AL and R→AL situations.

The AG (Arc→AL, Arc→RArc), \(x^2 + y^2 = 1\) (P→P, P→AV), and take reciprocal (R→R) connections were properly used in all appropriate situations and are considered to be present in those situations.
S4's problem solving U-schema is the preliminary Model problem solving U-schema with an added line joining Q to P for the non-Model sketch (Q→P) connection and with the following connections missing: form ratio of signs (S→S), uniform ratio of signs (S→S), observe (P→AV), QSXY (S→Q), QSTF (Q→S), form ratio (AV→AV), calculator (R→AL). S4's parent U-schema is the preliminary Model parent U-schema with a circle for the P vertex, dashed lines joining Q to S and AL to R, and a new solid line joining Q and P.

PART II: THE REFINED MODEL

After analysis of all interviews with the first four subjects, only slight refinements in the Model were found to be needed. No changes in the R-schema portion were necessary, and the modifications in the other parts were mostly limited to adding sketches where needed.

Model C-Schema

In the problem solving paths in C-schema, sketches were added to paths 3a, 3b, 3c, 3d, 3e, 3f, 4b, 4c, 4d, and 4e. Most of these paths were used with sketches by one or more subjects. In other situations it was considered that sketches were also appropriate. These added sketches required including the sketch connection in the Model in three new situations (Q→P, P→P, Q→A) and the observe connection in one new situation (P→Q). These changes led to additions to both the Model C-schema at the problem solving level and to
the Model C-schema. Two non-Model paths which were followed
during the interviews were considered to be significant and
were added to the Model, one (4d') as a variation of path 4d
and the other (4e') as a variation of path 4e. The modified
paths are listed in Table 5. These new paths led to no addi-
tional changes in the Model C-schemas.

So much similarity exists between the Model and the pre-
liminary Model C-schemas that no figures for the Model
C-schemas are given. The Model parent C-schema is identical
to the preliminary Model parent C-schema (Figure 5) except
that a new link joining Q and P is added. The concepts at
the vertices of the Model C-schema are identical to the con-
cepts at the vertices of the preliminary Model C-schema.
The Model problem solving C-schema is the preliminary Model
problem solving C-schema with sketch connections in the Q-P,
P-P, and Q-A situations having been added. The states of
knowledge of the concepts of the Model C-schema are identi-
cal to those for the preliminary Model. The necessary ad-
ditions to the list of connections in the preliminary Model
C-schema are given later in this section. The problem solv-
ing paths which replace corresponding problem solving paths
from the preliminary Model are given in Table 5. The prob-
lems with associated paths are the same as those in the pre-
liminary Model except that paths 4d' and 4e' are included
along with paths 4d and 4e.
Table 5

Problem Solving Paths Through the Model C-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3a</td>
<td>P → Sketch → P → F rat → R</td>
<td>8</td>
</tr>
<tr>
<td>3b</td>
<td>P → Sketch → P → TP → P → F rat → R</td>
<td>9</td>
</tr>
<tr>
<td>3c</td>
<td>P → TP → AV + A sign → P → F rat → R</td>
<td>5</td>
</tr>
<tr>
<td>3d</td>
<td>P → TP → AV + F rat → AV + A sign → R</td>
<td>5</td>
</tr>
<tr>
<td>3e</td>
<td>P → TP → AV + A sign → P → F rat → R</td>
<td>6</td>
</tr>
</tbody>
</table>
Table 5 (continued).

Problem Solving Paths Through the Model C-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3f</td>
<td>P → Sketch → P → TP → P → F rat → R</td>
<td>7</td>
</tr>
<tr>
<td>4b</td>
<td>R → U rat → P → Sketch → P → TP → P → F rat → R</td>
<td>11</td>
</tr>
<tr>
<td>4c</td>
<td>R → Obs → AV → U rat → AV → TP → AV → F rat → AV → A sign → R</td>
<td>12</td>
</tr>
<tr>
<td>4d</td>
<td>R → Obs → AV → U rat → AV → TP → AV → A sign → P → F rat → R</td>
<td>12</td>
</tr>
<tr>
<td>4d'</td>
<td>R → Obs → AV → U rat → AV → A sign → P → TP → P → F rat → R</td>
<td>12</td>
</tr>
</tbody>
</table>

Note: Each path indicates a sequence of actions or states through the model.
Table 5 (continued).

Problem Solving Paths Through the Model C-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>4e</td>
<td><img src="#" alt="Diagram" /></td>
<td>13</td>
</tr>
<tr>
<td>4e'</td>
<td><img src="#" alt="Diagram" /></td>
<td>13</td>
</tr>
</tbody>
</table>
Connections in the Model Problem Solving C-Schema

   (Q→A)
   d. Knowing the quadrant in which the terminal side of $\theta$ is located, sketch $\theta$ in standard position.
   e. Knowing the quadrant in which a point on the terminal side of $\theta$ is located, sketch that point in that quadrant. (Q→P)
   f. Knowing two of $x$, $y$, $r$ for a point on the terminal side of $\theta$, sketch that point. If $r$ is one of the known values, this requires the sketching of two points in different quadrants. (P→P)

7. Observe (Obs.) A→Q, P→Q.

Model U-Schema

In the U-schema, sketches were added in paths 3a, 3b, 3c, 3d, 3e, 4b, 4c, 4d, and 4e. This necessitated including the sketch connection in three new situations (P→P, Q→P, Q→Arc) and making the appropriate changes in both the Model U-schema at the problem solving level and in the Model U-schema. Path 4e as followed by S4 is more efficient and has replaced the Model path 4e. In examining the problem solving paths, recall that since $\sin s$ and $\cos s$ are in $P$ with the other trigonometric functions in $R$, some variation in each path may be necessary.

The Model parent U-schema is the same as the preliminary
Model parent U-schema (Figure 7) with the addition of a new link joining P and Q. The concepts at the vertices of the Model U-schema are the same as the concepts at the vertices of the preliminary Model U-schema. The Model problem solving U-schema is the same as the preliminary Model problem solving U-schema with sketch connections added in the P→P, Q→P, and A→Arc situations. The states of knowledge of the concepts of the Model U-schema are identical with those of the preliminary Model. The additions to the problem solving connections in U-schema are listed later in this section.

The problem solving paths of the Model U-schema which replace corresponding paths in the preliminary Model are given in Table 6. The problems with associated paths are the same as those in the preliminary model.

**Problem Solving Connections in U-Schema**


   d. Knowing x, y and/or r, sketch the point P as the end point of an arc in standard position. (P→P)

   e. Knowing the quadrant in which P is located, sketch P as the end point of an arc in standard position. (Q→P)

   f. Knowing the quadrant in which the end point of an arc is located, sketch the arc. (Q→Arc)
Table 6

Problem Solving Paths Through Model Problem Solving U-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3a</td>
<td>P → Sketch → P → F rat → R</td>
<td>5</td>
</tr>
<tr>
<td>3b</td>
<td>P → Sketch → P → TP → P → F rat → R</td>
<td>6</td>
</tr>
<tr>
<td>3c</td>
<td>P → TP → AV → A sign → P → F rat → R</td>
<td>7</td>
</tr>
<tr>
<td>3d</td>
<td>P → TP → AV → F rat → AV → A sign → R</td>
<td>7</td>
</tr>
<tr>
<td>3e</td>
<td>P → TP → AV → A sign → P → F rat → R</td>
<td>8</td>
</tr>
<tr>
<td>4b</td>
<td>R → U rat → P → Sketch → P → TP → P → F rat → R</td>
<td>10a,b</td>
</tr>
</tbody>
</table>
Table 6 (continued).

Problem Solving Paths Through Model Problem Solving U-Schema

<table>
<thead>
<tr>
<th>Number</th>
<th>Path</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>4c</td>
<td><img src="4c_diagram" alt="Diagram" /></td>
<td>11</td>
</tr>
<tr>
<td>4d</td>
<td><img src="4d_diagram" alt="Diagram" /></td>
<td>11</td>
</tr>
<tr>
<td>4e</td>
<td><img src="4e_diagram" alt="Diagram" /></td>
<td>12</td>
</tr>
</tbody>
</table>
PART III: INTERVIEW ANALYSES OF S5 AND S6

Following the Model refinement just described, an A student and a D student were selected from another trigonometry class at Virginia Polytechnic Institute and State University. The selection was made by the teacher of the class. These subjects were then interviewed from the refined Model and their interviews analyzed. It should be noted that S5 was the A student and S6 was the D student, and that this information was not given to the interviewer (who also analyzed the interviews) until after the interviews. As a check on replicability, the interviews with S5 were also analyzed by a second knowledgeable evaluator. All three analyses are included in this part.

Subject 5: Interview Analyses

Subject 5: R-Interview Analysis

Subject 5 clearly operated in Mode 1 during the R-interview. S used the right triangle definitions and did not draw coordinate systems. All vertices were properly utilized and are considered to be strong. All Model connections were correctly utilized in all Model situations, thus all Model connections are considered to be present in all Model situations. S did utilize one connection which is not included in the Model. On problem 5, S elected to use the sine function instead of the cosine function, which led to the wrong acute angle. S then found the complement of that angle and
completed the problem successfully. Thus, a previously unmentioned connection, the "complement" connection, is considered to be present (in the AM-AM situation) in S's problem solving R-schema. It should be noted that other subjects may also possess this connection but did not exhibit it during the interview. Since all Model vertices and connections are present, it is clear that all Model links are present and strong. Because of the similarity of S5's R-schemas with the Model R-schemas, no figures or tables will be exhibited.

Subject 5: C-Interview Analysis

Subject 5 operated in Modes 2 and 3 during the C-interview. In every drawing S used a and b as labels for sides of triangles, and sometimes had difficulty remembering that they could be negative. In addition, S never used the term "coordinate," instead referring to a as the "x-axis" and b as the "y-axis." S did show the ability to properly handle axes angles without using triangles, but the evidence cited earlier is so strong as to preclude any possibility that S might be operating in Mode 1.

Since S operated in Modes 2 and 3, the P vertex is considered to be weak and, in fact, this weakness showed itself frequently during the interviews in two major ways: (a) As indicated earlier, S thought in terms of triangles instead of points. (b) S exhibited great difficulty in realizing
and using the fact that $a$ could be negative, especially in considering problem 2.

Other vertices considered to be weak are $R$ and $RA$. The major weakness noted in $R$ was that $S$ did not understand that $0/1 = 0$. The difficulty with the $RA$ vertex showed itself on problem 3, where $S$ used the table to find $\arccos(1.6) = 58^\circ$ but did not know where to locate the $58^\circ$ angle on the figure. In addition, upon questioning by $I$ at a later time, $S$ did not know either of the terms "reference angle" or "related angle." Thus the $RA$ vertex is considered to be very weak.

$S$ exhibited slight weaknesses in the $AM$ and $A$ vertices in problem 1 when $S$ actually found and constructed the reference angle for $127^\circ$ instead of the $127^\circ$ angle itself, but used both vertices properly throughout the remainder of the interview, and they are considered to be strong. These weaknesses formed part of a non-Model path used by $S$ which is described below. The remaining vertices, $AV$, $S$, and $Q$ were properly utilized and are considered to be strong.

Three non-Model paths were used by $S$. The first one was used in solving problem 1 by construction. When asked to find $\cos 127^\circ$ without using either the table or calculator, $S$ modified path 1a in two ways. (a) First, as indicated earlier, $S$ found the reference angle to be $53^\circ$, constructed it in the proper location, and chose a point on the proper side of the reference angle. This is the slight
weakness in AM and A referred to above. (b) Second, instead of just observing a negative $a$, S used $|a|$, formed the proper ratio $|a|/r$, and determined the sign from the quadrant. This occurrence is apparently due to the weakness in $P$. The path followed is represented here in two parts.

$$\text{AM} \rightarrow \text{AG} \rightarrow \text{AM} \rightarrow \text{Const} \rightarrow \text{RA} \rightarrow \text{Ch pt} \rightarrow P$$

$$\text{Meas} \rightarrow \text{AV} \rightarrow \text{F rat} \rightarrow \text{AV} \rightarrow \text{A sign} \rightarrow R$$

The second non-Model path used was a modified path 3e used in solving problem 6. (Given: $b = 3$, $r = 7$, and $a < 0$) S used the Theorem of Pythagoras to find $|a|$, but instead of just observing that $a < 0$, S found $|\sec \theta| = |a|/r$ and used the quadrant (QSTF) to determine that $\sec \theta$ was negative. This path is represented here:

$$\text{S} \rightarrow \text{QSXY} \rightarrow Q \rightarrow \text{Sketch} \rightarrow P \rightarrow \text{TP} \rightarrow \text{AV} \rightarrow \text{F rat} \rightarrow \text{AV} \rightarrow \text{A sign} \rightarrow R$$

The third non-Model path used was an incorrect one used in the solution of problem 2a (Find $\tan 180^\circ$.) In this problem S chose the point $(-1,0)$ on the terminal side of $180^\circ$ but thought its coordinates were 1 and 0, due to the weakness in $P$. S then formed the ratio $0/1$ and, with much
help, found that \( \tan 180^\circ = 0 \). A representation of this path follows:

\[
\text{AM} \xrightarrow{\text{Sketch}} A \xrightarrow{\text{Ch pt}} P \xrightarrow{\text{Obs}} A \xrightarrow{\text{F rat}} R
\]

S showed several weaknesses in using the construct connection. It was not used in the AM-A situation at all. Instead, S used construction in the non-Model AM-RA situation as described in the first non-Model path described above. Even there, S exhibited difficulty in using the protractor. This connection was used in the P-A situation, but then S ignored the negative sign on one of the components of P. This is probably due to the weakness of the P vertex. The construct connection must be considered to be present in the AM-RA and P-A situations and absent in the AM-A situation.

The choose point connection was properly utilized in the A-P situation and in the non-Model RA-P situation (see the first non-Model path), and is considered to be present in both situations.

The weakness of the P vertex appeared to cause problems in the use of the measure connection. S's difficulties with considering negative components led to S's replacing the measure connection in the P-P situation by the measure connection in the P-AV situation (see the first non-Model path). After some questioning by I, S did use this connection in the P-P situation. In the A-AM situation, difficulties using the protractor were again evident. The measure connection is thus considered to be present in all three situations.
S properly used the form ratio connection in all occurrences in the AV-AV situation and in five occurrences in the P-R situation. In one occurrence in the P-R situation, S had difficulty knowing that \( 0/(-1) = 0 \), but this is considered to be due to the previously discussed weakness in the R vertex rather than a weakness in the form ratio connection. The weakness in the P vertex caused the form ratio connection to be used in the non-Model situation AV-R in the solution of problem 2a. (See the third non-Model path.) The form ratio connection is considered to be present in S's C-schema in the P-R, AV-AV, and AV-R situations.

The uniform ratio connection was properly utilized in all occurrences in the AV-AV situation, and in all but one occurrence in the R-P situation. In attempting to uniform the ratio -(16/10) in problem 3, S needed a prompting by I to find the necessary two answers. On a later occasion (problem 11), S did this properly, so it seems clear that, at least by the end of the interview, S could handle this situation correctly. Also, the weakness here is likely due to the weakness in P. Thus, the uniform ratio connection is considered to be present in both situations.

Proper utilization of the sketch connection was observed in all occurrences of the AM-A, P-A, Q-P, and Q-A situations. S had some difficulty in the \( \frac{RA}{Q} \rightarrow A \) and P-P situations, but this appeared to be due to the previously discussed weaknesses in the RA and P vertices rather than to
the sketch connection. The sketch connection is considered to be present in all six situations.

S properly used the observe connection in all occurrences in the A→Q, P→P, R→AV, R→S, A→Q, and P→Q situations. It was also used in the non-Model situation P→AV, which came about due to weaknesses in the P vertex. (See the first non-Model path.) The observe connection is considered to be present in all seven situations.

The R-schema (table) connection was properly used in the RA→AV situation, and although S required much prompting before thinking to use it in the AV→RA situation, it must be considered to be present in both situations.

S properly utilized the QSTF connection in the Q→S situation on several occasions, but did not think to use it in the S→Q situation (problem 3) and, when reminded, found only one quadrant when two were needed. The QSTF connection is considered to be present in both situations.

The QSXY connection was properly utilized when needed in the Q→S situation. It was properly utilized in the S→Q situation on one occasion and avoided on another by use of an alternate path. It is considered to be present in both situations. Similarly, the affix sign, form ratio of signs, uniform ratio of signs, and take reciprocal connections were appropriately used on all occasions and are considered to be present in all Model situations.

While solving problem 1, S indicated an unfamiliarity
with the use of the calculator in trigonometry and then proceeded to use it properly (in the AM–R situation). Also, S succeeded in using the calculator connection in the R–AM situation, but only with a great deal of help. The calculator connection is considered to be present in both situations.

S's use of the AG connection was interesting. S began working problem 1 by the method represented in the first non-Model path, by taking the supplement of the given angle. This is considered to be a special case of the AG connection in the non-Model situation AM–AM. After a suggestion by I, S appropriately used the AG connection in the A–RA situation. In working problem 3, S had difficulties using the AG connection in the A–AM situation due to not knowing where to put the reference angle on the figure (due to weak RA). S did use this connection properly in the A–AM situation for the special angle 270° (problem 4). The AG connection is considered to be present in the three situations.

The Theorem of Pythagoras was correctly used in all instances in the P–P, P–AV, and AV–AV situations. However, an error by I prevented any instance in which a negative answer was needed. It is unclear whether S could have done this properly because of the weakness in P.

S5's problem solving C-schema is the model problem solving C-schema with the construct (AM–A) connection missing and several new connections added: AG (AM–AM), construct
(AM→RA), measure (P→AV), observe (P→AV), form ratio (AV→R). S5's parent C-schema is the Model parent C-schema with circles at the P, RA, and R vertices, a dashed line joining AM and A, and an additional solid line joining AM and RA.

These conclusions make it appear that S's understanding and knowledge of coordinate system trigonometry is relatively complete. However, it should be noticed that the most important vertices, P, R, and RA are weak, which greatly reduces the estimate of S's understanding. In fact, since the weakness in P involved the use of a, b, and r as sides of a triangle rather than coordinates of a point, it appears that S is operating in a mode that is very close to right triangle trigonometry. One general conclusion from this interview is that, if the Model is used to compare subjects, some kind of weights measuring relative importance must be assigned to the vertices and connection.

Subject 5: U-Interview Analysis

Subject 5 operated in Mode 1 in the early part of the interview using arc, arc length, the end point of an arc, \( \sin s = y \) and \( \cos s = x \). This did not occur spontaneously and, in fact, required much encouragement. S did connect arc length with the unit circle and understood the idea of arc length but needed help with the details. Also, S's first inclination was to use \( \sin s = b/r \), but once reminded that \( r = 1 \), S observed (recalled?) that sine is the y coordinate and that cosine is the x coordinate. S used
sin s = y and cos s = x throughout the remainder of the interview. Later in the interview S may have lapsed into thinking in terms of right triangles. S drew right triangles within unit circles and appeared to use x and y as sides of a triangle rather than as coordinates of a point. This behavior was also exhibited during C-interview and indicates that S's R-schema is much stronger than either S's C-schema or U-schema.

As indicated earlier, S utilized the arc on a unit circle properly but required much assistance in order to use the arc length concept. Thus the Arc vertex is considered to be strong and the AL vertex to be weak. It should be noted, however, that they appear to be much weaker than the AM and A vertices in R-schema and C-schema.

S was totally unable to use or discuss the idea of a reference arc, and thus the R Arc vertex must be considered to be absent from S's U-schema.

The P vertex is considered to be weak for two reasons:
(a) S consistently used x and y as sides of triangles.
(b) S consistently ignored the possibility that s and/or y could be negative.

The AV and S vertices were avoided in problems 1 and 3 in which S did not get far enough to use them. However, since all states of knowledge of each were properly utilized at all other opportunities, they are considered to be strong. Also, all states of knowledge of the R vertex were properly
utilized at each opportunity, and it is considered to be strong.

The construct connection was properly utilized in problem 1, with assistance, in the AL-Arc situation. The difficulty is believed to result from S's weakness in the AL vertex. S did not use this connection in the P-Arc situation due to not getting far enough to reach it. S did demonstrate the ability to construct a unit circle and determine an arc in standard position on it, so the construct connection is considered to be present in the AL-Arc situation and absent in the P-Arc situation.

S did not use the measure connection in the Arc-AL situation due to not reaching it in the attempt to solve problem 3. It was utilized in the Arc-P situation with much assistance. It seems that this difficulty may be attributed to the weakness in P. The measure connection is considered to be present in the Arc-P situation and absent in the Arc-AL situation.

The form ratio connection was properly utilized in all instances and is considered to be present in the P-R and AV-AV situations.

S properly utilized the uniform ratio (R-P) connection in two instances. In another instance (problem 10b), S obtained only the positive answer and ignored the negative one due to the weakness in P. In problem 10a, S indicated that \( \sin s = 5 \) since \( \cos s/\sin s = -3/5 \) and could not find the
correct value. Thus, S was unable to properly utilize the uniform ratio connection in the difficult instance, but it is considered to be present in the R→P situation.

The sketch connection was properly utilized in all instances in the P→P, Q→P, and Q→Arc situations. It was not specifically used in the AL→Arc situation due to S's use of a previously constructed figure, yet it seems reasonable to assume that it is present in that situation. It was not used in the \( R_{\text{Arc}} \rightarrow \text{Arc} \) situation in problem 2 due to the absence of the RArc vertex which prevented any real attempt at solving the problem. Also, S did not use it in the P→Arc situation, although the problem (4) was solved correctly. The sketch connection is considered to be present in the AL→Arc, P→P, Q→P, and A→Arc situations and absent in the P→Arc and \( R_{\text{Arc}} \rightarrow \text{Arc} \) situations.

S properly utilized the observe connection in the Arc→Q, Arc→P, and P→AV situations. It was not used in the P→S, R→AV, and R→S situations in problem 3 since the absence of the RArc vertex prevented any attempt at solving the problem. In solving problem 12, S used a variation of path 4e. This involved observing the quadrant that the given point was in and then using QSTF to determine the sign of the answer. It involved a use of the observe connection in the non-Model P→Q situation. The observe connection is
considered to be present in the Arc-Q, Arc-P, P-AV, and P-Q situations and absent in the P-S, R-AV, and R-S situations.

S failed to utilize either the table connection or the calculator connection in any situation. S did not use the table connection due to the absence of the RArc vertex, and S could not use the calculator at all. Both connections, therefore, must be considered to be absent from S's U-schema.

Both the form ratio of signs and uniform ratio of signs were unused by S because so little progress was made in solving the problems in which they were needed that they were not reached. They must be considered to be absent from S's U-schema.

The QSTF connection was not used in the Q-S situation in problem 2 due to the absence of the RArc vertex, but was properly used in four other instances in that situation. It was not used in the S-Q situation at all due to S's total failure in problem 2, which was the instance in which it would have been used. However, S indicated knowledge of the "all students take calculus" mnemonic device, which indicates that it may have been available. The QSTF connection is considered to be present in the A-S situation and absent in the S-Q situation.

The QSXY connection was not used in the Q-S situation in problem 1, but was effectively utilized in that situation on two other occasions. Similarly, it was not used in the S-Q situation in problem 2, but was properly utilized in that
situation on another occasion. Thus the QSXY connection is considered present in both situations.

S failed to use the affix sign connection in problem 1, but used it properly in both the $AV_S \rightarrow R$ and $AV_S \rightarrow P$ situations on other occasions. It is considered to be present in both situations.

S exhibited difficulty in utilizing the AG connection in the Arc-AL situation and failed totally in the Arc-RArc situation. The failure in the Arc-RArc situation was due to the absence of the RArc vertex. The Arc-AL situation was properly utilized for quadrantal angles, but was not reached in problem 2 which involves non-quadrantal angles. This is consistent with an observation made in problem 1, that S could properly use the idea of arc length (the AL vertex) only for quadrantal angles. Thus S's difficulties with the AG connection are attributed to the weakness of the AL vertex and absence of the RArc vertex.

The AG connection is considered to be present in the Arc-AL situation and absent in the Arc-RArc situation.

The $x^2 + y^2 = 1$ connection was not properly utilized in any instance in the P-P situation, in that no negative values were found. This is attributed to the weakness in P since it appears that S considered x and y to lengths of sides of triangles and thus to be positive always. This
connection was properly used on several occasions in the
P→AV situation. It is considered to be present in both sit-
uations.

S properly utilized the take reciprocal connection in
both Model situations (R→R, R→P) and it is considered to be
present in both situations.

S5's problem solving U-schema is the Model problem
solving U-schema with the addition of the observe connection
in the P→Q situation and the deletion of the calculator
(P→AL, AL→P, AL→R, R→AL), table (AV→RArc, RArc→AV), con-
struct (P→Arc), measure (Arc→AL), sketch (P→Arc, Q→RArc),
observes (P→S, R→AV, R→S), form ratio of signs (S→Q), and AG
(Arc→RArc) connections. S5's parent U-schema is the Model
parent U-schema with open circles at P and AL; and with RArc
and all lines to it missing; with the lines joining R to AV,
R to S, P to S, and AL to R missing; and with a dashed line
joining Arc to P.

**Subject 5: T-Interview Analysis**

S5 succeeded in problem 1 with much assistance. S first
failed to observe that the table was in degrees while the
problem was in radians. After this was pointed out, S wrote
the correct conversion equation but needed help to use it
properly. Problem 2 was solved efficiently and correctly as
S had apparently learned enough from problem 1 to allow a
proper solution. It appears that S's $\pi/180 = s/\theta$ connection
was greatly strengthened during the interview and, at least by the end of problem 2, was present in both situations (AL-AM, AM-AL).

S also properly used the table connection in both appropriate situations (AL→R or F, AM→R). Thus it is strong and present in both situations. In the U-interview, S failed to use the table entirely, but this was due to the fact that the opportunity to use the table did not arise due to the absence of the RArc vertex. It is now believed that S is capable of using the table and that I should have introduced a first quadrant arc during U-interview to determine this.

S could not properly utilize the construct connection in the A-Arc situation in problem 3, but did use it properly in the Arc-A situation in problem 4. However, when faced with an arc of radius 2, S drew exactly the same angle indicating a total lack of understanding that r = 1 is necessary. This misconception is also the reason behind S's failure in problem 3. Thus, the construct connection is considered to be present in the Arc-A situation and absent in the A-Arc situation. It is also absent in the RA-RArc and RArc-RA situations due to the absence of the RArc vertex.
Subject 5: Interview Analyses by Second Evaluator (E2)

Subject 5: R-Interview Analysis by E2

S5 operated throughout the R-schema interview in mode 1 as evidenced by the S's use of the right triangle terminology of opposite, adjacent, and hypotenuse in the trigonometry definitions and by sketching and constructing right triangles without a coordinate orientation.

In all problem solving situations S utilized the appropriate vertices as needed; that is, each of the four vertices (R, L, RT, and AM) were strongly present in S's R-schema. However, it was difficult to determine the interiority of the ratio (R) concept, for in each problem S unformed the ratios as they were given without using the equivalence notion.

There were two minor instances of S using non-Model paths. In working problem 3, S appeared to use a R→Calc→AM→Calc→R path instead of the Model's R→Calc→R path; and in working problem 5, S first found the complementary angle and then added 90° and subtracted this sum from 180° to find the required angle. This behavior was not anticipated by the Model and in effect adds a new complement connection in the AM-AM situation.

All connections appeared to be strongly performed with the possible exception of the table connection (R-AM) which was haltingly tried and then discarded in working problem 1; but thereafter S performed it flawlessly so it was concluded
to be present along with the others. This improvement in performance with using the table would appear to imply that a subtle act of learning was taking place within S's R-schema as the interview progressed and as the dialogue between I and S supported and reassured S's actions. The fact that learning was occurring is supported by two other instances: it appeared that S had never before used a calculator in connection with trigonometry functions nor had ever before constructed right triangles to scale as a means of finding angle and line measures, though from the beginning S performed these operations very well, needing only a suggestion from I that S try using other tools provided for use during the interview; and so these connections were judged to be present. This alleged act of learning does not distract from the measurement of cognitive structures so much as it illustrates the latent potential of a schema to grow at propitious moments of readiness; indeed it is as if these rapidly assimilated connections were there originally.

S5's parent R-schema is the Model parent R-schema.

Subject 5: C-Interview Analysis by E2

S5 operated in mode 2 throughout the C-schema interview; that is, S worked within a coordinate system setting but applied the a, b, and r designations to sides of right triangles except for quadrantal angles, in which case S used coordinates on the unit circle, though there was one instance
in problem 3 where S sketched the point \((10,-16)\) in order to
measure the angle formed.

Three vertices were found to be weak in S's conceptual
structure for the C-schema. They were point, ratio, and
reference angle. The point vertex was judged to be very
weak--almost nonexistent; the fact that there are many dif-
ferent choices for points was not understood; in fact, the
only states of knowledge for P were the four quadrantal ver-
tices on the unit circle. Because of the central role play-
ed by P in the C-schema S's entire C-schema is viewed as be-
ing relatively weak. The R vertex was considered to be weak
since S continued to confuse the tangent and cotangent def-
initions, tended to prefer the tangent form \(\sin/\cos\) to \(b/a\),
showed no evidence of the equivalence relationship, and was
confused about fractions with zero in the numerator or de-
nominator. The RA vertex was considered to be weak since S
repeatedly failed to use it even when given considerable
guidance by the interviewer; at one point during the
C-schema interview I asked, "What do we mean by reference
angle?" to which S replied, "I don't know."

The remaining vertices, angle, quadrant, absolute value,
and sign, were found to be strong since S consistently han-
dled the various states of knowledge as they passed through
these vertices, though S's knowledge of the sign of trig \(\theta\)
in the various quadrants was based primarily on the mnemonic,
"all students take calculus."
An analysis of S's connections in the C-schema was complicated by the almost total absence of the point vertex and by S's heavy reliance on right triangles. It is clear that the relative strengths of vertices had a large impact on S's utilizing connections properly; nevertheless, taking the effects of weak vertices into account, the calculator (R→AM), AG (A→RA), AG (RA→A) connections were judged to be absent. In all other cases the connections were judged to be present.

S performed the construct connection (AM→A and P→A) very well throughout the interview.

S chose quadrantal points on the unit circle, but with one exception general points were never chosen. However, this avoidance was compensated by the use of right triangles, and if S's point vertex had been stronger, most certainly the choose point connection would have been more strongly applied.

Measures were well performed with both ruler and protractor.

Though S did not form a ratio directly from the coordinates of a point, the form ratio connection was successfully used several times. It was assumed that if the point vertex had been stronger the form ratio connection would also have been more strongly applied.

The uniform ratio connection was judged to be present, however its effectiveness was hindered by a weak ratio
vertex. When equivalent ratios were not needed, the uniform ratio connection (AV~AV) was well performed.

Overall sketch was one of S's strongest and most used connections.

The observe connection was similar to the sketch connection in that S performed very well within a right triangle context but failed to utilize it in the R-S situation at one point in problem 3.

Both QSXY and QSTF connections were performed successfully and unsuccessfully. Unsuccessful performances were particularly evident in problems 1 and 3, but as the interview progressed S became more and more familiar and adept with these connections so that they were performed very well after problem 3.

In problem 1 S failed to affix a negative sign to the obtained ratio, however the connection grew in strength as the interview progressed.

S knew how to combine the signs of the numerator and denominator to obtain the proper sign of a ratio, though because of weak point and ratio vertices S frequently failed to realize the existence of two cases without being reminded by I.

On two occasions in problems 3 and 5 S forgot to uniform the ratio of signs in order to consider two cases, but when reminded, S performed the connection well.

S could find the trigonometric ratio of a given angle
by using the calculator, but the inverse connection calc (R-AM) was not performed correctly in problem 3 when S failed to take the reciprocal before punching the inverse tangent key, and though this error was due in part to a weak ratio vertex it also appeared that S's familiarity with using a calculator was marginal at best (though S had used the calculator successfully in prior interviews), so calc (R-AM) was judged to be weak, but nevertheless present.

The arithmetic/geometry connections were a very weak part of S's C-schema, particularly in problem 3 where S appeared to be guessing much of the time when searching for the angle whose cotangent was 1.6, and this behavior continued after considerable support and patience from I. Of course a weak reference angle vertex was contributing to these weak connection behaviors. Specifically the weak arithmetic/geometry connections were used in the A-AM and RA-A situations.

AG (RA-A) is technically a new connection since it was not listed as one of the original arithmetic/geometry connections.

S did not perform TP (P-P) because of a weak point vertex, but the Pythagorean theorem was performed perfectly within the right triangle context and so $x^2 + y^2 = r^2$ was judged to be a strong connection.

The take reciprocal (R-R) connection was performed very
very well in problems 6, 10, and 13; so take reciprocal was judged to be a strong connection.

Overall S's C-schema was relatively weak; in particular, the R-schema has not been well integrated and consolidated (embedded) in the C-schema; for example, S's "strong" performance in the later problems appeared to be an algorithmic nature performed in the familiarity of right triangles. S failed to realize that the reference angle was really playing the role of the acute angles within the ordinary right triangles.

Subject 5's parent C-schema is the Model parent C-schema with open circles at P, R, and RA; dashed lines joining AM to A, AM to R, and A to RA; and the line joining A to RA absent.

Subject 5: U-Interview Analysis by E2

S5 operated mostly if not entirely in mode 3; that is, S treated the U-schema as a special case of the C-schema, letting \( r = 1 \), but otherwise continuing as if operating within the C-schema; for example, angles were used instead of arc except in cases where I strongly encouraged S to use arc, and even then the subject performed in an unsure manner.

Four vertices were found to be weak in S's conceptual structure for the U-schema, one vertex was totally absent, and three vertices were judged to be strong. The weak vertices were arc length, arc, ratio, and point; the missing
vertex was reference arc; and the strong vertices were quadrant, sign, and absolute value. S's concentration on angles rather than arcs had a strong influence on measuring the strengths of the vertices because of the restricted availability of states of knowledge pertaining to arcs. At no time during the interview did S voluntarily use arcs instead of angles, though under strong encouragement from I, S demonstrated limited use of arc measurement, especially as related to quadrantal angles. These observations led the reviewer to conclude that both arc length and arc were weak vertices.

The closely related reference arc was completely absent; the only evidence the subject gave of possessing any state of knowledge connected with the reference arc vertex was in problem 3 where S was looking for the arc length $s$ given that $\cos s = -.3$. In this case S used the table and found that $\cos (1.25) = 0.3$, but as the interview continued it became clear that S had no idea how the information could be used in a viable solution; in other words S had reached a state of knowledge belonging to the reference arc vertex without knowing it and without any means of transforming that state of knowledge to another state.

Weak ratio and point vertices also contributed to S's overall weak performance within the U-schema. S had a difficult time adjusting from the "$b/a$" to "$\sin/cos$" definitions of the trigonometric functions. It was particularly
difficult for S to recall the "sin s = y coordinate" and "cos s = x coordinate" definitions; at no time did S actually place a point on the unit circle nor write an ordered pair representing (cos s, sin s); and once S achieved the unit circle state of knowledge it was as as if the circle was a fixed image to be viewed like a picture rather than being a viable construct to be used in solving problems. In problem 1, for example, S showed no sense of the relationships between coordinates as ordered pair entries and coordinates as measures of distances except for the quadrantal points. The weakness of the ratio and point vertices was particularly revealing in problem 10a (find sin s if cot s = -3/5). The subject immediately concluded that since cos s = cos s/sin s = -3/5, y = 5 or sin s = 5! The important and basic ideas of ratio equivalence and multiple points serving the same situation were completely absent.

The remaining quadrant, sign, and absolute value vertices were judged to be strong since S possessed the corresponding states of knowledge for these vertices as they were required in working the problems during the interview. Actually the states of knowledge for these three vertices remained the same in the U-schema as they did for the C-schema, in which case they also were judged to be strong.

Next a discussion and judgement of S's problem solving connections in the U-schema is given. However it should be noted that S's weak and missing vertices play an important
role in judging the relative strengths of connection in the U-schema as it did in the C-schema, and furthermore this role is almost impossible to factor out. Some of these difficulties will be noted in the following discussion of connections. Most of S's successes closely followed the patterns used successfully in the right triangle and coordinate schemata. In short, the construct and calculation connections were judged to be absent and the arithmetic/geometry, measure, observe, and table connections were judged to be present.

There was no evidence of S using the construct connection so it is considered to be absent from S's U-schema structure. Clearly S would have been able to construct right triangles, but S's weak arc and arc length vertices hindered any construction with arcs.

The measure connection was judged to be weak since S needed considerable guidance from I at the outset to measure the length of the semicircle \( r = 1 \) and an arc of four radians.

S used form ratio \((P\rightarrow R)\) very well coming off an application of the Theorem of Pythagoras in a triangular setting, so the form ratio connection was judged to be present even though both the P and R vertices were judged to be weak. The fact is the form ratio connection was well formed in previous work and continues to serve on a rather surface or rote manner.
S used the uniform connection (R-P) in an acceptable manner several times, but as mentioned earlier, the subject unformed the ratio \( \cot s = -3/5 \) to obtain a sine value (y-coordinate) of 5; however this particular failure seems to be attributable more to a weak R vertex rather than a weak uniform connection.

The sketch connection was well performed in all instances except sketching an arc measuring four radians in length, but this failure was largely caused by weak arc vertices.

S failed to use the observe connection (R-S) in problem 10b and performed it badly in problem 3 (R-AV), so S's observe connection was judged to be weak.

S had little facility for using the radian measure trigonometric table. The only attempt in problem 1 was unsuccessful; therefore S's table connection was considered to be very weak, though again much of the difficulty can be traced to weak arc vertices.

As was the case with S's C-schema, the QSXY and QSTF connection were performed correctly in S's U-schema when S remembered to use them, but S forgot to apply them on about four occasions when they were needed; nevertheless both QSXY and QSTF were judged to be present in the subject's U-schema.

S's use of the affix sign connection was not applied in problem 10b, however none of the sign related connections were applied in 10b because S failed to realize that there
were two cases, and since S other applications of the affix sign connection (S→R) were perfect, a good case could be argued for judging S's affix sign connection to be strong.

In problem 6 S misused the form ratio of signs connection (S→S) by not considering both cases, but it was due to weak ratio and point vertices.

S could not use the calculator in radian mode so the calculator connection was judged to be absent from S's U-schema.

The only time during the interview that S showed any indicated of possessing the AG connection was in problem 4 where S recognized that the length of an arc terminating at (0,1) had length \( \pi/2 \), so it was judged to be weak.

Finally, both the Theorem of Pythagoras and take reciprocal connections were properly used in each appropriate instance so they were judged to be strong connections.

Subject 5's parent U-schema is the Model parent U-schema with RArc missing; open circles at AL, Arc, P, and R; with dashed lines joining AL to Arc, Arc to P, P to S, AV to R, R to S, and AV to RArc; and with the line joining AL to R missing.

Subject 5: T-Interview Analysis

In actuality S5 possessed no T-schema. The construct (A→Arc and Arc→A) connection was absent; the algorithmically performed proportion, \( \theta/180 = r/\pi \), was incorrectly used in one situation (AL→AM) and correctly used in another (AM→AL);
and the table was used correctly for first quadrant radius and degrees entries, however the subject interpreted .8 radians as .8 degrees when first attempting problem 1 and proceeded to interpolate in a rote manner.

Subject 6: Interview Analyses

Subject 6: R-Interview Analysis

With only slight encouragement S6 operated in mode 1 on problem 1 and without further encouragement remained in mode 1 throughout the remainder of the interview. Early in the interview S appeared to show some weaknesses in the L, AM, and R vertices. S appeared to have difficulty recognizing "0" as meaning the length of the opposite side, tried to equate 50° with .50, and had difficulty realizing that tan θ = .3 did not mean θ = .3. However, as the interview progressed these difficulties did not reappear, and all vertices were properly used in all situations.

S had some difficulty using the table, utilizing the wrong side for two angles that were greater than 45°. However, in other instances S properly used the table connection in all appropriate situations. It is considered to be strong and present in the R→AM, AM→R, and R→R situations.

S showed a complete inability to use the calculator connection in any situation, and it is considered to be absent from S's R-schema.

The construct connection was used only once, in the L→RT
situation (problem 5). It is considered to be present only in the L→RT situation.

The measure connection was never used in the interview, even in the one instance in which a construction had been done, and it is considered to be absent.

S did not use the form ratio connection in problem 1 due to the inability to construct but did use it properly in all later opportunities, and it is present in the L→R situation. Similarly, the uniform ratio connection was not used in problem 2 due to S's inability to construct, but it was used properly in each later opportunity. It is considered present in the R→L situation.

The Theorem of Pythagoras, take reciprocal, sketch, and observe connections were properly used in all Model situations and are considered to be present in all Model situations.

S indicated an inability to solve an equation and thus the solve connection is absent.

In summary, the calculator, measure, and solve connections are absent form R's R-schema, while all others are present. S's problem solving R-schema is the Model R-schema with the following connections missing: construct (AM→RT), calculator (AM→R, R→AM), solve (R→L), and measure (RT→L, AM→RT). S's parent R-schema is the Model R-schema, but all links are weak.
Subject 6: C-Interview Analysis

During the C-interview S6 seemed to operate primarily in mode 2. Although S often talked about coordinates of a point, the figures which were drawn used a and b as sides of triangles. S even mentioned on several occasions that a and b were sides of triangles. Circles were drawn in most figures but were ignored in problem solutions. Since S6 operated in mode 2, we must conclude that P is weak.

There were several other reasons for concluding that P was weak. In problem 5 S failed to consider that a and b could be negative. S repeatedly stated and wrote that r could be negative. In problem 12, with a = 2 and b = -3, S sketched a right triangle by joining the points (2,0) and (0,-3) by a line segment, and the point (2,-3) was not sketched. Thus P was very weak.

Another vertex that was very weak was the R vertex. On two occasions S had to be told the definition of sin θ in order to continue. Once given the definition of sin θ, S listed the definitions of the other five but had to refer to this list frequently throughout the interview. In addition, S thought that (-2)/3 = s/(c-3).

S appeared to have no conception of the reference angle idea, once even stating an ignorance of the meaning of the term. In problem 1 (find cos 127°) S used both 37° and 53° in ways in which a reference angle could be used but had no idea which one should be used. Thus, 37° and 53° are
considered to be states of knowledge in AM and not in RA. In problem 3 S did measure the reference angle instead of the angle in standard position, but this just seemed to be a matter of convenience. Also in problem 3, S used the table to find the measure of an angle but did not know that it was a reference angle and could not complete the problem. Since a state of knowledge of RA was actually used, the RA vertex is considered to be present, but very weak.

All other Model vertices were properly used and are considered to be strong and present in S's C-schema.

S used several non-Model paths which need discussion. In attempting to find \( \cos 127° \), S incorrectly decided that \( 90° \) is half of \( 127° \), looked up \( \cos 90° \) and multiplied by 2. This path contains an incorrect connection and an incorrect use of RA, and is exhibited as follows:

\[
\text{AM} \rightarrow \text{AG} \rightarrow \text{RA} \rightarrow \text{Table} \rightarrow \text{R} \rightarrow \cos 2\theta = 2\cos \theta \rightarrow \text{R}
\]

In a second attempt to find \( \cos 127° \), S noted that \( 127° = 90° + 37° \), used the table to find \( 37° \), stated that \( \cos 90° = 1 \), and added these two values. This path also contains two incorrect connections and is exhibited as follows:

\[
\text{AM} \rightarrow \text{Arith} \rightarrow \text{AM} \rightarrow \text{Table} \rightarrow \text{R} \rightarrow \cos(A+B) = \cos A + \cos B \rightarrow \text{R}
\]

To attempt to solve problem 9, S used \( x^2 + y^2 = r^2 \) to find \( r = \pm \frac{13}{2} \). To determine whether sec \( \theta \) was positive or
negative, S observed that the point was in the fourth quadrant and that sec $\theta$ must be negative, an incorrect use of QSTF. S then chose the negative answer. Thus the two errors made by S in this problem were (a) thinking that $r$ could be negative and (b) the incorrect use of QSTF. The path follows:

Another non-Model path used occurred in problem 12. S used $|\cot \theta| = 2/3$, and unformed the ratio. To decide which one was negative, S attempted to sketch the point, observed that the point was in QIV, and noted that in QIV, $a < 0$ and $b < 0$, so that $a = 2$ and $b = -3$. S then used $x^2 + y^2 = r^2$ to find $r$ and formed the required ratio ($\sin \theta$) correctly. The path follows:

The last non-Model path was used in problem 13. S unformed the ratio sec $\theta = 4$ to get $r = 4$, $a = 1$ and used $x^2 + y^2 = r^2$ to obtain $b = \pm \sqrt{15}$. To find the sign, S observed that $\sin \theta$ was negative, concluded that $b$ had to be
negative, and formed the correct ratio $\tan \theta = -\sqrt{15}/1$.

The path follows:

Several non-Model connections (arithmetic, AM→AM; $\cos 2\theta = 2\cos \theta$, R→R; $\cos(A + B) = \cos A + \cos B$, $\cos 90^\circ = 1$, AM→R) which have already been discussed are considered to be present in S's problem solving C-schema. One additional non-Model connection was used in the attempt to solve problem 3. S said that $\theta$ must be negative since $\cot \theta$ is negative. Thus the connection "$\cot \theta < 0 \Rightarrow \theta < 0$" in the S→S situation is considered to be present in S's problem solving C-schema. Of all of these non-Model connections, only "arithmetic" is a valid mathematical operation, and it is present in S's C-schema only because it was used in an incorrect attempt at solving problem 1.

S failed to use construction in problem 1 (AM→A), noting that the protractor "doesn't tell the cosine," but did succeed in constructing an angle in problem 3 (P→A). Thus the construct connection is present in the P→A situation and absent in the AM→A situation.

The choose point connection (A→P) was used only for a quadrantal angle (problem 2). It was not used in problem 1 since no construction was done. It is considered to be present in the A→P situation.
The failure to use construction in problem 1 caused the measure connection (P→P) to be avoided, but it was used in problem 3 (A→RA) to measure the reference angle. It is present in the A→RA situation and absent in the P→P situation.

The sketch connection was properly used in the AM→A situation and with some difficulty (due to weak P) in the P→A situation. It was used incorrectly in the Q→P situation (again due to weak P). The weakness of RA caused S to be unable to use the sketch connection in the RA→A situation. It was not used in the Q→A and P→P situations. Thus it is present in the AM→A, P→A, and Q→P situations, and absent in the RA→A, Q→A, and P→P situations.

The form ratio connection (P→R) was avoided in problem 1 due to the failure to use construction, but was properly used in that situation on six other occasions. It was properly used on the only appropriate occasion in the AV→AV situation. In addition, it was used in the non-Model P→AV situation, as previously described in connection with the third non-Model path. Thus it is considered to be present in all three situations.

S properly used the uniform ratio connection (R→P) on all four occasions, but required some assistance when two answers were needed. It was also used in the non-Model situation AV→AV (refer to the fourth non-Model path). It is present in both situations.

The observe connection was used properly and is
considered to be present in the A→Q, P→P, R→AV, R→S, and P→Q situations. It was not used in the A→Q situation since the problem was solved with no sketch and no observation was needed. This connection is absent from S's problem solving C-schema in the A→Q situation.

S did use the R-schema connection in the RA→AV and AV→RA situations. In an unsuccessful attempt to solve problem 1 without being able to use the reference angle, S used the table (RA→AV) as described in connection with the first two non-Model paths. S also used both the table and the calculator (AV→RA) in an unsuccessful effort to solve problem 2. Thus the R-schema connection is considered to be present in both Model situations.

The mnemonic "all silver teacups" was used by S to remember the QSTF connection, but even so S failed to utilize it in the S→Q situation and exhibited several errors in the Q→S situation. At various times S stated that only sin θ is positive in QI, that cot θ is negative in QIII, and that sec θ is negative in QIV. The QSTF connection is present in the Q→S situation and absent in the S→Q situation.

The QSXY connection was used and is considered to be present in both Model situations (Q→S and S→Q), but S did exhibit difficulties with this connection. It was not used in problem 1, being replaced by QSTF. S could not use it in problem 5, but did use it in problem 12 although S indicated that b > 0 in QIV.
S properly used the affix sign connection in the $AV_S \rightarrow S$ situation in problems 1, 5, and 9 although some assistance was needed in problem 1. This connection was not in the $AV_S \rightarrow P$ situation in problem 5 due to use of QSTF instead of QSXY, but it was properly used in that situation in problems 12 and 13. The affix sign connection is present in both situations.

The form ratio of signs (S→S), uniform ratio of signs (S→S), and take reciprocal (R→R) connections were properly used in all appropriate instances and are considered to be present in S's C-schema.

S properly used the calculator in the AM→R situation but was unable to use it in the R→AM situation. The calculator connection is present in the AM→R situation but absent in the R→AM situation.

The AG connection was properly used in problem 4 in the A→AM situation, and it is present in that situation. As described earlier, in solving problem 2 by construction, S constructed an angle with (-16,10) on the terminal side, and measured the reference angle. However, since S had no knowledge of the reference angle concept, it is believed that S simply used this as a procedure to find the angle and not as a use of the RA vertex. This use of AG is considered to be in the non-Model AM→AM situation. Thus the AG connection is considered to be present in the AM→AM and AM→A situations and absent in the A→RA situation.
The $x^2 + y^2 = r^2$ connection was properly utilized in the P-A situation, but its use was avoided in the AV-AV situation due to the use of the fourth non-Model path on problem 12. In the P-P situation several difficulties were observed. In problem 7, S found only the positive answer and then added the negative answer. In three different problems S allowed $r$ to be negative. Both of these difficulties were attributed to the weakness in the P vertex. In problem 6, knowing that $x$ is negative, S incorrectly wrote $-x^2 + 3^2 = 7^2$ and then used incorrect algebraic procedures to find $x = -40$. This connection is considered to be present in the P-P and P-AV situations and absent in the AV-AV situation.

S's problem solving C-schema is the Model problem solving C-schema with some missing connections and some added connections. The missing connections are: construct (AM→A), sketch (P→P, Q→A, RA→A), measure (P→P), $x^2 + y^2 = r^2$ (AV-AV), AG (A→RA), and QSTF (S→Q). The added connections, each of which is either inappropriate or incorrect, are: arithmetic (AM→AM), $\cos 2\theta = 2\cos \theta (R \rightarrow R)$, $\cos 90^\circ = 1 (R \rightarrow R)$, and $\cot \theta < 0 \Rightarrow \theta < 0 (R \rightarrow R)$. S's C-schema is the Model C-schema with open circles for the weak vertices P, R, and RA; the link joining AG to RA missing; and with dashed lines for the weak links joining AM to A, AM to R, A to Q, Q to S, S to R, and AV to R.
Subject 6: U-Interview Analysis

Analysis of the U-interview with S6 reveals a complete lack of knowledge of unit circle trigonometry. S had no knowledge of the unit circle, arcs on a unit circle, or of arc length, and did not know the unit circle definitions of the trigonometric ratios. Thus S has no problem solving U-schema and no parent U-schema.

In addition, the U-interview determined that S had no knowledge of radian measure and could not even use the table with radian measure. In this situation it was clear that S could not possess any connections between C-schema and U-schema and hence no T-interview was given.

VALIDITY

Face Validity

The present Model has been constructed to meet face validity requirements. The objective was to develop a model of a structure of trigonometric concepts which could describe problem solving. All problem solving paths used by all subjects could be represented in the preliminary Model and Model schemas with no changes in vertices. Differences from the Model were of five types.

1. S may not have possessed all states of knowledge of a given vertex.

2. S may have possessed incorrect states of knowledge of a given vertex.
3. S may have possessed incorrect or unnecessary (from an efficiency point of view) connections in various situations. (All correct and necessary non-Model connections used by S1, S2, S3, and S4 were added to the Model. None were used by S5 or S6.)

4. S may not have possessed certain important connections.

5. S may have possessed incorrect or unnecessary non-Model links. (All correct and necessary non-Model links possessed by S1, S2, S3, and S4 were added to the Model. None were used by S5 or S6.)

One further observation important to face validity can be made. The sources of difficulty in every unsuccessful problem solving effort can be classified as one (or more) of these five types, and can be identified as resulting from weaknesses in specific vertices or connections.

**Cross-Validity**

Comparisons of the A and D students from the two subject selection phases are given here. The intent is to determine if the predictions from the Model are fulfilled by the data.

1. The A student's parent schema could contain more vertices than the D student's.

2. The A student's parent schema could contain more strong vertices than the D student's.
3. The A student's parent schema could contain more links than the D student's.

4. The A student's parent schema could contain more strong links than the D student's.

5. The A student's problem solving schema could contain more correct and appropriate connections than the D student's.

6. The A student's problem solving schema could contain fewer incorrect or inappropriate connections than the D student's.

Comparison of S3 and S1

Recall that S3 was selected as the A student and S1 as the D student in the first sample. From the analyses of S1 and S3 the following information concerning their R-schemas can be observed.

1. S3's parent R-schema contained four strong vertices, while S1's parent R-schema contained three vertices of which only two were strong.

2. S3's parent R-schema contained three strong links and one weak link, while S1's contained only two links, both of which were weak.

3. S3's problem solving R-schema contained a total of 12 correct connections in various situations, while S1's contained only five correct connections in various situations. Neither of the R-schemas contained any incorrect connections.
From the analyses of their C-interviews, the following information concerning their C-schemas can be observed.

1. S3's parent C-schema contained eight vertices of which three were weak, while S1's contained eight vertices of which two were weak.

2. S3's parent C-schema contained 10 links of which four were weak, while S1's also contained 10 links of which four were weak.

3. S3's problem solving C-schema contained 29 connections in various situations, while S1's contained 26 connections in various situations.

4. S3's problem solving C-schema contained no erroneous connections, while S1's contained one erroneous connection.

From the analyses of their U-interviews and T-interviews no differences of the predicted nature can be observed.

Comparison of S5 and S6

In the second phase of subject selection, S5 was the A student chosen and S6 was the D student chosen. From the analyses of their R-interviews, the following information about their R-schemas was observed.

1. Each subject's parent R-schema contained four strong vertices.

2. S5's parent R-schema contained four strong and no weak connections, while S6's contained no strong and four weak connections.
3. S5's problem solving R-schema contained 18 correct and no incorrect connections.

From the analyses of their C-interviews, the following information about their C-schemas was observed.

1. S5's parent C-schema contained eight vertices of which five were strong, while S6's contained eight vertices of which five were strong.

2. S6's parent C-schema contained 11 strong links (one non-Model) and no weak links, while S5's contained eight links of which two were strong and six were weak.

3. S6's problem solving C-schema contained 40 correct connections (five non-Model) and no incorrect connections, while S5's contained 27 correct and four incorrect connections.

S6 possessed no U-schema at all, while S5 possessed a fairly complete U-schema. The same is true for the T-schema.

Word Association

As indicated earlier, each subject was asked to respond to a word association instrument. The instrument contained six key words, given in order: trigonometric functions, right triangle, sine, trigonometry, angle, and arc. Each subject listed all of the responses from each key word which were thought of in a one minute interval. Since it is known that S5 has more complete and accurate schemas than S6, the
### TABLE 7

**Subject 5: Word Association Responses**

<table>
<thead>
<tr>
<th>Trigonometric Functions</th>
<th>Right Triangle</th>
<th>Sine</th>
<th>Trigonometry</th>
<th>Angle</th>
<th>Arc</th>
</tr>
</thead>
<tbody>
<tr>
<td>coordinates</td>
<td>90°</td>
<td>b/r</td>
<td>sine</td>
<td>degree</td>
<td>Noah</td>
</tr>
<tr>
<td>sine</td>
<td>angle</td>
<td>y-coordinate</td>
<td>triangle</td>
<td>vertex</td>
<td>radian</td>
</tr>
<tr>
<td>cosine</td>
<td>30°-60°-90°</td>
<td></td>
<td>angles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tangent</td>
<td>45°-45°-90°</td>
<td></td>
<td>radians</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cotangent</td>
<td>$a^2+b^2=c^2$</td>
<td></td>
<td>degrees</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cosecant</td>
<td>'s</td>
<td></td>
<td>cosine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>circle</td>
<td>sides</td>
<td></td>
<td>tangent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>triangle</td>
<td>opposite</td>
<td></td>
<td>circle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>angles</td>
<td>adjacent</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30°</td>
<td>hypotenuse</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60°</td>
<td>Pythagorean</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90°</td>
<td>Theorem</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### TABLE 8

**Subject 6: Word Association Responses**

<table>
<thead>
<tr>
<th>Trigonometric Functions</th>
<th>Right Triangle</th>
<th>Sine</th>
<th>Trigonometry</th>
<th>Angle</th>
<th>Arc</th>
</tr>
</thead>
<tbody>
<tr>
<td>formulas</td>
<td></td>
<td>measurement</td>
<td>unit</td>
<td>planes/intersection</td>
<td>functions</td>
</tr>
<tr>
<td>problems</td>
<td>θ</td>
<td>b/r</td>
<td>cosine</td>
<td>a²,b²,r²</td>
<td>radian</td>
</tr>
<tr>
<td>between numbers</td>
<td>0</td>
<td>x</td>
<td>division</td>
<td>right</td>
<td>circumference</td>
</tr>
<tr>
<td>numbers</td>
<td>0</td>
<td>cos</td>
<td>degrees</td>
<td>degree</td>
<td>circle</td>
</tr>
<tr>
<td></td>
<td>quadrants</td>
<td>opposite</td>
<td>angle</td>
<td>measurements</td>
<td>π</td>
</tr>
<tr>
<td></td>
<td>hypotenuse</td>
<td>sine</td>
<td>trigonometry</td>
<td>formulas</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>sine</td>
<td>cosine</td>
<td>trigonometric</td>
<td>relations</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>cosine</td>
<td>tangent</td>
<td>trigonometry</td>
<td>trigonometric</td>
<td>3.14</td>
</tr>
<tr>
<td></td>
<td>measurement</td>
<td>+ +</td>
<td>trigonometric</td>
<td>trigonometric</td>
<td>3π/2</td>
</tr>
</tbody>
</table>
responses of these subjects will be analysed. They are reported in Tables 7 and 8.

Analysis of these tables reveals little information to indicate differences. S5 made a total of 43 responses while S6 made a total of 41 responses, so no difference is noted here. It does seem that S5 may have tired of the exercise, since S5's early responses were more frequent, precise, and appropriate than were S5's later responses. On the other hand, S6's responses improved in frequency, precision, and appropriateness as the exercise progressed. There is some indication that S5 knew more about unit circle trigonometry than S6. S5's responses to trigonometric functions, sine, and trigonometry all contained references ("circle," "coordinates," "y-coordinate," "radians," "circle") to unit circle trigonometry. S6's responses to these items contained no such references. S6 did list "sine" as a response to Arc, but this may be because the instrument was administered at the close of the U-interview. The little evidence that can be gained from this data is consistent with the analyses of the interviews with S5 and S6.

RELIABILITY

To obtain an indication of the reliability of the interview analysis procedures, the interviews with S5 were analyzed by a second knowledgeable evaluator (E2) and the
analyses compared. The analyses are reported earlier in this chapter; the comparisons are given here.

The two analyses of S5's R-interview agree very closely. Both conclude that all vertices and links were strong. Both found that S used a non-Model path involving a connection which was called the complement connection by both evaluators. E2 also indicated an unusual use of the calculator in problem 3 which was not indicated by the first evaluator (E1), but this is the only difference noted.

Overall agreement between the two analyses of S5's C-interview was noted, but with some differences. Both analyses concluded that the P, R, and RA vertices were weak, with the others strong and that this indicated serious problems with S's understanding of coordinate system trigonometry. The parent C-schemas developed by the two evaluators showed three differences. E2 concluded that the links joining A to RA and AM to R were weak while E1 considered them to be strong, and E1 added a strong non-Model link from AM to RA. E1's conclusions that the links joining A to RA and AM to R were strong appears to be an error in analysis. E1's analysis indicates that S's use of the only connection on each link showed weaknesses and, according to the instructions, such links must be considered to be weak. E1's addition of a link joining AM to RA was the result of an observation that S really constructed the reference angle instead of the angle itself. E2 did not make that observation.
This difference also led to several differences in the evaluators' conclusions concerning S5's problem solving C-schema. E2 indicated the presence of the construct connection in the AM-A situation while E1 found it to be absent there and present in the AM-RA situation. E1's observation also led to further variations in problem solving paths which caused the addition of Model connections in five non-Model situations.

In their analyses of S5's U-interview the two evaluators differed in their conclusions as to the mode of operation, but this appeared to have no effect on the remainder of the analysis. Both found the AL, R, and P vertices to be weak, the RArc vertex to be absent, and the Q, S, and AV vertices to be strong. However, E1 indicated that the Arc vertex was strong while E2 considered it to be weak.

Some other differences were observed in the parent U-schemas obtained by the two evaluators. E2 observed no construction at all and concluded that the link joining AL to Arc was weak, while E1 indicated that S performed (with difficulty) a construction in that situation and concluded that the link was strong. E2 indicated weak links joining AV to R, R to S, P to S, and AV to RArc (even though RArc was absent), while E1 considered these links to be absent. These differences all arose from the same source. E1 observed total failure in the attempts to solve all problems which would utilize these links, attributing the failures to the absence of the RArc vertex. E2 seemed to have observed some attempt
to solve these problems and apparently observed some use of the appropriate connections.

E1 and E2 agreed in their analyses of the $\theta/180 = r/\pi$ and table connections in the T-interview, but showed one minor difference concerning the construct connection. E2 found that S5 did not use it at all, while E1 indicated that S5 did use it (without understanding) in the Arc→A situation in problem 4.
CHAPTER 5
CONCLUSIONS AND APPLICATIONS

Conclusions

This study had a twofold intent: (a) to develop a theory based model of structures of trigonometric concepts within which routine problem solving can be described; and (b) to develop a methodology which can be used to construct similar models in other content areas. The first stated purpose of the study was to make operational that part of Skemp's theory which deals with conceptual structures. This purpose relates to both intents and was accomplished by hypothesizing two related types of schemas, the underlying parent schema and the observable problem solving schema.

The specific fulfillment of the first intent was the objective of the second stated purpose. The Model developed in this study accomplished this objective. It was developed from both the adaptation of Skemp's theory previously summarized and from paths for solving trigonometry problems, and thus fulfills the first intent and the second purpose.

The third purpose involved the development of an interview process to determine if the described Model contained the problem solving paths used by subjects. An interview process was developed which was successful in determining representations of subjects' conceptual structures. In addition, the interview analyses determined that the Model was
flexible enough to represent the problem solving paths actually used by subjects, even when they were different from the paths used in Model development. Two major results support these conclusions: (a) All problem solving paths used by all subjects could be represented in the Model with no changes in vertices. (b) The sources of difficulty in every unsuccessful problem solving effort can be identified as resulting from weaknesses in specific vertices or connections. Fulfillment of this purpose also demonstrates strong face validity.

The second intent of the study was expressed in the fourth stated purpose: to generalize the processes of model formulation and interviewing in such a way that they can be used and tested in areas other than trigonometry. Fulfilling this purpose requires a set of instructions for model development and a set of instructions for interviewing. The instructions for model building are given in detail in Part II of chapter 3 and are summarized here. Problems from the chosen content area must be selected and methods of solution examined. From the methods of solution the important concepts and actions leading from one concept to the next should be identified. The identified concepts should be placed in a geometric configuration with two concepts joined by a line if and only if some action in a problem solving path joins those concepts. This is the parent schema. Then the problem solving schema can be drawn. In this figure the concepts may
be joined by more than one line and each line should be labeled according to the action it represents. The interview and analysis instructions used in this study are given in detail in Part IV of chapter 3. For another content area they would be similar, although modes of operation may not be necessary since there may be only one interpretation. A summary of those instructions is given here. During an interview each problem should be posed, the method of solution observed and described, the primary tool used in the solution removed, and the problem posed again. This process should be continued until the subject can find no more solutions, and then the next problem posed. Interview analysis should determine, according to the operational definitions, which vertices, connections, and links are present and which of the vertices and links are strong. Thus the model formulation and interviewing processes have been generalized. That they can be used and tested in other areas has not been established, but is a topic for further research. These considerations provide strong support for the fulfillment of the four purposes and two intents.

A major aspect of any instrument which requires discussion is validity. Face validity has been discussed earlier in this chapter. Two other forms of validity, cross validity and comparison with word association data, were investigated in this study. Cross validation involves comparing predictions (from the Model) of differences between A and
D students with observed differences. The major difference predicted from the Model is that each schema possessed by the A student is more complete and accurate than the corresponding schema possessed by the D student. More precisely, the A student's parent schema should possess more vertices and links than the D student's, and more of them should be strong. Also, the A student's problem solving schema should contain more correct and fewer incorrect connections than the D student's. The observed differences of the R-schemas of S3 (an A student) and S4 (a D student) were as predicted. However, only slight differences between their C-schemas and no differences between their U and T-schemas existed. Differences between all corresponding schemas of S5 (an A student) and S6 (a D student) were as predicted. With some mixed results, cross validity was generally supported.

The other type of validity examined involved comparing subjects' conceptual structures with word association data. The word association data reported in chapter 4 seems to have little relation to this study. The word association responses of S5 and S6 showed few recognizable differences, although their schemas were substantially different. It appears that more concepts and ideas can come to mind in the word association environment than can be used in problem solving.

A second major aspect which requires discussion is reliability. In this study no attempt was made to determine
the reliability of the interview process. To gain information concerning the reliability of the analysis procedures, the taped interviews with S5 were analysed by two evaluators (E1 and E2), and their analyses compared. The two evaluators were in agreement about S5's R-schema. Some differences were observed between their representations of S5's C-schema. They differed on the strengths of two links, and E1 reported a non-Model link which E2 did not report. The differences in strengths of the two links resulted from an analysis error by E1. The non-Model link was a result of a subtle observation which was made by E1 and missed by E2. This may be due to the fact the interviewing was done by E1 and provides some indication that, in general, analysis should be done by the interviewer. A difference in evaluation of the vertices was observed in their analyses of S5's U-interview. E1 found that the Arc vertex was strong while E2 found that it was weak. The cause of this difference is not clear. Some differences in the links were also observed. There were four links that E2 considered to be weak while E1 considered them to be absent. These differences arose from the same source. E1 observed total failure in the attempts to solve all problems which would utilize these links, attributing the failures to the absence of the RArc vertex. Although agreeing that the RArc vertex was absent, E2 seemed to observe some attempt to solve these problems and apparently observed some use of the connections along those links. The two
evaluators were in substantial agreement on the analysis of S5's T-interview.

These results indicate that reliability of analysis is strong for the simpler schemas (R and T) and somewhat weaker for the more complicated ones (C and U). It should be noted however that examination of the entire analyses for the sources of the differences shows more agreement than examination of the conclusions of the analyses would indicate. This suggests that the entire analysis of each interview should be examined in order to gain complete information about the subjects.

The conclusion that reliability of analysis is weaker for the more complicated interviews should not be surprising. In fact, the major limitation of this study is its complexity. Because of this complexity a researcher using the Model would be required to spend substantial quantities of time in preparing, interviewing, and analyzing. However, the use of conceptual structures in problem solving is a complex phenomenon, and a simple explanation may not be possible.

A major aspect of the Model is its flexibility, which is a result of the varifocal ability aspect of schemas. The schemas as used could be modified in a varifocal way to facilitate different goals in instruction or research. One way in which they could be modified would be by developing an entire schema to replace some connection. As an example, the $x^2 + y^2 = r^2$ connection could be detailed as a substitution
connection to the $x^2 + y^2 = r^2$ vertex and a solve connection to some other vertex. Another way would be to use an entire schema as one connection. For example, any of the Model schemas could be used as a "find trig $\theta$" connection in a larger schema. From this example, it is clear that varifocal ability applies to connections as well as to vertices, a fact which has not been mentioned by Skemp.

Another conclusion of the study concerns the realization that the vertices are of primary importance in the Model. As the study developed, the importance of the vertices emerged in two major ways. (a) No matter how strong a connection exists between two vertices, few problems can be solved correctly if one or both of those vertices are weak. For example, if a subject's P-vertex in the C-schema does not allow $x$ to be negative, a properly utilized form ratio connection cannot lead a negative value of the cosine function. (b) As indicated earlier, all problem solving paths used by subjects in this study utilized only the Model vertices. Many of these paths did use non-Model connections. Thus, all problem solving paths used by subjects could be described within the Model vertices, but variation in connections was evident.

**Research on the Model**

This study introduces a new technique which needs more research. One aspect which should be investigated further is validity. The results of this study indicate that the Model
has strong face validity and show some support for a conclusion of strong cross validity. Additional research to gain more support for cross validity and to obtain more information concerning comparisons of the Model with other methods of measuring conceptual structure would be valuable. More support for validity could also be obtained by measuring the conceptual structures of experts and comparing them with the Model.

As has been indicated, some question exists as to the reliability of analysis of the study. This should be investigated further with the less complex schemas first. Perhaps the experience gained would lead to some refinement of the analysis procedures which would increase their reliability. In addition, research should be designed to check the reliability of the interview procedures.

Although the establishment of validity and reliability is needed, it is also important to determine if it is generalizable. To determine this, additional research is needed which is similar to the present study, but which utilizes areas other than trigonometry.

Using the methodology of this study in any area is complex, but the use of written tests instead of interviews would simplify the procedures and would be of benefit to both the researcher and the practitioner. It would appear that developing such tests would be difficult and that such tests could not gain the amount of information which could be
gained by interviewing. For some purposes the lesser amount of information may be sufficient.

One other area of research on the Model would be the comparison of subjects' conceptual structures. Since the main intent of this study was to develop a method of measuring conceptual structures, no attempt has been made to rank subjects on the basis of their conceptual structures, except for the gross comparison used for cross validation. Now that the Model has been developed, such an attempt should be made. It is likely that this effort would have to include some system for weighting the various vertices, links, and connections according to their relative importance. It should be noted here that any attempt to condense subject analyses must result in a loss of information.

Research Uses of the Model

A primary potential research use of the Model concerns Skemp's theory. Much of this theory is based on schemas. Thus, an ability to represent such schemas provides the opportunity to use data to investigate many aspects of his ideas. These aspects include modification of structures, plan forming and director systems, and relational and instrumental learning. In the area of modification of structures, the Model could be used to investigate how schemas are assimilated, expanded, and restructured as well as why some schemas are more resistant to modification than others.
Information as to how plans are formed and problems solved may be gained by the use of thinking aloud interview procedures based on the Model. Since plan forming is a function of the director system, such research would also investigate the functioning of the director system and, in particular, the functioning of the comparator. Because of the previously discussed importance of relational learning, research on the subject would be of value. It may be possible to obtain usable operational definitions of relational and instrumental learning from the Model and to modify the interview and analysis procedures so that subjects' learning style may be classified as relational or instrumental. Such procedures would likely depend heavily on the ability or inability to develop plans which had not been taught or studied before. With these definitions and techniques, research could be designed to determine which teaching methods are effective in encouraging relational learning.

As an additional research suggestion, it may be possible to combine the methods of this study with those of other studies which measure other aspects of conceptual structure. Two methods (semantic distance and word association) which can be used to determine a measure of closeness (Euclidean distance) between concepts were reported in chapter 2. If such methods were used with the concepts at the vertices of schemas of this study, distances between these concepts could be obtained. It may then be possible to produce
representations of schemas which would preserve both Euclidean distance and the topological considerations of the present Model. Such figures would then represent two important aspects of conceptual structures: (a) closeness; and (b) problem solving capability.

Instructional Uses of the Model

A general use of conceptual structures in instruction would simply involve a commitment to the development of structures. This would lead to the teaching of concepts and reasoning from those concepts to solve problems, and away from the teaching of recipes for problem solving. A more specific use of the Model in trigonometric instruction or of a similar model in other areas would involve the design of instructional materials to first teach and strengthen the concepts of the vertices and then to teach and strengthen each connection.

The Model (or a similar one in another area) may also be used in diagnosis and evaluation of students. This would be most valuable when a very small group is being diagnosed or evaluated. In this instance each student could be interviewed according to the Model, noting specific weaknesses and inaccuracies. Instruction could then be designed to strengthen the weaknesses, remove the inaccuracies, and complete the schema.

The same principles could be followed with a larger
group, but this would involve the design of a written test which would attempt to determine strengths and weaknesses of the group. The use of a written test would produce less information than an interview and the combining of this information to form conclusions about the group would be less valuable than forming conclusions about an individual. However, such procedures combined with methods of instruction designed from a structural viewpoint should produce more complete and accurate schemas than teaching recipes for problem solving.

Summary of Conclusions

The Model as developed has fulfilled the four purpose statements, except that the generalization aspect remains to be tested. It has strong face validity although other types of validity need further testing. Its reliability has been supported in the less complicated areas. Also, the Model can be valuable in research on structural theories, both Skemp's and others, and has potential uses in both design and evaluation of instruction. The uniqueness of this study is that it is based on both psychological principles and problem solving in a particular content area. Its power lies in hypothesized applicability to other mathematical areas. Even allowing for the Model's complexity, it is a viable model of conceptual structures within which problem solving can be described, and it has potential value in both research and instruction.
Reference Notes


References


Geeslin, W. E., & Shavelson, R. J. Comparison of content structure and cognitive structure in high school students' learning of probability. *Journal for Research in Mathematics Education,* 1975, 109-120. (a)


Maier, N. R. F. Reasoning in humans, III. The mechanisms of equivalent stimuli and of reasoning. *Journal of Experimental Psychology*, 1945, 35, 349-360. (b)


Shavelson, R. J. Some aspects of the correspondence between content structure and cognitive structure in physics instruction. *Journal of Educational Psychology*, 1972, 63, 225-234.


The two page vita has been removed from the scanned document. Page 1 of 2
The two page vita has been removed from the scanned document. Page 2 of 2
Richard Skemp's theory of conceptual structures (schem- as) was adapted by hypothesizing two types of schemas: (a) an underlying parent schema; and (b) a problem solving schema which contains paths for problem solving. Three interpretations of the definitions of the trigonometric functions were identified: (a) the right triangle interpretation; (b) the coordinate system interpretation; and (c) the unit circle interpretation. For each interpretation representative problems were chosen and methods of solution analysed. From the methods of solutions the relevant concepts and specific actions employed were identified. The parent schema was constructed by placing the concepts in a geometric configuration with two concepts joined by a line if and only if some action joined those concepts. The problem solving schema was formed by joining the concepts at the vertices by lines which were labeled to describe the actions they represent.

The preliminary model thus constructed was tested and
refined by interviewing four subjects of varying abilities from a trigonometry class and then analyzing those interviews according to instructions developed from the adaptation of Skemp's theory and the problem solving methods. Interview analysis included constructing representations of the parent and problem solving schemas possessed by each subject in each interpretation. The refined Model was then used to interview two additional subjects from another trigonometry class and to analyse the interviews.

Interview analysis indicated strong face validity in that the Model was found to contain the problem solving paths used by the subjects. Cross validation was also found to be strong. Reliability of analysis was found to be strong in the less complex schemas and somewhat weaker when more complex schemas were involved. The Model was found to be a viable model of conceptual structures in which problem solving can be described and to have potential value for both instruction and research.

Suggestions for further research on the Model and for using the Model in both instruction and research are included.